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Citing GraphPad Prism 

When citing analyses performed by the program, include the name of the analysis, and 
Prism version number (including the second number after the decimal point). Use this 
example as a guide: “One-way ANOVA with Dunnett’s post test was performed using 
GraphPad Prism version 4.00 for Windows, GraphPad Software, San Diego California 
USA, www.graphpad.com”. 

To find the full version number, pull down the Help menu (Windows), the Apple menu 
(Mac OS 8-9), or the Prism menu (Mac OS X). Then choose About Prism.  

It is more important to explain which analysis choices you made than which program you 
used. It doesn’t really help to say you fit a curve with Prism if you don’t say which 
equation you selected, how you chose to weight data points, whether you fixed any 
parameters to constant values, etc. 

Windows system requirements 

Prism 4 for Windows runs under Windows 98, 2000, ME, NT4, or XP. Prism 4 does not 
run under Windows 3.1, 95, or Windows NT3.  Your screen must have a resolution of  
800 x 600 or better. We recommend using a computer with at least 64 MB of RAM. 

Prism Windows requires Internet Explorer version 3 or later. You don’t have to use it as 
your default browser, but Prism uses Internet Explorer to display help topics and also to 
send files via ftp (when you ask it to). 

Macintosh system requirements 

Prism 4 for Macintosh runs under Mac OS 8.6 or higher, or OS X (version 10.1 or higher). 
Prism will not run under the original OS X version 10.0. Your screen must have a 
resolution of at least 1024 x 768 on Mac OS X and at least 800 x 600 under Mac OS 8-9, 
however, Prism is best viewed on 1024 x 768 resolution. We recommend using a computer 
with at least 64 (Mac OS 8-9), or 128 (Mac OS X) MB of RAM. 

 

 

 1994-2003, GraphPad Software, Inc. All rights reserved. 

 

GraphPad Prism, Prism, and InStat are registered trademarks of GraphPad Software, Inc. 
GraphPad is a trademark of GraphPad Software, Inc. 
 

To contact GraphPad Software, email support@graphpad.com or sales@graphpad.com.  
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1. Upgrading to Prism 4 

You can still use Prism 3 after installing version 4 
The Prism 4 installer puts Prism 4 into a new folder, without changing Prism 3. You can 
run both during the transition period. But note that after purchasing an upgrade, you 
don’t own more licenses than you did before. You will violate your license agreement if 
you let someone else use your prior version while you use Prism 4. 

New Prism 4 file format 
Prism 4 uses a new file extension .PZF.  Prism 4 can open .PZM files created by Prism 
versions 2 and 3. However prior version of Prism cannot open files saved by Prism 4. 

If you collaborate with other Prism users, you may want to keep using Prism 3 on your 
collaborative projects until your colleagues upgrade to Prism 4. Also note that Prism 4 
graphs, in some cases, look a bit different than the Prism 3 graphs. If you need to make a 
series of matching graphs, do so all within one version of the program. 

Prism 4 can open all Prism 3 files, but there are two things to watch out for: 

• When you open a Prism 3 file with embedded results on a graph or layout, Prism 4 
will show the same rows as before. But in some cases, the result you want to show 
is on a different row in Prism 4 than it was in Prism 3. To fix this, you can double-
click on the embedded table and enter different rows in the dialog. Or delete the 
entire embedded object, and copy-paste again.  

• If you have written scripts that export results, you may also have to edit these 
scripts in cases where the results you care about appear on a different row in 
Prism 4 than in Prism 3. 

• Bar fills look a bit different on Prism 4 than they did on Prism 3. This depends, in 
part, on which printer you use and how you configured it. 

What’s new? 
The full list of new and changed features would fill many pages. You can find that list on 
our web site. But there is no need to read the list. Just start using Prism 4 and you’ll 
discover most of the changes as you use the program.  

We list below some changes that you could easily overlook: 

• We’ve lifted all the limits. You can create more sheets. Data tables can have more 
rows, columns and subcolumns. User-defined equations can be longer and include 
more parameters. 

• With Prism 4, you can drag columns to make them wider or narrower. You can 
also change the size of the font used on data tables. 
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• With Prism 3, you decided whether to show bar labels, and whether they should 
be horizontal or vertical, on the Format Bars (or Format Columns) dialog. With 
Prism 4, you make these settings on the X tab of the Format Axes dialog. Double-
click on the axis to bring up the dialog. 

• Duplicating sheets is very useful. In Prism 3, you chose to duplicate on the same 
dialog you use to make a new sheet. With Prism 4, click the New button (or drop 
the Insert menu) and choose one of the Duplicate commands. 

• With Prism 3 double-clicking on the graph background brought up the Format 
Graph dialog where you could change graph type and change which data are 
plotted. That dialog still comes up if you double-click on the periphery of the page, 
away from the plotting area. But if you double-click in the graphing area (within 
the axes) you’ll bring up the Format Symbols (or Bars) dialog.  

• With Prism 3, the “fill pattern” setting for bar graphs could be used to either add a 
pattern or could be used to effectively make a lighter fill color. With Prism 4 bar 
graphs, your choice of a color and a pattern are totally separate. First choose a “fill 
color” for the entire bar. Prism 4 lets you choose any color, which can be light. 
Then optionally overlay a “pattern” (grid) with a different color. Because of these 
changes, bar graphs created with Prism 3 will not look exactly the same when 
opened in Prism 4. 

• Prism 4 lets you perform two-way repeated measures ANOVA even if you have 
different numbers of subjects in each group. 

• The new Info section holds both unstructured notes and structured data 
(notebook number, experimenter, concentrations, etc.). Entering structured data 
can help you keep track of experimental details. You can also use these values as 
constants in some analyses (constants in transforms, constraints in nonlinear 
regression) and in graph titles and legends. Of course, everything is linked so if 
you edit the info constant, Prism will update linked analyses and graphs. 

• The Macintosh version of Prism 4 exports (or copies) vertical and angled text 
different than Prism 3 did. You no longer need to copy or export an enlarged 
graph, and then shrink it in the other application. 
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2. Getting started with Prism 

Approach to learning Prism 
GraphPad Prism helps you quickly and efficiently create scientific graphs, fit curves, 
perform statistical analyses, and organize experimental data.  

We offer two ways to get started, and you’ll probably want to use a combination of both: 

• Read this chapter, and the next two, to understand how Prism is organized. These 
chapters don’t tell you what to do, but rather orient you to how Prism is organized. 
They are a map, not step-by-step driving directions.   

• Follow some of the examples in the companion book of Step-by-Step examples. 
These examples tell you exactly what to do, step by step, to make common graphs 
and perform common analyses. 

Once you’ve gotten oriented to Prism and have followed some examples, you can consult 
the rest of this User’s Guide as reference.  

To learn more about curve fitting and statistics with Prism, consult the two companion 
books: 

• Prism 4 Statistics Guide. Statistical analyses for clinical and laboratory 
researchers.  

• Fitting models to biological data using linear and nonlinear regression. A practical 
guide to curve fitting.  

These books help you pick an appropriate analysis and interpret the results. They emphasize 
principles and concepts, and only a small portion of the material is specific to Prism. 

All four volumes (this book, the book of step-by-step examples, the statistics guide, and the 
curve fitting book) can be downloaded as Acrobat (.pdf) files from www.graphpad.com .  

The five sections of a Prism project 

What is a project file? 
Each Prism project file is divided into five sections: Data Tables, Info, Results, Graphs, 
and Layouts. Sections contain pages known as sheets, each holding an individual graph, 
table, etc.  
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Prism remembers all logical links between sheets. You may provide your own name for 
any data sheet, and Prism incorporates that name into all linked sheets. When you select a 
sheet to display or work on it, all related sheets are shown in boldface in the Navigator, so 
you can always see where you are, identify related items, and tell at a glance what has 
been done with each experiment. 

Data Tables 
Prism’s data tables are formatted differently than a spreadsheet or other programs you 
may have used.  

The first column is usually for X values. Enter (or import) numbers for XY or survival 
graphs or group labels for bar graphs. If you format a table for creation of a column graph, 
there will be no X column. 

The rest of the columns are for Y values, and these can be divided into subcolumns. For 
example, the table below shows data for two experimental conditions (columns A and B) 
with each column subdivided for entry of triplicate values (subcolumns Y1-Y3).  

 

Some tables lack X columns. For example, the table below shows one way of entering data 
for analysis by one-way analysis of variance. Levels of the grouping variable (Treatment) 
are in the headings for data sets A-D. Here, the data are entered as mean, standard 
deviation, and sample size (N) into a table formatted for that purpose.  
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Here are the key concepts about Prism’s data tables you need to know to get started. 

• The format of a Prism data table determines what kinds of graphs you can make 
and what kind of analyses you can perform. It is important that you choose a 
format appropriate for your data. If it isn’t right, you can change it.  

• You are not limited to one data table per file. Store an entire project in one file, 
creating as many data tables as you need.  

• Prism can plot error bars from raw data. You don’t have to enter SD or SEM 
values, although you can. 

• A data table can have only one X column. When you enter your data, you need to 
carefully choose which values you place in the X column. 

Info 

 

Use the Info section to document experimental details. Here are the key concepts: 

• Use of info sheets is optional. 

• Enter structured information on the left and unstructured notes on the right.  

• Each info sheet can be linked to a particular data table, but doesn’t have to be. 

• When you enter values into analysis parameters dialog (such as a constant in the 
Transform dialog), you can choose an info constant and its value will be linked to 
the analysis. 

• You can use a value entered on an info sheet as a graph or axis title.  

• You can copy and paste any block of constants and values to label a graph or 
layout. 

• You can change the default list of constant names in the Preferences dialog. 

• You can also choose whether to automatically make a new info sheet every time 
you create a data table.  
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Results 

 

The Results folder holds all your analyses. 

• Some results sheets are just meant for you to read. Other results sheets are similar 
to data tables, which you can graph or analyze further. For example, when you 
choose a data transform, Prism doesn’t change your data. Instead, it creates a new 
results table, which you can graph or analyze. 

• Results sheets have red grids to distinguish them from data tables and remind you 
that you cannot edit values in results tables.  

• Some results sheets have several subsheets. Choose to view a subsheet using the 
drop-down list in the toolbar or by clicking on the subsheet in the Navigator.  

• You can copy any portion of a data table and paste it onto a graph or layout as an 
embedded table.  

• Prism can help you pick an appropriate test. Click “Help Me Decide” from any 
analysis parameters dialog. 

 

• Click the Analysis Checklist button to review the assumptions of the analysis. 

  

• If you realize you made invalid choices on the parameters dialog, you don’t need to 
start over again. Instead, click the Analysis Parameters button to change your 
analysis choices and view updated results. 

 

Graphs 
Prism can create many kinds of two-dimensional scientific graphs. 

• A Prism project file can contain many graphs. 

• Prism automatically creates one graph of each data table, but you are not limited 
to this. You can create several graphs from one data table, and can place data from 
several data tables on one graph. 

• To Prism, curves are simply data sets. Prism automatically tries to plot curves 
(from nonlinear regression) on an appropriate graph. But you can remove curves 
from the graph or add them to different graphs.  
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Layouts 
Use the page layout section to arrange two or more graphs along with data or results 
tables, text, imported images, and more.  

• Prism helps you get started by providing a regular array of graph placeholders. 
You are not limited to these regular arrangements. You can delete, add, and resize 
placeholders. 

• Double-click on a placeholder to assign a graph to that position. Or drag a graph 
from the navigator and drop onto a placeholder. 

• When assigning a graph to a placeholder, you can choose a graph from any 
project. 

Automatic linking 
Prism automatically maintains links between sheets. 

• If you edit data, Prism automatically recomputes linked analyses and redraws 
linked graphs. 

• If you edit info constants, Prism automatically recomputes linked analyses, and 
recreates graphs and layouts where those info constants are used. 

• If you edit a graph, Prism automatically redraws linked page layouts. 

• You can save a project as a template to simplify your work. Open the template, 
edit the data, and you are done. 

Three especially useful buttons 
Like all programs, Prism provides many menu commands and toolbar buttons. Of all 
these, three buttons are particularly useful: 

 

• The New button creates new sheets. Use it to create new data tables, info sheets, 
graphs, or layouts. Also use it to duplicate a sheet, perhaps along with all related 
sheets. 

• Click Analyze from any data table or graph. Remember that Prism uses the term 
“analyze” to include data manipulations like transforming and normalizing, as 
well as statistical analyses and curve fits. 

• Click Change to change almost anything. The dropdown menu is specific to the 
section you are in. 
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3. The Welcome dialog 

Choosing the type of graph 
When you launch Prism, you’ll see the Welcome dialog. Here you tell Prism whether 
you’re continuing work on an existing project or starting a new one. For new projects, 
there are several ways to begin.  

 

If you are new to Prism, we suggest that you always choose the type of graph. (People who 
have used Prism may prefer to choose the format of the data table.)  Prism gives a choice 
of four families of graphs, presented on four tabs. The tab you choose determines how 
your data will be organized and what kinds of analyses you will be able to perform. 

XY  

 

Choose XY to make graphs that you will fit with linear and nonlinear regression. If you 
choose a graph that includes Y error bars, Prism asks how you’ll enter the error bar 
information. You can enter replicate Y data and have Prism compute the error bar, or 
enter the mean and SD (or SEM) directly. Enter replicates side-by-side, as shown below:  

 



 

3.  The Welcome dialog 15 

If you choose to enter SD or SEM directly, you’ll enter the SD or SEM (and N) in labeled 
subcolumns next to the subcolumn for mean. 

If you choose a graph that includes an X error bar, your data table will have a subcolumn 
for X error next to the X column. Enter the error value directly. Prism cannot compute X 
error bars from replicates. 

Label the columns by replacing their default headings (“X Title,” “Data Set-A,” etc). Use 
toolbar buttons to enter Greek letters, superscripts and subscripts. 

Prism tables have only one X column. To enter several data sets with different X values, 
stagger the results down the page. 

 

One grouping variable 
Choose One grouping variable for data you will analyze with t tests, one-way analysis of 
variance, and column statistics. 

 

The data table has only Y columns. If you choose a graph with error bars, enter replicate 
values stacked in a column. Label each group by typing a column heading. 

 

Prism will link a column graph to this type of table. The term “column” refers here to the 
organization of replicate data into columns on the data table. It doesn't mean that you’ll 
necessarily get a vertical bar graph, which may be termed a “column graph” by other 
programs, although that is one of the choices.  Column graphs can be vertical or horizontal. 
Even if you want a horizontal graph, enter each group into a separate Y column. 

Two grouping variables 
Choose Two grouping variables for data that will be analyzed with a contingency table or 
two-way analysis of variance.  
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Enter labels for the levels of one grouping variable as headings over the columns. Each 
data set (column) generates bars of a unique appearance.  

Enter labels for the levels of the other grouping variable into the X column. Each row 
generates another bar. 

The example above generates six bars. The columns “Before exercise” and “After exercise” 
create bars of different appearance. Since there are three rows, you’ll see three of each 
kind of bar.  

If you want to enter replicate data to compute error bars, enter the replicates in side-by-
side subcolumns. 

Survival graphs 
Before creating survival graphs, you’ll need to understand the principles of survival 
analysis and understand the term “censored” data. For more details on survival analysis, 
see the companion Statistics Guide. 

Tip: Survival analysis can track time to any one-time event; it doesn’t 
have to be death. 

You’ll enter raw survival data, and Prism will automatically analyze these data to create a 
Kaplan-Meier survival curve and compare data sets with a logrank test. This is unique. For 
any other kind of analysis, you need to click the Analyze button and choose the analysis type. 
But Prism performs the survival analysis automatically once you choose the survival tab. 

Choose how you want the survival graph to appear on the Welcome (or New Graph) 
dialog. Your choice (which you can customize later) does not affect the analysis. 
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Enter time in the X column as number of days, weeks, or months. Prism cannot calculate 
the duration from a range of dates. 

In the Y columns, enter a “1” for patients that die. Enter a “0” for patients whose data was 
censored at the indicated time. Data for a subject is said to be censored when you have no 
useful information about what happened to the subject after that time.  Subjects alive at 
the end of the study are censored, because you do not know about their later survival.  
Subjects who leave the study are also censored, either because you do not know whether 
or not they survived or because you can't use that information because they were no 
longer following the study protocol. 

  

Note that the table doesn’t contain any subcolumns for entry of error bar information. 
Error bars on survival curves are calculated as part of the Kaplan-Meier analysis, and not 
from replicates or error terms that you enter. 

Prism creates the survival curve automatically. Go to the graphs section to see the graph, 
and the results section to see the table of survival over time and the results of the logrank 
test to compare survival curves. 

Bar graphs 
Prism offers two distinct ways to make bar graphs. Each requires a different organization 
of data.  

If you choose One grouping variable, the columns define your groups. You will enter one 
group per column, stacking replicates (if any). Each column then becomes a bar, and 
you’ll be able to control the appearance of each bar individually. 

If you choose Two grouping variables, one group is defined by rows and the other group 
is defined by columns. You’ll enter replicates (if any) in side-by-side subcolumns.  Each 
column will create bars with a different appearance that you can change. Each row 
becomes another bar. So if you have three Y columns and four rows, you’ll have three 
kinds of bars, and you can choose the color, fill, and border of each. You’ll have four 
different bars of each type. You can choose whether you want the bars interleaved, 
stacked, or grouped on the Welcome dialog or by clicking Change and then Type of graph. 

Both the kinds of bar graphs mentioned above place the bars on the graph in order, with 
equal spacing. In some cases, you want to position each bar along the X axis with the 
position determined by an X coordinate you enter. You can do this by creating an XY 
graph, and then changing the symbol shape from a standard symbol (circle or square) to a 
spike or bar. See page 102.  
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Choosing a data table format 
Instead of choosing the format of your first graph (which also chooses the format of the 
first data table), you can choose the format of the first data table directly. This choice is 
provided primarily for those who are familiar with previous versions of Prism.  

 

The choices are explained in Chapter 5.  

Opening a template 
A Prism template is simply a Prism project designed to be reused. After you open a 
template, all you have to do is enter your data (perhaps replacing sample data). Then view 
the completed analyses, graphs, and layouts. 

We provide a few sample templates, but these are only provided to give you a sense of 
what templates can do. They won’t save you any time, since they don’t do exactly what 
you want. Create your own templates, and you’ll be able to analyze and graph repeated 
experiments in an instant. Making a template takes only a few minutes, as explained in 
Chapter 10. 

Opening an existing Prism file 
You can open a Prism file right from the Welcome dialog. Prism lists the nine files you 
used recently right on the Welcome dialog. You can select one and get working right away. 
Or click “More files” to bring up a standard File Open dialog to open another Prism file. 

Note that this command is only used to open Prism files. If you want to import files 
containing data created by other programs, first create an empty Prism data table, and 
then use the File Import command.  
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4. Navigating and managing a project 

What does a project contain? 
A Prism project file contains all parts of an experiment, organized into five sections: Data 
Tables, Info, Results, Graphs, and Layouts. Each individual data table, info page, analysis 
result, graph, and layout is called a sheet. This chapter explains how to navigate between 
sheets, how to organize your sheets, and how to work with several projects at once. 

Finding the right sheet 

Project Navigator  
You’ll see the Navigator on the left side of the Prism screen after starting a project. The 
Navigator shows all the sheets in the project. Sheets related to the selected sheet are 
shown in bold. To display a sheet, click on its name in the Navigator. 

 

To show or hide the Navigator while you’re working, pull down the View menu and select 
Navigator or use the Navigator button.  

 

To narrow or widen the Navigator, point to its border until you see a two-headed arrow 
mouse cursor. Then drag to change the width. 

Section tabs 
You can also move between sections of a project by choosing one of the yellow section tabs 
on the toolbar. 
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Gallery 
The gallery shows thumbnail previews of all sheets in a section. To go to the gallery, drop 
the View menu and choose Gallery, or click the Gallery button.  

 

Once you find the sheet you want, double-click on its thumbnail preview to display that 
sheet full-size. 

 

Going to a linked sheet 
The Navigator shows all sheets linked to the currently displayed one in boldface. Click on 
a sheet name to go there. To choose from a list of linked sheets, press the Linked Sheet 
button on the tool bar.   

 

To go back to the sheet you just visited, click the web-like "back" button on the left of the 
tool bar. Press repeatedly to go back to sheets you visited recently. If you go back too far, 
press the Forward button. 

Tracking chains of analyses 
Prism lets you chain analyses. For example, you can first transform data, then normalize 
the transformed data, then fit a curve to the normalized results, and finally run a 
normality test on the residuals from the curve fit. 

To make it easier to view analysis chains, Prism can show an additional folder in the 
Navigator labeled “Data with Results.” To show this folder, drop the Edit menu (Prism 
menu in Mac OS X), choose Preferences, choose the View tab, and choose to always view 
Data+Results. In this additional Navigator folder, each analysis is shown indented under 
the table it analyzes, so analysis chains appear as a cascade of indented sheet names. 
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Renaming sheets 
Prism initially assigns each data table a generic name such as “Table 1”. You’ll find it 
easier to manage large projects if you give the sheets more descriptive names. To rename 
a sheet, click on the sheet name in the toolbar and edit. 

 

Tip: Don’t try to delete the current sheet name. If you delete the name, 
Prism replaces it with a default name. Instead, double-click to select the 
sheet name, and then begin typing to replace it. 

Don’t confuse the name of a sheet with the file name for the entire project. Remember 
that you’ll have many sheets within each project. 

You may also rename a sheet in the Navigator. Click once to go to the sheet you wish to 
rename. Then right-click and choose Rename. 

You may use the clipboard to copy and paste portions of sheet names. To do this, click the 
right mouse button and use the copy and paste commands on the shortcut menu. The 
copy and paste keyboard shortcut keys and the commands on the Edit menu will not 
work. 

When you rename a data table, Prism propagates the new name sensibly. For instance, if 
you rename “Data 1” to “Experiment 54,” Prism will also rename a graph named “Data 1 
Graph” to “Experiment 54 Graph” and a results sheet “Nonlin fit of Data 1” to “Nonlin fit 
of Experiment 54.” To stop the automatic renaming of a particular set of linked sheets, 
simply rename the graph or results sheets to a name that does not include the name of the 
linked data table. Automatic renaming works only if you rename a data table, not if you 
rename analyses or graphs. 

Freezing sheets 
Data are linked to results and graphs. If you change the data, Prism automatically re-
calculates the analyses and updates the graphs. 

Freeze a results or graph sheet if you don't want it to update. For example, you might want 
to freeze results and a graph before excluding some outliers from the data. You can then 
repeat the analysis, and have both copies of the results and graphs in the project. To freeze 
a results or graph sheet, select Freeze Sheet from the Edit menu.  
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To unfreeze the sheet, choose Freeze Sheet again. 

Reordering sheets 
To change the order of sheets, pull down the Edit menu and choose Reorder Sheets. The 
Reorder Sheets dialog lists all the sheets in the current section. Click on a sheet name, then 
press Top, Move Up, Move Down, or Bottom to change the position of that sheet in the list.  

 

Deleting sheets 
As you work with a large project, you may accumulate unneeded graphs and analyses. To 
delete one or more sheets, pull down the Edit menu and select Delete Sheet(s). Or right 
click on a sheet name in the Navigator, and select Delete Sheet. Select one or more sheets 
in the current section to delete. If you are in the Data section, you also have the option to 
delete all info, results, and graph sheets linked to the selected data tables. 

 

Because sheets are linked, remember that deleting one sheet may affect others. When you 
delete a data table or results sheet, you also remove those data and results from all graphs. 
The graphs themselves remain; they just have fewer (or no) data plotted on them. Any 
results sheets based on the deleted data become orphaned (you can still view and graph 
orphaned results but can’t change the calculation parameters). When you delete a graph 
sheet, you also delete that graph from all page layouts, but you will not delete the page 
layout sheets themselves.  
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Merging and splitting projects 
While you are working on one project, you may append a second project. Pull down the File 
menu, select Merge, and then choose a file. All sheets from that file will be appended to your 
current project. Prism places an asterisk (*) in front of the name of each merged sheet. 

If a project file grows too large to be manageable, split it into two files. Drop the File 
menu, choose Save Special and then Save Family As. This will save the sheet you are on 
along with all related sheets. Then delete the unwanted sheets from the original project. 
To do this, go to the Data Tables section, pull down the Edit menu, and choose Delete 
Sheet(s)…. Select the data tables you want to delete, and check the option to also delete 
related sheets. 

Backup files 

Automatic backups 
Choose automatic backups on the File & Printer tab of the Preferences dialog. Prism only 
saves backups when you switch from sheet to sheet, so the timed backup process never 
interrupts your work. The backup files are also saved whenever you save your work, so the 
backup files can never be older than your project files. The backup files are named with 
the extension .PZB.  

When you quit Prism normally, the timed backup files are deleted. In case of computer 
disaster, the backup files will remain on your hard drive. When you restart Prism, these 
files will automatically load so you can continue your work. 

If you hold the Control key while exiting Prism, it will not delete the timed backup files. 
When you start Prism again, your projects will open. If you work on several projects at 
once, this is a convenient method to interrupt and restart your work. Remember that your 
work is stored in .PZB files in the temporary folder. Don't accidentally delete them.  

Manual backups 
Prism makes it easy to save backup copies of your projects. Drop the File menu, choose 
Save Special, and then choose Save Backup As. Prism will save a copy of your project to 
the location and name you specify, perhaps to a network or CDR drive. Your project is not 
renamed. The Save command will continue to work just as it did before. 

Note: When you use the File Save As command, your project is renamed. 
When you later use the Save command, you’ll save to the new location 
and with the new name. In contrast, The Save Backup command does 
not rename your project. 
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5. Entering and editing data 

Changing format of the data table 
Unlike Excel or most other graphics programs, Prism’s data tables are formatted. In most 
cases, the first column is for X, and it can be formatted for numbers or text. The rest of the 
columns are for Y values, and these can be divided into subcolumns for entry of error 
bars.  

When you choose to make a new graph (from the Welcome dialog or New Table dialog), 
Prism formats a data table according to your choices. X is formatted according to the kind 
of graph you chose. If you choose an XY graph or two-grouping variable graph, the Y 
columns are formatted according to your choices on the bottom of the dialog. 

 

After the table is created, you can change its format. From the table, click Change, and 
then choose Format Data Table. 
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Choices to format X column 

Format Explanation 
Numbers (XY 
Graph) 

You'll use this format most often, to create XY graphs and perform 
linear or nonlinear regression,. X values are entered as numbers with 
no associated error terms.  

Numbers +/- 
Error bar 

Same as above, except that the data table will include a subcolumn 
for entry of x error bar information.  

Text (bar graph) Use to analyze data grouped by two types of categories (e.g., for two-
way analysis of variance or contingency tables). The X column will 
hold text labels, showing the levels of one of the grouping variables. 
Levels of the other variable will be entered as Y-column headings.  

None (column 
graph) 

Use to analyze data grouped into categories of one type (e.g., column 
statistics, t tests, one-way ANOVA). The X column will be omitted 
from the table, and levels of the grouping variable will be entered as 
Y-column headings. Enter values for each group into a separate 
column. 

Series Use when X values are regularly spaced, e.g., time points or fraction 
numbers. Enter the first X value and the interval between succeeding 
values. Prism calculates the X values and displays them in boldface 
type. You may not edit individual values in the series. You don't 
specify the end of the sequence. Prism generates as many values as it 
can (until the bottom of the table). The range of the graph is 
determined by how many Y values you enter. Ignore the extra X 
values.  

Tip: It is easy to forget that you have formatted the table for text X 
values. If you format the X column for text, everything you enter will be 
left justified, and the X column will be titled "X labels". Decimal points 
may not line up. If you format the X column for numbers, the values will 
be right justified with aligned decimal points, and the column is titled "X 
values". 

Format of Y columns 
Prism data tables can contain up to 104 data sets. Each data set can be subdivided for 
entry of replicate values or for mean and SD or SEM.  

Note: The maximum number of rows is limited only by your hard disk 
size. 
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Format Comments 

A single column of 
values 

Use if (a) you don't have replicate values, (b) you want to only 
enter mean values, or (c) you do not have an X column on the 
table (X format is “None”) and you will enter replicates vertically 
down the Y column(s). 

n replicates to calculate 
error bars 

Prism divides each data set Y column into the number of 
subcolumns you specify (up to 52). Allow for the maximum 
number of replicate values in the data sets you want to analyze 
and graph together. If some data sets have fewer replicates, leave 
some cells blank. 

Mean, Standard 
Deviation [Error] 

Enter SD or SEM only if your data are already averaged. You 
don’t have to enter SD or SEM to graph error bars. Prism can 
graph error bars directly from replicate values.  

Mean, Standard 
Deviation [Error], N 

If you also enter N, Prism can perform two-way ANOVA and 
change the error bars between  SD, SEM or 95% CI error bars. 

Mean, -Error, +Error Create asymmetrical error bars. Don’t enter the high and low 
values; enter how far the error bar extends below and above the 
mean. If the mean is 12, with a confidence interval from 9 to 16, 
enter 3 as the minus error and 4 as the plus error. 

Note: You do not need to choose a format that includes SD or SEM to 
graph error bars. Prism can plot error bars directly from the replicate 
values you enter. Switch between SD, SEM and CI error bars on the 
graph, not on the data table.  

Entering multiple sets of data that don’t share X values 
Each data table has a single column for X and up to 104 sets of Y values. What should you 
do if you have different X values for each set of Y values? There are two ways to solve this 
problem. 

The best approach is to stagger the data entry. You don't have to start entering data in the 
first row. This example shows three data sets with different X values. 

  

An alternative approach is to enter each data set on a different table. The disadvantage 
with this method is that you lose some analysis choices. You must enter all the data sets 
on one table in order for Prism to compare linear regression lines, to compare best-fit 
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values from nonlinear regression, and to compare survival curves. Another minor 
disadvantage is that Prism will automatically make a different graph for each table. 
However, you can delete the unneeded graphs and include data from all the data tables on 
a single graph. 

Embedding data tables in graphs or layouts 
If you want to print your data table and graph on one page, you can embed any portion of 
a data table onto a graph or page layout. Select the range of data, and copy to the 
clipboard. Then go to the graph or layout and paste. Double-click on the new table to 
bring up a dialog that lets you change its appearance. 

Working with the data table 

Number format 
Prism usually chooses the number of decimal points to display automatically. You can 
change the number of decimal points displayed. Select the column or columns you wish to 
change (click at the top of the column to highlight), then click Change… Number Format.  

 

Column widths 
Column widths are determined automatically. To adjust the width of a column, point your 
mouse to the area between the column designators (“A”, “B”, etc.), and drag. If you select 
several columns, dragging the border of one column will change the width of all selected 
columns. Prism determines the width of subcolumns (replicates) automatically, and you 
cannot change these widths. 

Sorting data 
If you choose to graph data with point-to-point lines connecting the points, the points will 
be connected in the order they appear on the data table. If the X values are not in order, 
the connecting lines will jump back and forth. To sort your data by X values, pull down the 
Edit menu and choose Sort by X Value. 
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Excluding data 
If a value is too high or too low to be believable, you can exclude it. Excluded values are 
shown in blue italics on the data table, but are not included in analyses and are not shown 
on graphs. From the point of view of analyses and graphs, it is just as if you had deleted 
the value, but the number remains on the data table to document its value. 

To exclude data, select the cell or cells you wish to exclude, pull down the Edit menu and 
choose Exclude Values (the Exclude command is also on the shortcut menu accessed by 
the right mouse button). The excluded values appear in blue italics. Repeat the process to 
include the value again. 

Note: If you want to remove entire data sets from a graph or analysis, 
this is not the best way to do it. From a results sheet, click Change and 
then Data Analyzed. Then choose selected data sets to analyze. From a 
graph, click Change and then Remove/Replace Data Sets.  

Deleting data 
After selecting a range of data, press the DEL key to delete the selected range. Even if you 
have selected an entire data set, pressing the Delete key will erase all the values, but the 
data set will still be linked to analyses and graphs. When you enter new data, Prism will 
update the analyses and graphs.  

To delete a block of data completely, select Delete from the Edit menu. Other data on the 
table will move to fill the gap. When you delete entire data sets, you also delete those data 
from graphs. Results based on the deleted data become orphaned (see "Frozen and 
orphaned results" on page 47). 

Note: The DEL key is the same as the Edit Clear command, but is not the 
same as the Edit Delete command. 

Moving the insertion point with the keyboard 
If you navigate with the keyboard (rather than clicking the mouse) Prism offers several 
shortcuts. The Enter key moves to the next Y value. It moves over to the right to the next 
subcolumn, if there is one; otherwise it moves down a row and to the first subcolumn. 
Shift-Enter does the opposite. The tab key moves one cell to the right, while Shift-Tab 
moves to the left.  

Editing values 
When you place the insertion point in a cell that contains a value, the number in that cell 
will be selected. When you start typing, you will replace the existing number. To edit an 
existing number, click once to go to the cell and then click again to place the insertion 
point inside the cell so you can edit. 
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Using the clipboard 

Selecting 
Use the clipboard to copy data from one location and paste it somewhere else. Before 
copying, you must select a region on the data table. 

 

To select Mouse Keyboard 
A range of data. Point to one corner of the block. 

Hold down the left mouse button 
and drag to the opposite corner.  

Move to one corner of the 
block. Hold down the Shift 
key and move to the opposite 
corner (using arrow keys). 

One or more 
columns. 

Click on one of the column 
headers (“A”, “B”, etc.). Drag over 
the desired range of columns. 

Hold Ctrl, and press the 
spacebar. 

One or more rows. Click on one of the row headers 
(“1”, “2”, etc.). Drag over the de-
sired range of rows. 

Hold Shift, and press the 
spacebar. 

All data on the 
table. 

Click here. 

 

Ctrl-A 

Copy, cut, paste 
Access the cut, copy, or paste commands on the toolbar, the shortcut menu, or the edit 
menu. Or hold the control key (Windows) or Command key (Mac) and press X, C, or V. 

Before pasting, position the insertion point and consider changing the column format of 
the data table to match the new data. Prism simply pastes the values onto the data table 
(starting at the insertion point) and does not distinguish between X and Y columns or 
between columns that denote replicates, those that denote error values (SD) and those 
that denote distinct data sets. 

When you paste data from Excel into the Windows version of Prism, you can choose to 
embed the entire spreadsheet within Prism or link Prism to the spreadsheet file. See 
"Pasting data from Excel" on page 30. 

Exporting data and results tables 
To export data formatted as plain ASCII text, choose Export from the File menu. Choose a 
comma-delimited value (csv) file type to separate adjacent columns with commas or the 
tab-delimited text (txt) file type to separate adjacent columns with tabs. 
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6. Importing and pasting data 

Using data from Excel  
You can bring data from Microsoft Excel into Prism either by copy/paste via the clipboard 
or by export/import via files. Copying and pasting is easier, and the only real reason to use 
files is to move data from Excel running on one computer to Prism running on another.   

Pasting data from Excel (Windows) 
After you copy selected data to the clipboard from Excel, switch to Prism, move the 
insertion point to the cell that will become the upper-left corner of the pasted data, and 
drop the Edit menu. Then choose one of the Paste or Paste Special options (these 
commands are also on the shortcut menu you see when you click the right mouse button). 

 

If you choose Paste Data, Prism retains no link back to the Excel spreadsheet. The values 
will be pasted and nothing else. The only advantage to using this method is that it is 
conceptually simpler.  

When you Paste Embed, you paste the selected data into the data table and also paste a 
copy of the entire spreadsheet file into your Prism project, even if it has several 
worksheets (tabs). This means you don’t need to worry about keeping track of multiple 
files. You don't need to save the spreadsheet file separately (except as a backup). You can 
open Excel from within Prism, edit the data, and instantly update the analyses and graphs 
in Prism. A potential disadvantage of embedding is that you will end up with multiple 
copies of the same data. Another disadvantage is that your Prism files will be larger. 

When you Paste Link data into Prism, you paste the values as well as a link back to the 
Excel file. The link has two functions. It lets you trace (and document) the source of the 
data so you stay organized. It also is a live link. If you edit or replace the data within Excel, 
Prism will update the analyses and graphs. The Paste Link command is available only if 
you paste from an Excel workbook that has a name. If you are working with a new Excel 
file, you must first save it (thus giving it a name) before you can link its data into Prism. 

Tip: When in doubt, choose Paste Link. 

If you choose Paste Special, you'll see the Format Data Object dialog, where you can 
choose whether to embed or link, and also choose to filter and rearrange the data (such as 
transposing). See "The Format Data Object dialog" on page 33. 

When you paste link or paste embed from Excel, Prism pastes the data with as much 
precision as possible. If you paste data (or if the data came from any program other than 
Excel), Prism pastes the values exactly as they appear on the Excel screen. Format the 
data within Excel to show enough digits after the decimal point before copying to the 
clipboard. 
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Pasting data from Excel (Macintosh) 
After you copy selected data to the clipboard from Excel, switch to Prism, move the 
insertion point to the cell that will become the upper-left corner of the pasted data, and 
drop the Edit menu. Then choose Paste or Paste Special. If you choose Paste Special, 
you'll then see the Format Data Object dialog, where you can choose whether to filter and 
rearrange the data (such as transposing). See "The Format Data Object dialog" on page 
33. 

Note: It is not possible to paste embed or paste link on the Macintosh 
(because Microsoft does not provide software developers with the 
necessary information about Excel on the Macintosh). 

Transferring data from Excel to Prism via text files 
Rather than use the clipboard, you can also transfer data from Excel to Prism using text 
files. To create these files, go to the worksheet (tab) you want to export, then pull down 
Excel's File menu and choose Save as. Select either Text (tab delimited) or CSV (comma 
delimited).  

 

The csv format separates columns with commas, while the txt format separates columns 
with tabs. Both these formats are also called ASCII formats.  

Tip: We suggest using txt files, rather than csv files since commas 
sometimes are part of the data. 

Excel always saves an entire worksheet (tabbed sheet) into a file. You cannot export a 
selected range, and cannot include several worksheets in one txt or csv file. 

To import the txt or csv file into Prism, start from a data table and move insertion point to 
the cell that will become the upper-left corner of the imported data. Select Import from 
the File menu, set the file type to text, and choose a file. Prism will show you the Import 
dialog, which is identical to the Format Data Object dialog. See "The Format Data Object 
dialog" on page 33.  

Note the distinction between opening files and importing files. You can't open an Excel 
file from Prism's Welcome dialog or with the File Open command. When importing, you 
must first start a new file (or open an existing one), position the insertion point, and then 
choose the Import command from the File menu.  

Importing native Excel files (Windows only) 
Prism can also import data directly from an Excel xls file. Position the insertion point on a 
Prism data table, then choose Import from the File menu, set the File type to Worksheets, 
and pick a file. There are several limitations to importing Excel files directly.  

• If your workbook (spreadsheet file) has several worksheets (tabs), Prism only 
reads one – the one that was selected when the file was saved. The other 
worksheets are invisible to Prism. 
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• To import data from an Excel file, Prism launches Excel invisibly, and asks Excel 
to send the data to Prism. So Prism can only import an Excel file if Excel is 
available on the same computer as Prism. Because Excel has to be launched, 
importing an Excel file can take much longer than importing a text file.  

• Importing an Excel file requires an OLE connection between Prism and Excel. 
This is a complicated process, requiring the coordination of Excel, Prism, and 
various Windows components. While it works fine on most computers, it simply 
doesn’t work on some computers. 

• You'll rarely want to import an entire worksheet. While you can restrict rows and 
columns to import on Prism's Format Data Object dialog, it is easier to simply 
copy and paste the appropriate range. 

Tip: Whenever possible, transfer data from Excel using copy and paste. 
Importing Excel files directly is rarely helpful. 

Pasting a picture of an Excel table into Prism 
You can also copy a portion of an Excel spreadsheet and paste it onto a Prism graph or 
layout. This pastes a picture only, and Prism cannot analyze or graph the values since the 
values are not in any Prism data tables. 

0.0 0.1 0.2 0.3 0.4 0.5
0.0

0.1

0.2

0.3

0.4

0.5

Protein O.D.
0.05 0.097
0.10 0.183
0.20 0.290
0.30 0.371
0.40 0.462

[Protein], mg/mL

O
pt

ic
al

 D
en

si
ty

, U
ni

ts

 

Importing data from text files 
All spreadsheet and statistics programs can export blocks of data as a text file, separating 
adjacent columns with commas, semicolons, or tabs. Text files commonly have the 
extension .TXT, .DAT, .CSV (comma separated value), or .PRN (printer). Some programs 
refer to these files as ASCII files rather than text files.  

Note. It is not sufficient that the file have an extension (file type) such as 
txt or dat. The file has to be a plain text file. If a file is not a text file, 
renaming it to have a different extension won’t help.  

To import text files into Prism, start from a data table and move the insertion point to the 
cell that will become the upper-left corner of the imported data. Select Import from the 
File menu, set the file type to text, and choose a file.  



 

6.  Importing and pasting data 33 

The Format Data Object dialog 
When you import a file, or use the Paste Special command, you can choose which data to 
use and how to arrange the values within Prism. The choices on this dialog are arranged 
on five tabs: Source, View, Filter, Placement, and Info & Notes.  

Source tab 

 

When you paste special or import, the Source tab lets you choose between importing/pasting 
just the values, linking to a file, or (Windows only) embedding a data object.  

If you link to a file, check “Automatically update Prism when the data file is changed” to 
keep a live link to the file. Whenever you look at that Prism table, or look at a Graph, 
Results, or Layout sheet linked to that table, Prism will update the data if the linked file 
has been edited. 

If you return to this dialog to edit a data object, this tab looks a bit different. It is 
informational (lets you see where the data came from and whether the data are embedded 
or linked). You can also change to a different file by pressing Browse. 

If your file contains commas, tell Prism how to interpret them. Commas can be defined in 
three ways. 

Definition Example: “123,456” 

Separate columns 123 in the first column. 456 in the next. 

Delineate thousands The number 123456. The comma has no meaning, but 
makes it easier to read. 

Decimal point The number 123.456 with the comma used instead of 
a period to denote the decimal point (common in 
many countries). 
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If the file contains spaces, specify whether the spaces separate columns or are only used to 
separate words within column or row titles. 

View tab  

 

View the contents of the file, divided into columns. Click Open File to open and edit the 
data file. If it is an Excel file, you'll open Excel. If it is a text file, you’ll open a text editor. 

Filter tab  

 

Choices on the Filter tab let you choose which portions of the data file to import. Apart 
from the choice on this tab, you can choose to use the first row of the file for column titles 
on the next tab. 

First select the range of rows to import, by specifying a first and last row. If your file 
includes <notes>, <info>, or <title> information (see the next section), start counting 
rows at the first row after this structured information. Row “1” is the first row with data, 
not the first row in the file.  

Then select rows you want to skip. The filters work by checking whether a designated 
column meets a criterion you specify. You can apply any combination of three kinds of 
filters: Skip all rows until a criterion is met; skip all rows after a criterion is met; or skip 
every row that meets your criterion. 
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When defining the criterion, use any column in the file. You are not restricted to using 
columns you choose to import. Compare by checking whether the column is less than or 
equal to (<=), less than (<), equal to (=), greater than (>), greater than or equal to (>=) or 
not equal (<>) to the value you enter. It is not possible to define criteria that compare 
values in two columns, only to compare the value in one column with a value you enter in 
the dialog. 

If your data file is huge, decimate the data as you import. "Decimate" literally means to 
keep one of every ten rows of data, but you can tell Prism to skip any number of rows 
between the rows it imports. It imports a row, skips the number of rows you specify, and 
then reads another row. This is useful with any large file as a way to make Prism files 
smaller and accelerate analyses and graphing. 

Choose a range of columns you wish to copy by specifying a first and last column. Or 
choose to read a column, skip one or more columns, and then read another column. 

Some statistics programs save data in an indexed format (sometimes called a stacked 
format). Each row is for a case, and each column is for a variable. Different groups or 
experimental conditions are not defined by different columns (as Prism is organized), but 
rather by a grouping variable. Prism can unstack indexed data. Specify which column 
contains all the data and which column contains the group identifier. The group 
identifiers must be integers (not text), but do not have to start at 1 and do not have to be 
sequential. 

For example, in this sample of an indexed data file, you may want to import only the data 
in column 2 and use the values in column 3 to define the two groups. 

 

Row # Col. 1 Col. 2 Col. 3 

1 12 123 5 

2 14 142 6 

3 13 152 5 

4 12 116 6 

5 11 125 6 

6 15 134 5 

 

In the Filter tab of the Format Data Object dialog, check the box to unstack data only from 
column 2 using column 3 to identify the groups. Prism will automatically rearrange the 
data, so they look this like: 

Row # First Col. Second Col. 

1 123 142 

2 152 116 

3 134 125 
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The column that identifies the groups must contain integers. The lowest integer defines 
the group whose values will be placed in the column containing the insertion point in 
Prism. If there are gaps in group numbers, Prism will leave blank columns. 

Note. If you use Paste Special to paste data from the clipboard, the 
column numbers in the Filter tab are relative to the range of data you 
copied to the clipboard. If you copied columns C13-F45 from Excel to the 
clipboard, then column 1 in Prism’s Filter tab refers to the data in 
Column C in Excel, the first column of the copied range. 

To denote an excluded value in a text file (or within Excel), put an asterisk immediately 
after the value. Then check the option on the Filter tab of the Import or Paste Special 
dialog to exclude values followed by asterisks. 

When entering data, you can leave any parts of the data table empty. Prism automatically 
figures out what to do with missing values. When Prism imports a text file, it handles 
missing values automatically. Some other programs use a code, say 99, to denote missing 
values. If you import data from such a program, enter that code value into the Filter tab.  

Placement tab  

 

Choose whether you want to rename the Prism data table and/or the Prism column titles 
with the name of the imported file or with text imported from a specified row in that file. 
Count rows from the top of the file – you can specify a row that is not included in the 
range of rows selected in the Filter tab. 

Specify the top-left corner of the data object in Prism. Normally, this will be the 
position of the insertion point when you choose the Import or Paste Special command, 
but you can change it. 

Prism can rearrange the data as it imports.  

If you choose Transpose, the first row in the source will become the first column in 
Prism, the second row in the source becomes the second column in Prism, and so on. 
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Choose By rows or By columns if the data source has one column (or row) and you 
want to organize the data according to your experimental design. 

Example: Your data source has thirty values in a single column, and you wish to import 
into a Prism data table formatted for entry of triplicate Y values. The first three values in 
the source data are the first three replicates. The next three values in the source are the 
next set of replicates, so they belong in row 2 of data set A. After filling five rows, you want 
to start inserting data into data set B. Choose to import by rows, placing three values on 
each row and starting a new column after five rows. 

 

If the data source had the values from 1 to 30 in order, Prism would organize the data as 
shown below. When placing values side-by-side, Prism does not pay attention to the 
difference between subcolumns and data sets. It just puts values in the next cell to the 
right, and it doesn't care whether that cell is another replicate, a SD, or the beginning of a 
new data set. In the example above, Prism placed three values side-by-side because you 
entered 3 into the dialog. The data table was formatted separately for triplicate values. 

 

What if the data were organized differently, so that the first five values are the first 
replicate of the first group, the next five values are the second replicate, etc.? Choose to 
arrange the data by columns, stacking five values in each column. 

 

 Prism organizes the data like this: 

 

Note: If you choose to arrange the data “By rows” or “by columns”, Prism 
reads the values row-by-row from your source file, but ignores all line 
breaks. It treats the data as though it came from one column or one row. 
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Info and notes tab 

 

When importing a text file (or pasting), you can also import information into a linked Info 
page.  

One way to do this is to specifying a range of row numbers for importing info or notes. 
The first row in the file is row 1. 

If you can control the format of your text file, you can include info constants and notes in 
structured sections at the beginning of the file. 

<Info> 
Experimenter, “Dave Jones” 
”Lot number”   564A 
”Specific radioactivity”   345.6 
</Info> 
<Notes> 
The experiment went smoothly, but we noticed a large bubble in the third 
replicate at 10 micro molar. 
</Notes> 
<Title> 
Experiment of June 32, 2098 
</Title> 

 

Enter a tab after the info variable name to separate it from its value. If the variable name 
is two words, you may use quotation marks around the name.  

The three blocks (info, notes, and title) can appear in any order. You don’t need to include 
all the blocks, but they must appear at the beginning of the file.  

If the info variable already exists, its value will be updated. If the variable doesn’t exist, it 
will be appended to the table. Notes will be appended to the notes (right) portion of the 
Info sheet. It is not possible to include Greek letters or super or subscripts when 
importing. 

The title you enter, if you include a <title> section, will replace the sheet title. 

When you see the preview of your data in the second tab of the dialog, it will not include 
the structured information enclosed in notes, info, or title tags. When you enter 
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information on the Filter tab about which rows to include, start counting with the first row 
following the structured information. 

Data objects in Prism 
Blocks of Prism data linked to a text file or linked to an embedded spreadsheet (Windows 
only) appear with a border around them. These are called data objects. You cannot edit 
these values within Prism. When you click on any cell within a block, you select the entire 
data object. The figure below shows a data object that occupies rows 2-5 of the second 
column. 

 

To Do this 
Open the Format Data 
Object dialog. 

Double-click anywhere within the block. 

Edit the data. Double-click to bring up the Format Data Object dialog. 
Then click Open File to Edit Data. After editing and 
saving the spreadsheet, return to Prism and press 
Update to close the dialog. 

Unlink a data object. Double-click anywhere within the object to bring up the 
Format Data Object dialog. Click the Unlink button on 
bottom of that dialog. The values will remain on Prism’s 
data table, but will no longer be linked to an external 
file or to an embedded spreadsheet. 

Move a data object to a 
different location on 
the same table. 

Click anywhere in the data object to select it. Select the 
Cut command from the Edit menu. Move the insertion 
point to the cell that will become the new upper-left 
corner of the data object. Then select Paste from the 
Edit menu. 

Move a data object to a 
different data table. 

Click once on the data object to select it. Pull down the 
Edit menu, and select Copy. Go to the other table, and 
click to position the insertion point. Pull down Edit and 
select Paste. 

Update values in Prism 
after editing a linked 
file. 

Double-click on the data object in Prism to bring up the 
Format Data Object dialog. Press the Update button on 
that dialog. This is only necessary if you didn't check 
the option to automatically update on the Source tab. 
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To Do this 
Change the region of a 
spreadsheet file linked 
to Prism. (Windows 
only.) 

If you accidentally linked to the wrong part of a linked 
spreadsheet, the simplest approach is to unlink the data 
object, then start over.  

An alternative approach is to change the region linked 
within Prism. Click on the linked data object, then pull 
down the Edit menu and choose Links. You’ll see a list 
of each linked data range on the current Prism table, 
with the region you selected already highlighted. Press 
Change Source, to bring up a second dialog. At the 
bottom of that dialog, you'll see the current linked 
range in the field labeled Item Name. With Excel, this 
range is formatted in an unfamiliar way. R1C3:R100C4 
goes from the first row of column 3 to the 100th row of 
column 4.  

Change the region of a 
spreadsheet embedded 
within Prism. 
(Windows only.) 

If you accidentally embedded the wrong part of a 
spreadsheet, you'll need to copy and paste again. You 
can't simply delete the data object and start again, 
because the object contains the embedded Excel table. 
If you don't have the original spreadsheet file, you need 
to save it from Prism. To do this, open the embedded 
spreadsheet from Prism, and then use Excel's File..Save 
Copy As command to save the spreadsheet as a file. 
Then you can delete the data object, and start over.  

Select a single cell 
within a Data Object to 
copy to the clipboard. 

It is difficult to select a single cell within a data object. 
If you click on a cell in a data object, you’ll select the 
entire object. To select one cell within an object, click 
on a cell near the object, but outside of it. Then use the 
arrow keys to move the selection inside the object to the 
desired cell.  

If a linked file has moved 
If the linked text or Excel file no longer exists, Prism tries to find it. It knows the 
relationship between the original location of the file and the location of the Prism file at 
the time the link was established. If the Prism file has moved, it looks for the linked file at 
the same relative position. If you keep the linked files in the same folder with the Prism 
file, Prism will always be able to find it – even if you move the files to a different 
computer. If it can’t find the file, it notifies you, and you can either locate the file using a 
File Open dialog or you can choose to unlink the data. 

Note: Prism stores the imported values in its file, not just the name of 
the linked file. If the linked file is deleted or renamed, Prism will not be 
able to update the data table. However, the imported values remain in 
the Prism file. You don’t lose any data if the link is broken. 

Editing linked or embedded Excel data (Windows only) 
After linking or embedding Excel data in Prism, you'll see the data in Prism as a data 
object surrounded by a border.  
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See "Data objects in Prism" on page 39. Double-click anywhere in the data object to bring 
up the Format Data Object dialog (described in detail below). Then click the button "Open 
file to edit data" to edit within Excel. 

While editing embedded data in Excel, the title of the Excel window will look like this:  

 

The name of the Prism file is followed by the name of the Prism data table that includes 
these data. Then comes the Excel range pasted into Prism table as sheet name (workbooks 
can have several sheets or tabs), row and column number of the upper left corner, and the 
row and column numbers of the lower right corner. In this example, the only values of the 
spreadsheet included in Prism are on Sheet1, starting at row 4 column 3 (C4) and ending 
at row 12 column 4 (D12).  

While a linked or embedded worksheet is open in Excel, the data object within the Prism 
table appears hatched. When you close the worksheet in Excel, the appearance in Prism 
will return to normal.  
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7. Organize experimental details on info sheets 

Overview of info sheets 
Use info sheets to include information about your experiments in your Prism files. Include 
both unstructured notes and structured information, such as experimenter, experiment 
date, lot numbers, notebook identifier, concentrations, etc.  

An info sheet can be linked to a particular data sheet or be global for the entire project. 
Each data table may be linked to one or more info sheets or may have no associated info 
sheets.  

 

Creating an info sheet 
To create a new info sheet, click the New button on the toolbar, or drop the Insert menu. 
Choose New Info Sheet. 

 

On the Create New Info Sheet dialog, choose whether the new sheet is linked to a 
particular data table.  

Prism can automatically create a linked info sheet to accompany every new data table you 
create. Drop the Edit menu (Prism menu in Mac OS X), choose Preferences, choose the 
Info Sheet tab, and check the option to automatically create a new info sheet for every 
data table. 
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Editing info sheets 
The right side of an info sheet is a simple text editor for notes. Editing notes is 
straightforward—just click and type. To change margins and line spacing, click within the 
Notes box, then select Change and Notes Format. 

The left side of the info sheet is for structured information with the left column for 
constant names and the right column for values. Both the name and value can be more 
than one word (it’s OK to include spaces). You may also use Greek letters, superscripts, 
and subscripts using the toolbar buttons. 

To change the order of the rows, click on a row, then click the right mouse button. From 
the shortcut menu, choose to move the selected row up or down, or choose to delete that 
row. 

Save time and maintain consistent terminology by using default info constants. Drop the 
Edit menu (Prism menu in Mac OS X),  choose Preferences, and choose the Info Sheet tab. 
You may enter just the constant name and leave the value blank, or you may also enter 
default values. These constants will appear automatically on all new info sheets (in any 
project). Of course, you can later edit the information on each individual sheet. 

 

Tip: You can import info constants (and notes) along with data from a 
text file. See page 38. 

Using info constants in analyses 
You can insert info constants as constraints in nonlinear regression or as constants when 
transforming. You’ll know when it’s possible to insert an info constant, because Prism 
superimposes a small dialog that lets you choose an info constant.  
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Choose a value from that dialog, and Prism puts that value into the analysis, showing the 
value in parentheses in the dialog. This is a live link, and changing the info constant will 
cause the analysis to be recalculated with the new constant.   

Placing info constants on graphs or layouts 
There are two ways to include info constants in graphs or layouts. 

• Embed all or part of the info table. Select all or part of the info table, and copy to 
the clipboard. Then go to a graph or layout and paste. This will be a live link, 
updated if you edit the info table. Double-click on the embedded table to adjust its 
properties. 

• Insert into a graph title, legend, or text object. While entering text, drop the Insert 
menu and choose Info Constant. Prism maintains the link, updating the text when 
you edit the info table. 
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8. Analyzing data  

Choosing an analysis 
You can start an analysis from a data table, a graph, or tabular results (i.e. results of a data 
transform). Simply click the Analyze button. 

 

Note: The Analyze button isn't just for statistics and regression, but also 
for data manipulations such as transforming, removing baselines, and 
normalizing. 

 

 

When choosing a built-in analysis, first choose a Type on the left then choose an analysis 
on the right. The sixth choice, Recently used, lists the seven analyses you have used most 
recently. The analysis you want will often be on this list. 

Note: You can also choose to reapply a series of analysis and graphing 
steps, either within the same file or saved as a method file. For details 
see Chapter 10. 

Chaining results  
The results of some analyses, such as transforms, can be analyzed further. For example, 
you might want to first remove a baseline, then transform the results of that analysis, and 
then perform nonlinear regression on the transformed results. There is no limit to how 
many analyses can be chained together in this way. When you edit or update the data 
table, Prism will update the entire analysis chain automatically. 
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Analyze a results table just as you analyze a data table. Go to the results table (and if it has 
several subpages or views, pick the right one). Then click Analyze.  

Note: You cannot use a saved method to analyze results tables. 

Choosing data to analyze 
Prism analyzes one data table at a time, and normally analyzes all data sets on that table. 
To analyze only selected data sets from that table, choose "Selected Data Sets" on the 
bottom of the Analyze Data dialog, then select the data sets to analyze on a second dialog. 

 

Analysis parameters dialogs 
After you choose an analysis, Prism will bring up a Parameters dialog. All the analyses are 
all explained in detail in the companion books. Each parameters dialog has a button "Help 
me decide" which will bring up online help explaining the principles of the analysis. 

Viewing and graphing results 
The results of all analyses are stored in the Results section of your project and saved with 
the project file. 

Some analyses produce several subpages of results. For example, linear regression can 
produce one subpage that tabulates results, another that contains the XY coordinates of 
the regression line, another with residuals, and another with standard curve calculations. 
Choose between these subpages using the drop down list in the toolbar. 

 

Tip: After dropping the list box, press the UP or DOWN arrow keys to 
browse through all the subpages. As you change the selection in the list 
box, you also change the subpage displayed on the screen. 

You can also choose analysis subpages in the Navigator on the left of the Prism window. 
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Changing an analysis 
After reviewing the results of an analysis, you may want to change your choices. If you 
only want to keep the revised results, don't repeat the entire analysis. Fix the problem 
instead.  

To change the analysis parameters (choices), press Change and choose Analysis 
Parameters.  

To change which data table and data sets to analyze, press Change and select Data 
Analyzed. Choose a different table, and press Select to choose which data sets on that 
table to analyze. You can only choose one table for each analysis. 

If you picked the wrong analysis (say, linear regression instead of nonlinear regression, or 
t test instead of one-way ANOVA), delete the invalid results so you don't clutter your 
project with obsolete sheets. To delete a sheet, pull down the Edit menu and choose Delete 
Sheet(s). Or right click on the sheet name in the Navigator panel, and choose Delete sheet 
from the shortcut menu. Then go to the data table, press Analyze and choose the correct 
analysis. 

Frozen and orphaned results 

Frozen results 
Data are linked to results. If you change the data, Prism automatically recalculates the 
analyses and updates the results. 

Freeze results you don't want Prism to update. For example, you might want to freeze the 
results before excluding some outliers from the data, then repeat the analysis and have 
both copies of the results in the project. To freeze a results sheet, select Freeze sheet from 
the Edit menu. To unfreeze the sheet, choose Freeze sheet from the Edit menu again. 
Prism immediately recalculates the analysis. 

 

Orphaned results 
Prism automatically links results pages to the data. If you delete a data table, linked 
results are labeled orphaned. You can view and graph orphaned results, but you cannot 
change the parameters. 

 

Note the distinction between deleting data sets and deleting just the values. If you erase 
all values from a data set using the DEL key, Prism still maintains the links between the 
data and the results. Since there are no data, the results will become blank. When you 
later add data, Prism will update the results automatically. This is the concept behind 
templates.  



 

48 GraphPad Prism User’s Guide 

Analysis preferences 
To change default Analysis Preferences, pull down the Edit menu (Prism menu on Mac OS 
X), choose Preferences, and then choose the Analysis tab. 

 

The choices for linear and nonlinear regression become the default choices when you 
perform regression in the future. You can always override the defaults for each individual 
analysis. These choices only affect analyses you do in the future. They do not affect 
analyses already performed.  
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9. Embedding results on graphs  

Overview of embedding a data or results table 
You can copy and paste any portion of a data or results table onto a graph or layout. This 
lets you display a graph with an entire data table or with selected analysis results.  

Like graphs and analyses, these tables remain linked to the original data. If you edit or 
replace the original data, Prism will update the embedded tables. 

The example below shows the simplest table, consisting of a single value, the P value. The 
text "P=" is a separate text object placed in front of the embedded table. Because the P 
value is an embedded table, it is linked to the data and analysis (unpaired t test). If you 
change the data, the P value in the graph will change automatically. (The line above "P=" 
is actually an arrow with a special style of arrow head. See "Drawing lines, arrows, and 
shapes" on page 125. )  
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The example below shows a longer table to the right of the graph. The data were fit with 
nonlinear regression, with standard curve calculations to interpolate unknown values. To 
place the table of unknowns on the graph, simply select it, and then paste to the graph.  
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How to embed a data or results table 
To embed a data or results table: 

1. Select a portion of a data or results table and copy to the clipboard.  

2. Go to a graph or layout, move the mouse to the appropriate spot, click the right 
mouse button, and choose Paste. Or choose Paste from the Edit menu. 

3. To change the appearance of the table, double-click on it to bring up the Format 
Embedded Table dialog. 

 

Troubleshooting embedded tables 
How can I make the table larger? 

Select it, and then drag a corner to stretch it. The fonts will get larger as well. If 
you increase the font size from the Table properties dialog, the table will grow. 

How can I place a single result (say a P value) on a graph? 

The table can be as small as a single value. Click on that result cell, and copy to 
the clipboard. Then paste onto a graph. 

How can I change the number of decimal places shown in the table? 

You cannot edit the numerical format inside the table. However, you can adjust 
the number format in the data table and results table. For data tables (and results 
tables like Transforms), select one or more columns and choose Number format 
from the Edit menu. For other results, choose the number format on the 
Parameters dialog. From the results sheet, press Change and then choose 
Analysis parameters. 
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Can I embed a Prism table into another program? 

Not directly. But you can embed the table into an empty layout within the same 
Prism project, and then copy and paste embed that layout into another program. 
For example, this method would let you include a Prism results table in a 
PowerPoint slide. 

Can I embed a table created with Excel or Word? 

Yes. Simply select part of a table in Excel or Word, and copy it to the clipboard. 
Then go to a Prism graph or layout and paste. 

Can Prism create a table containing only text? 

Yes. Click the New button, and choose New Data Table. Choose X and Y formats, 
and choose Text for each. 

How can I change the range of cells included in the embedded table? 

Initially, you specify which cells to embed by selecting and copying the 
appropriate range. You can change that range from the Format Embedded Table 
dialog. An option box controls whether X values (row titles) are included. The 
range of Y values is controlled by entering the upper left and lower right cell. 
Follow these examples. 

From  To Comment 

A1 C4 From the first row of column A to the 
fourth row of the column C. 

A1 E: All of columns A through E. Since there 
is no final row number, the entire 
columns are included.  

A1 ZZ The entire table. 

E3 E3 Only the value in the third row of 
column E. 
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10. Simulating data  

Overview on data simulation 
Prism lets you generate simulated data. The X values can come from a data table you 
entered or can be generated as an arithmetic or geometrical series. The ideal Y values can 
also come from a data table but are more often computed from an equation. Prism can 
then add random scatter to these ideal values, using a variety of rules to compute the 
scatter.  

Prism considers simulating data to be an “analysis” so the values appear on a results table. 
You can analyze and graph these simulated data, just like any other table.  

Some questions about data analysis and experimental design can best be answered by 
simulating many data sets, analyzing each, and then looking at the distribution of the 
results. 

Tip. Don’t confuse simulating data (with random error) with creating a 
theoretical curve (plotting a function) so you can see how the plot 
changes as you vary a parameter. See page 56. 

Simulating data with random error 
Prism makes it very easy to create (and then analyze) simulated data with random error.  

1. To simulate a dataset, start from a data table or graph.  

2. If you want your simulated error to have X values you enter (rather than a series), 
enter these into a data table. If you want your simulated data to use ideal Y values 
based on values you enter (with random error then added), enter these on the same 
table. 

3. Click Analyze, select built-in analysis, and then select Simulate data with 
random scatter from the list Simulate and generate.  

4. The first tab defines the X values. In most cases, you’ll generate a series by 
choosing the starting value and arithmetic or geometric increment. Or choose to 
use the X values of the table you are analyzing. 
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5. The second tab defines the ideal Y values. In most cases, you’ll choose an equation, 
but you can also choose to use the Y values of the data table you are analyzing.  

 

6. If the Y values come from an equation, choose how many datasets you wish to 
generate, and how many replicate values you wish. You can choose different 
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equation parameters for each data set. The replicates within each data set are 
generated from the same equation parameters but with different random error. 

7. Enter the parameters for the first data set you wish to generate, as well as a column 
title for the results. 

8. If you are simulating more than one data set, go to the next one using the drop 
down menu (choose Data set B or Data set C….).  Click Copy Previous 
Parameters to copy the parameters (and column title) from the previous data 
set, then edit as needed. 

The third tab defines how Prism adds random numbers to each value. Choose the kind of 
random number, and enter the SD value(s) if prompted. 

 

Kind of error Comments 

Gaussian, 
absolute 

Random errors are taken from a Gaussian distribution with a mean of 
zero and a SD you enter. These errors are added to the ideal Y values. 

Gaussian, 
relative 

Enter the SD as percent error. Prism will choose a random number from 
a Gaussian distribution with a mean of zero and the SD you enter. It will 
then multiply that percentage times the ideal Y value. This means that 
the size of the error, on average, will be proportional to the Y values. 
These errors are then added to the ideal Y values. 

Double Gaussian Random errors are taken from two Gaussian distributions with a mean 
of zero and two SD values you enter. You choose the probability that the 
random value will be chosen with the first (vs. the second) distribution. 

Poisson The resulting Y values come from a Poisson distribution, based on the 
ideal Y value. This only makes sense when the Y values represent the 
number of objects you would observe in a certain space, or the number 
of events you would observe in a certain time interval. 
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Kind of error Comments 

t distribution The t distribution is wider than a Gaussian distribution when df is small 
and is virtually the same as the Gaussian distribution when the df is very 
high. The t distribution with 2 degrees of freedom is very wide, so 
simulates data with outliers.   

Lorentzian The Lorentzian distribution is wider still, with a high chance of outliers. 
It is identical to the t distribution with df=1. The random error applied 
to your Y values equals a random value from a Lorentzian distribution 
times the SD you enter. (SD is not actually the correct term here, as the 
Lorentzian distribution allows for so many outliers that its SD is 
infinitely large.) 

How Prism generates random numbers 
Prism can add random values to each of the calculated Y values to simulate experimental 
error.  

The only way to generate truly random numbers is through a random physical process, 
such as tossing dice or measuring intervals between radioactive decays. Prism, like all 
computer programs, generates “random” numbers from defined calculations. Since the 
sequence of numbers is reproducible, mathematicians say that the numbers are “pseudo-
random”. The difference between truly random and pseudo-random numbers rarely 
creates a problem. For most purposes, computer- generated random numbers are random 
enough to simulate data and test analytical methods. 

Prism generates random values from a Gaussian distribution using routines adapted from 
ideas presented in Numerical Recipes in C, (W. H. Press et al, second edition, Cambridge 
Press, 1992; available online at www.nr.com). The function RAN3 (defined in Numerical 
Recipes) generates uniformly distributed random numbers and the function GASDEV 
transforms them to a Gaussian distribution with a mean of zero and a standard deviation 
you enter.  

Prism uses the time of day when calculating the first random number, so you will get a 
different series of random numbers every time you run the program.  

Prism can also generate random numbers based on a Poisson distribution. Again, our 
method is based on ideas from Numerical Recipes.  

Prism also can generate random numbers from a t distribution with any number of 
degrees of freedom (df). If df is low, this distribution is wide. If df is high (more than 20 or 
so), it is almost indistinguishable from a Gaussian distribution. If df=1, the distribution is 
extremely wide (lots of outliers) and is identical to a  Lorentzian distribution, also known 
as the Cauchy distribution. Prism uses this equation to generate random numbers from 
the t distribution with df degrees of freedom: 

i= df

i= 1

*

Rand

Rand Rand
df∑

 

In this equation, Rand is a random number drawn from a Gaussian distribution with 
mean=0 and SD=1. To compute a random number from a t distribution with df degrees of 
freedom, you need to use df+1 different random numbers drawn from a Gaussian 
distribution. 
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Simulating many data sets using a script 
When testing analysis methods and experimental designs, it can be useful to simulate and 
analyze a large number of data sets. Prism makes this easy. 

First create a Prism project that simulates one or more data sets and performs the 
analyses. In the example below, the project has two results pages. The first simulates some 
data and the second analyzes the simulated data via nonlinear regression to a sigmoidal 
dose-response curve.  

Then create a Prism script, as shown below, and save as a plain text file. 

SetPath “C:\temp” 
Openoutput “simulation.txt” clear 
Foreach 1000 
  Goto R 1 
  Regenerate 
  Goto R 2 
  Wcell 5,1 
Next 

To run the script, drop the File menu and choose Run script. 

The first line defines the folder you are working with, and the second line opens an output 
file in that folder and clears (deletes) its contents if the file already exists. Then the script 
loops 1000 times. It goes to the first results page (with the simulation) and regenerates 
the random numbers. It then goes to the second results page (with curve fit results) and 
writes the value (in this example, the logEC50) in the fifth row of the first column into the 
output file. Then it repeats the loop. 

When done, the file simulation.txt contains 1000 logEC50 values from 1000 sets of 
simulated data. 

Learn more about Prism scripts in Chapters 28. 

Creating a family of theoretical curves 
Prism can graph a family of theoretical curves to help you understand the properties of 
the model. This is sometimes called “plotting a function”.  

Note: Generating a family of theoretical curves is quite different than 
fitting a curve with nonlinear regression. With nonlinear regression, you 
choose the equation and Prism finds the values of the parameters that 
make that equation fit your data the best. When plotting theoretical 
curves, you choose both the equation and the values of the parameters, 
and Prism graphs the function. There is no curve fitting involved. 

To simulate a family of curves, start from any data table or graph and follow these steps. 

1. Click Analyze, select built-in analysis, and then select Create a family of 
theoretical curves from the list of  Simulate and generate.  



 

10.  Simulating data 57 

  

2. The curve will be defined by a number of line segments. Choose how many 
segments you want. The default value of 150 will suffice for most purposes. 

3. Choose a starting and ending value for X. 

4. Select an equation. 

5. Choose how many curves you wish to generate. All will be generated from the same 
equation, over the same range of X values. You can enter different parameters for 
each. 

6. Enter the parameters for the first data set. 

7. If you are creating more than one curve, go to the next one using the drop one 
(choose Curve B or Curve C …). Click Copy Previous Parameters to copy the 
parameters from the previous curve, then edit as needed. 
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11. Analyzing and graphing repeated experiments 

Science is repetitive by its very nature. Prism provides several approaches to analyzing and 
graphing repetitive data. You'll use a different approach depending on whether you simply 
want to repeat analysis and graphing steps within the same project, repeat those analyses 
and graphs in different projects, or automate analysis of a large number of data files at once. 

Repetition within a project 
Prism offers several ways for you to instantly analyze and graph data from a repeat experiment 
exactly as you analyzed and graphed data from the first experiment, all within one project.  

Duplicating a family of sheets 
Enter, analyze and graph your first experiment. Then go to the data table and click the New 
button. Choose to duplicate the current sheet with its family (linked analyses and graphs).  

 

Prism will create a new set of sheets within the same project. Go to the new table. It will 
have a copy of the data you entered on the first table. Replace the values with your new 
data. Because this new data table is linked to new results and analyses, simply go to these 
new sheets to see the analyses and graphs of the second experiment. All your analysis and 
graphing choices are automatically and instantly applied to the second set of data.  

Method by example 
After entering, analyzing, and graphing the first experiment, create a new data table and enter 
the data table of the second experiment. From this table, press Analyze, then choose Method 
by example and select the data set to use as an example (which must be in the same project).  
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Advantages and disadvantages of the two methods 
The two methods are very similar, and your choice is mostly a matter of preference. Do 
you want to first enter the new data and then decide what to do with it? Or do you want to 
duplicate the first data table, and then replace the values?  

If you use the Method by example, you don’t have to format the data tables exactly the 
same way. The first experiment could be formatted for entry of triplicates, while the 
second experiment is formatted for entry of duplicates.  

An advantage of duplicating the family is that you will also duplicate the column titles and 
X values, which are likely to also apply to the second experiment.  

Templates  

Templates simplify your work 
A template is a Prism project with a Prism table linked to analyses and graphs. Open a 
template, enter new data, and the analyses and graphs are completed automatically.   

Creating a template 
Prism users often hesitate to create templates, thinking it is a complicated process. It isn’t. 
Simply follow these steps: 

1. Create a new file with data from a representative experiment, and all necessary info 
sheets, analyses and graphs.  

2. Erase the portions of the data that will change with each experiment (for example, 
erase the Y values but leave the X values and the column titles).  

3. Switch to the sheet that you want to see when you open the template, usually a data 
table. Also position the insertion point to the spot where you will first want to enter 
data.  

4. Pull down the File menu, choose Save Special, and then choose Save Template.  
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5. Choose a category, or create a new one. Then enter a new name for the template file 
or choose to overwrite an existing template.  

6. Enter a description or instructions which will be shown every time someone uses 
this template. You may leave this blank. 

Tip. Templates don't have to contain only one data table. If your 
experiment has several parts, create a template with two or more data 
tables.  

Using a template 
Choose a template from the Welcome dialog when you start a new project, or from the 
Create New Table dialog when you add a data table to an existing project. 

 

If the template was saved with a description and/or instructions, these will appear in a 
dialog superimposed over the data table. Then enter the new data and view the completed 
graphs and results. 

Tip: Templates don't have to perform any analyses. You can create a 
template that simply makes a graph. 

Methods 
Methods are similar to templates. But while templates include a data table you add to 
your project, you apply a method to a data table you’ve already created.  

Using either templates or methods can speed your work. The two have very similar 
capabilities, and which you use is a matter of personal preference. 



 

11.  Analyzing and graphing repeated experiments 61 

Saving methods 
If you frequently analyze and graph data using the same steps, you can simplify your work 
by saving a method. 

To save a method, analyze and graph representative data. Go to the data table, and select 
Save Special… Save Method from the File menu. The dialog is almost identical to the 
dialog used to save templates, shown on page 59. Choose a category, or create a new one. 
Then enter a new name for the method file or choose to overwrite an existing method. 
Finally (optionally), enter a description.  

The method includes all analysis chains and graphs made from the current data table. 

Using a method 
To use a method, go to any data table in any project and press Analyze. At the top of the 
Analyze Data dialog, choose to use a saved method. Then choose a category and method. 
The new data will be analyzed and graphed according to your method. The column format 
of your data table does not have to match the column format of the representative data 
used to create the method. 

 

Analyzing a large series of experiments 
Methods and templates automate analyses and graphing. If you want to analyze a large 
series of experiments at once, you will also want to automate data importing. To do this, 
run a Prism script.  

Don’t be scared by the idea of writing a script. Prism scripts tend to be very short and easy 
to write, since you only need to write script commands to import data and export results 
and graphs. The analysis and graphing steps are performed automatically by your Prism 
project, so they don’t require scripting commands. Even if you’ve never written a 
computer program, it will only take you a few hours to get started with Prism scripts. 

See "Automating Prism using scripts" on page 150. 
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12.  Creating and changing graphs 

Graphs are created along with data tables 
When you start a new project, or choose to make a new table, Prism creates a graph linked 
to that table (unless you tell it not to). Likewise, when you choose to insert a template into 
your project, it will usually contain both a data table and a graph.  

This means that you’ll rarely need to use a command to make graphs. The graphs are 
already there and you just need to go to the right one. Click on the Graphs tab, or choose a 
graph in the Navigator.  

Making more than one graph of the same table 
Although Prism automatically creates one graph for each table, you can create additional 
graphs. You can create any number of graphs of the same data. 

One way to make another graph is to duplicate an existing graph, and then edit one of the 
copies. Press the New button and select Duplicate Current Sheet.  

Note the distinction between duplicating the current sheet and duplicating the current sheet 
with family. If you duplicate a graph, it will be linked to the same data as the first graph. If 
you duplicate the graph with its family, you also duplicate the data (and any results). The 
original graph is linked to the original data table, while the duplicated graph is linked to the 
duplicate of the data table. This is useful when your goal is not to make two similar graphs of 
the same data table, but rather to make two similar graphs of different data tables. Duplicate 
the graph with family, and then change the data in the duplicated table. 

Another way to make another graph of a table is to click the New button and choose New 
Graph of Existing Data. Then choose a data or results table to graph. You can only choose 
one data table on the Create New Graph dialog. Once you’ve created the graph, you may add 
any number of additional data tables to that graph. Click the Change button and select Add 
Data Sets. 

Prism usually plots an entire data table on a graph. When you click New, then New graph 
of existing data, you can choose to only plot selected data sets. And you can choose to 
make a separate graph for each selected data set. If your data table has three data sets and 
you choose this option, Prism will create three separate graphs. 
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Changing the graph appearance 
Prism offers many ways to change a graph. To access all of them, click the Change button. 
You can change: 

• Graph type. If you chose the wrong kind of graph originally, change it. 

• Data on graph. You can add more data sets, or remove data sets. See the next 
section. 

• Colors. You can choose the background color of the page, and the plotting area 
(between the axes) direct from the Change menu. You can also choose a color 
scheme that changes the color of everything on the graph at once. You can also 
change colors from within the Format Axes and Format Symbols and lines (or 
Format Bars) dialogs. 

• Appearance of symbols, bars, etc. See Chapter 18. 

• Limits and appearance of axes. 

Changing which data are included on a graph 
When Prism creates a graph, it includes all data sets from a single data table. It then adds 
curve fits automatically. But a graph is not limited to plotting one data table.  

To add data to a graph:  

1. Click Change and choose Add Data Sets.  

Shortcut: Click on the table name in the Navigator and then drag the 
table name onto the graph. 
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2. Choose a data or results table and then the specific data sets on that table you wish 
to add to your graph.  

3. Choose whether these data should be plotted on the left- or right-Y axis. If you 
choose to plot on the right Y-axis, Prism will create that axis if it doesn’t already exist. 

4. If the data table you chose is linked to regression lines or curves, choose to add just 
the data or to also add those curves to the graph. 

Tip: Although new graphs contain one data table, you may include data 
from other tables on the same graph. 

To remove or replace data from the graph, click Change… Remove/Replace Data Sets. 
Then select one or more data sets and click Remove. Or select a single data set, click 
Replace, and then choose a data set to add in its place. 

 

Page orientation and background 
You can choose the page orientation of each graph separately. Click Change then Graph 
Type. Choose orientation, as well as background color, at the top left of the dialog. 

 

With many programs, you set page orientation for an entire file in the Printer Setup 
dialog. However, Prism ignores the setting in the Printer Setup dialog when printing 
graphs (and layouts). The problem is that the Printer Setup dialog has one setting for the 
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entire project. Prism lets you choose the orientation of each graph in the Format Graph 
dialog, so you can combine portrait and landscape pages in one file. 

You choice of portrait or landscape only matters when you print the graph from the 
Graphs section. This choice does not control the shape (aspect ratio) of the graph. Change 
the shape by clicking and dragging the axis ends. Or click Change.. Size and Frame to 
bring up the Format Axes dialog. 

Graph preferences 
When you create a new graph, Prism will use the preferences you have set in the Graph 
tab of the Preferences dialog. To change graph preferences, pull down the Edit menu 
(Prism menu in Mac OS X),  choose Preferences, and go to the Graphs tab. 

 

The choices on this dialog define the initial appearance of graphs that Prism creates 
automatically, as well as those you create manually. For example, you can choose the shape 
and size of the graph, whether it includes a frame, and the fonts used for titles and legends. 

These choices only affect the initial appearance of the graphs. You can customize each 
graph after it is made. The choices on this dialog do not change the appearance of graphs 
you have already made. 

Also choose the default zoom for the graphs and layout section of your project. This 
setting determines the magnification (zoom) of the graph you’ll see on the screen when 
you go to a different graph sheet. You can then change the zoom of that sheet using the 
View menu or the Zoom buttons. Changing the zoom only affects the appearance on 
screen, not the graph size when printed.   

Note: These choices only affect graphs you make in the future. Graphs 
you have already made are not affected by this dialog. 
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13. Plotting replicates and error bars 

How to enter replicate values in Prism 
When you collect scientific data, you almost always collect replicate data and plot the 
individual replicates or an error bar showing the variability of the data. 

Prism can graph error bars automatically. You enter the replicate (e.g., triplicate) values 
directly on the data table, and Prism automatically plots the error bars. Entering 
replicates works differently for one-grouping-variable column graphs than for XY graphs 
and two-grouping-variable bar graphs. 

Entering replicates for XY graphs and two-grouping-variable bar graphs 
If you are creating an XY graph or two-grouping-variable bar graph, choose the maximum 
number of replicates (number of subcolumns) when you create the table.  

 

Enter the replicates in side-by-side subcolumns labeled A:Y1, A:Y2 and A:Y3. 

 

Increase the number of subcolumns by clicking Change, then Format data table. 
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Entering replicates for one-grouping-variable column graphs 
When you choose a one-grouping-variable graph (box-and-whiskers, column bar graph, 
before-and-after graph, etc.), the data table has no subcolumns. Enter replicate values 
stacked in a column. You don’t need to specify how many replicates you will enter when 
you set up the table. 

 

 

Note: Enter replicates in this (stacked) format for t tests and one-way 
ANOVA. 
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How to enter previously computed SD or SEM values 
If you have already computed the SD or SEM in another program, you can enter, import 
or paste these directly into Prism. Choose the appropriate format when you create the 
data table. 

 

If you created the table incorrectly, click Change then Format Data Table. 

 

If you enter just the SD or SEM, Prism can plot that error bar. If you also enter N, Prism 
can switch between SD, SEM and 95% CI error bars and can also do statistical 
calculations. 

How to enter X error bars 
Prism can plot XY graphs with error bars in the X direction, as well as the Y direction. 
Choose to plot an X error bar when you choose the format of the data table or graph type. 
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If you forgot to choose an X error bar, you can reformat the data table. Click Change, and 
then Format Data Table. 

 

Enter the values for the X error bars into the subcolumn created for that purpose. Prism 
plots the values you enter as the error bar, and does not distinguish between SD, SEM or 
CI. The values you enter are used only for that purpose (graphing X error bars), and are 
not used in any analysis. 

 



 

70 GraphPad Prism User’s Guide 

0.0 2.5 5.0 7.5 10.0 12.5 15.0
0

25

50

75

Concentration
R

es
po

ns
e

 

The Format Symbols and Lines dialog presents choices for error bar color, thickness, and 
style. These choices apply to both the X and Y error bars. X error bars are always plotted 
in both directions. Prism doesn’t give you the choice of plotting the error bars only in the 
right (or left) direction. 

How to change how Prism graphs scatter or error bars 
When Prism creates a graph, it automatically includes error bars based on the format of 
your data table and your choice in the Graph tab of the Preferences dialog. You can easily 
change the way Prism plots scatter or error bars.  

Graphing scatter in XY graphs 
Double-click on any symbol, or click Change and then Symbols & Lines, to bring up the 
Format Symbols and Lines dialog. Click the All button on the dialog, or drop the Data set 
list and choose “Change ALL data sets”. That way you’ll be changing the error bar format 
for all data sets at once, rather than just one. Then drop the list labeled “Plot” and choose 
what you want to plot. Note that the second-to-bottom choice plots each replicate 
individually, rather than plotting an error bar. 
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Graphing scatter in two-category bar graphs 
Double-click on any bar to bring up the Format Bars dialog. Or click Change then Bar 
Appearance. 

Click the All button on the dialog, or drop the Data set list and choose “Change ALL data 
sets”. That way you’ll be changing the error bar format for all data sets at once, rather 
than just one. Then drop the list labeled “Error values” and choose what you want to plot. 

 

Graphing scatter in one-category column graphs 
Double-click on any symbol or bar to bring up the Format Bars dialog. Or click Change 
then Bar Appearance. 

Click the All button on the dialog, or drop the Data set list and choose “Change ALL data 
sets”. That way you’ll be changing the error bar format for all data sets at once, rather 
than just one. Then drop the list labeled “Plot” (or “Line at” if you are plotting a column 
scatter graph) and choose what you want to plot. 
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Graphing each replicate 
When making a XY graph or a one-grouping-variable graph, you don’t have to plot error 
bars. Consider displaying variation by showing each data point (replicate).  This is often 
the best way to show the data. 

Tip. Graphs that show every replicate value are often the best. They show 
what actually happened in your experiment.  

For an XY graph, choose “Each replicate” in the Format Symbols and Lines dialog. 
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If you enter data grouped by one variable, you don’t have to plot means and error bars. 
Instead, make a column scatter plot that shows each value in a group, with a line at the 
mean or median. Each data set (column) in the data table becomes a group in the graph. 
Choose a column scatter graph from the Welcome or New Table dialog (choose Type of 
graph and the One grouping variable tab).  

 

Prism can superimpose a line at the mean or median, as well as error bars. 
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Graphing the range and quartiles 
On XY graphs and bar graphs, Prism gives you the choice of plotting the median (or 
mean) with range, or the median with the interquartile range. 

 

The median is the 50th percentile. Half the values are higher, and half lower, than the 
median. The interquartile range extends from the 25th to the 75th percentile. One quarter 
of the values are above the 75th percentile, and one quarter are below the 25th percentile. 
Thus, the interquartile range (from 25th to 75th percentile) includes half of your values.  

If you are creating a one-grouping-variable graph, you can plot the median with either the 
range or the interquartile range by creating a column bar graph. Or you can include both 
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the range and the interquartile range by choosing a box-and-whiskers graph. The box 
extends from the 25th percentile to the 75th percentile, with a line at the median (the 50th 
percentile). Prism plots the whiskers to extend above and below the box to show the 
highest and lowest values (some programs define whiskers differently). A box-and-
whiskers plot shows quartiles: One quarter of the values lie between the top whisker and 
the top of the box; one quarter in above the median line within the box; one quarter below 
the median line within the box; and one quarter between the bottom of the box and the 
bottom whisker.  

Create a box-and-whiskers graph from One grouping variable tab of the Welcome or New 
Table dialog.  

 

Graphing the mean and standard deviation (SD) 
Prism can plot the mean and SD on XY graphs or bar graphs. 

 

The standard deviation (SD) quantifies variability. If the data follow a bell-shaped 
Gaussian distribution, then 68% of the values lie within one SD of the mean (on either 
side) and 95% of the values lie within two SD of the mean. This is illustrated in the graph 
below. Each point represents a value drawn at random from a Gaussian distribution. The 
data points are offset horizontally to prevent overlap.  
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The SD is expressed in the same units as your data. Prism calculates the SD using this 
equation (each yi is a value, ymean is the average, and N is sample size): 

SD
y y

N
i mean=
−
−

∑ ( )2

1
 

Why is the denominator N-1 rather than N? In the numerator, you compute the difference 
between each value and the mean of those values. You don’t know the true mean of the 
population; all you know is the mean of your sample.  Except for the rare cases where the 
sample mean happens to equal the population mean, the data will be closer to the sample 
mean than it will be to the population mean. This means that the numerator will be too 
small. So the denominator is reduced as well. It is reduced to N-1 because that is the 
number of degrees of freedom in your data. Defining degrees of freedom rigorously is 
beyond the scope of this book, but here is a simple way to think about it. When computing 
the SD of a list of values, you can calculate the last value from N-1 of the values and the 
mean (since you use the mean in the calculation of the numerator), so statisticians say 
there are N-1 degrees of freedom.   

The standard deviation computed this way (with a denominator of N-1) is called the 
sample SD. In contrast, the population SD is calculated with a denominator of N. Prism 
always calculates the sample SD. 

Prism graphs the mean and SD directly from the raw data. You don’t need to do anything 
special to tell Prism to compute the SD unless you want to see the SD values. To see the 
values, click Analyze and then choose Row Means/totals (for side-by-side replicates used 
in XY or two-grouping-variable bar graphs) or Column Statistics (for one-grouping-
variable graphs). 

Graphing the mean and standard error of the mean (SEM) 
Prism can plot the mean and SEM on XY graphs or bar graphs. 

 

The Standard Error of the Mean (SEM) is a measure of how far your sample mean is likely 
to be from the true population mean. The SEM is calculated from the standard deviation 
and sample size by this equation: 

SEM SD
N

=  

By itself, the SEM is difficult to interpret. It is easier to interpret the 95% confidence 
interval, which is calculated from the SEM (see the next section). 

Many scientists are confused about the difference between the standard deviation (SD) 
and standard error of the mean (SEM). The SD quantifies scatter — how much the values 
vary from one another. The SEM does not quantify scatter. Instead, the SEM quantifies 
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how accurately you have assessed the mean, taking into account both scatter and sample 
size. 

As you collect more and more data (increasing N), the SEM gets smaller. This makes 
sense, because the mean of a large sample is likely to be closer to the true mean than is the 
mean of a small sample. As you collect more data, the SD does not change predictably. 
The SD quantifies the scatter of the data, and increasing the size of the sample does not 
increase the scatter. Therefore, the SD is equally likely to get larger or smaller as you 
collect more data.  

Prism graphs the mean and SEM directly from the raw data. You don’t need to do 
anything special to tell Prism to compute the SEM unless you want to see the SEM values. 
To see the values, click Analyze and then choose Row Means/totals (for side-by-side 
replicates used in XY or two-grouping-variable bar graphs) or Column Statistics (for one-
grouping-variable graphs). 

Graphing the 95% confidence interval 
Prism can plot the mean and 95% confidence interval on XY graphs or bar graphs. 

 

The 95% confidence interval quantifies the precision of the mean. The mean you calculate 
from your sample of data points depends on which values you happened to sample. 
Therefore, the mean you calculate is unlikely to equal the overall population mean exactly. 
The size of the likely discrepancy depends on the variability of the values (expressed as the 
SD) and the sample size. Combine those together to calculate a 95% confidence interval 
(95% CI), which is a range of values. You can be 95% sure that this interval contains the 
true population mean. More precisely, if you generate many 95% CI from many data sets, 
you expect the CI to include the true population mean in 95% of the cases and not to 
include the true mean value in the other 5% of the cases. Since you don't know the 
population mean, you'll never know when this happens. 

The confidence extends in each direction by a distance equal to the SEM multiplied by a 
constant. This constant comes from the t distribution, and its value depends on sample 
size and how confident you want to be (95% confidence is standard, but you could pick 
another value). With large samples and 95% confidence this multiplier equals 1.96, 
resulting in the rule of thumb that the 95% confidence interval equals the mean plus or 
minus two standard errors. With smaller samples, the multiplier is larger.  

Which error bar should you graph? 
The figure below shows the many ways to display scatter and error bars on a graph. This 
figure shows how scatter can be shown on a one-grouping variable graph.  
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You have exactly the same choices with XY graphs. If you plot each replicate, it works a bit 
differently. On an XY graph, Prism does not give you the choice of superimposing a line at 
the mean or median, and plots each point exactly at its X coordinate without any 
horizontally staggering to prevent overlap.   
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A. Plot every value. Consider using this kind of graph routinely. It shows what 
actually happened (every data point) but takes up no more space than the other 
choices. 

B. Median with error bars showing the 25th and 75th percentiles.  

C. Median with error bars showing the range.  

D. Box-and-whiskers graph. The line at the middle is the median. Half the values 
were higher, half lower. The box extends from the 25th to 75th percentile. The 
error bars, or whiskers, extend down to the lowest value and up to the highest 
(some box-and-whisker graphs made by other programs define the whiskers 
differently).  

E. Mean and standard deviation. If the data are sampled from a Gaussian 
distribution, the bars extend over a region predicted to include 68% of the values.  

F. Mean and standard error of the mean. The error bars are much shorter. Note that 
they enclose only a tiny fraction of the actual data points. If you are not familiar 
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with how a standard error is computed, seeing a graph like column F can give you 
a misleading impression. You may mistakenly think the data are far less scattered 
than they actually are. (This may be why so many scientists prefer to show data as 
mean and SEM!) 

G. Mean with 95% confidence interval. If you assume that the data are sampled 
from a Gaussian distribution, and that each value is independent of the rest, you 
can conclude that there is a 95% chance that the range enclosed by these error 
bars includes the true population mean.  

As you can see, there are lots of ways to display scatter. Choice A is one extreme, plotting 
the raw data with no calculations. Column G is the other extreme, plotting a conclusion 
(confidence interval) calculated from your data without showing the variation at all. 

If each value comes from a different patient or a different animal, you probably want to 
show what actually happened. You want your graph to show the variability. Consider 
showing every value, as shown in column A. Or use choices B to E that are alternative 
ways of plotting scatter. Avoid plotting the SEM or 95% confidence interval. These values 
show you how well you have determined the mean, and do not show the variation among 
the data. 

If the entire scatter comes from experimental error, you may prefer to create a graph that 
shows you how well you have determined the mean rather than a graph that shows how 
much the replicates varied. In this case, it can make sense to plot the mean and 95% 
confidence interval of the mean. An alternative is to graph the mean and standard error. 

Error bar direction 

Choose error bar direction for a data set 
To make all the error bars for a data set to go in one direction, double-click on the symbol 
to bring up the Format Symbols and Lines dialog. Choose your data set and then choose 
the error bar direction. 
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Choose error bar direction for individual points 
Sometimes you want some data points to have error points extending up and others 
having error bars extending down. This can help avoid overlapping error bars and a 
confusing figure. You can do this with Prism, with a bit of work.  

First, format the data table for entry of asymmetric error bars by choosing Mean, +Error, -
Error. 

 

 

Next, enter the data. Enter only the + error values for points that you wish the error bar to 
go up, and enter only the – error values for points that you want the error bar to go down. 
You have to enter the actual error value; Prism can't compute the SD or SEM in this case. 
However, you could copy and paste the SD or SEM values from the results of a row 
statistics analysis.  
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Error envelopes, confidence bands, and prediction bands  
When fitting your data with linear or nonlinear regression, you can choose to graph 
confidence or prediction bands.  
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If you open the Format Symbols and Lines dialog, you can see how Prism plots the 
confidence band. 
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The confidence band is an “error bar” of the regression line, using a special error bar style 
denoted in the dialog with dashes. This error bar style connects the tops (and bottoms) of 
an error bar with a dotted line. Note that the graph shown above has two error bars. The 
data are plotted with error bars denoting the SD of the replicates. The linear regression 
line is plotted with an error envelope denoting the confidence band.  

You can use this error bar style for other uses. Below, we removed the regression line and 
its confidence band from the graph, and changed the style of the error bars of the points.  
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14. Axes  

General axis formatting 
Change the size and shape of the graph, the axis frame, and the graph origin on the 
General tab of the Format Axes dialog. To bring up this dialog, double-click on any axis. 
Or click the Change button and choose Size & Frame. Then choose the General tab. 

Shortcut: Double-click on the origin of the graph to bring up the General 
tab of the Format Axes dialog. 

 

Graph shape and size 
The easiest way to change size and shape is to stretch the axes with the mouse. Click once 
on an axis to select it. Knobs appear on both ends. Move the mouse over the right knob of 
the X-axis or the top knob of the Y-axis. Drag the axis to make it longer or shorter.  

If you want to make several graphs exactly the same size, set the size and shape of the 
graph on the upper left corner of the General tab of the Format Axes dialog (double-click 
on an axis to bring up this dialog). 

 

Prism can create a standard tall, square, or wide graph. On a wide or tall graph, the long 
axis is 1.5 times the length of the short axis. After you enter a new width or height, Prism 
automatically changes the other value. Or select a Custom shape, and enter width and 
height independently. 



 

14.  Axes 83 

You can only change the shape of a graph (ratio of height to width) from the Graphs 
section. When you place a graph on a layout, you can change its size but not its shape. 

Frame and axes 
The General tab of the Format Axes dialog offers eight choices for frames and axes: 
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• No frame. Just show the X and Y axes, meeting at the origin. 

• Offset X and Y axes. The X axis is moved down a bit, and the Y axis is moved to the 
left, so the two don’t touch. This is helpful if you have data at the minimum X 
value (usually zero) as it prevents the data point from being right on top of the Y-
axis. To customize the distance between the axes, click on an axis to select it, and 
then hold the mouse over the left or bottom knob and drag.   

• Plain frame. Frame completes the box started by the X and Y axes. 

• Frame with ticks. Show minor and major ticks on all four sides of the frame. 

• Frame with grid. Add grid lines at major ticks. 

• Hide X axis. Optionally show a scale bar instead. See "Hiding axes and showing 
scale bars" on page 94. 

• Hide Y axis. 

• Hide both axes. 
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Origin 

 

The position where the X and Y axes intersect is called the origin. Prism offers three 
choices (at the lower left corner of the General tab on the Format Axes dialog): 

• Set automatically. The X axis and Y axis intersect either at X=0, Y=0 or at the 
lower left corner of the graph, depending on the limits of the axes. 

• Lower-left. The X axis and Y axis meet at the minimum X and Y values shown on 
the axes, at the lower-left corner of the graph. 

• Upper-left. Useful for some bar graphs. 

• Custom. The X axis and Y axis meet at the coordinates you enter.  

Graph title 
Choose how far the graph title is from the graph, and what font is used. Or uncheck this 
option to omit a graph title. 

Format of each axis 
The Format Axes dialog offers individual tabs for the X axis, the left Y axis and the right Y 
axis. Use these to change the axis scaling, limits, ticks, etc. To bring up this dialog, double-
click on any axis, and you’ll be taken to the tab for that axis. Or click the Change button 
and choose Size & Frame. Then choose the tab for the axis you want to change. 
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Setting: Discussion: 

Gaps and direction 

 

Select a reverse axis to number the axis in descending rather 
than ascending order. If you choose a reverse axis, you cannot 
have a discontinuous axis. You can't choose a reverse axis with 
bar graphs. For explanation of discontinuous axes, see page 91. 

Scale 

 

Choose a linear, log10, or log2 scale. See "Logarithmic axes" on 
page 96. 

Range  

 

Prism determines the range and tick interval automatically and 
adjusts the range as needed if you edit the data. To override 
these settings, deselect “Auto” and set the range manually on the 
Axes dialog. 

Tick options 

 

The axis will start at the minimum value and end at the 
maximum value you enter. The first major tick and number is at 
the “starting at” value. Additional major ticks and numbers are 
placed at the interval you specify. 

Numbering and 
labeling  

 

Choose to omit numbering from the axis or to set the numbering 
location (above or below the X axis, the right or left of the Y-
axis). For numbers placed below the X axis, choose their angle. 

Also choose a format: Decimal ("13"), scientific ("1.3x101), or 
powers of ten ("1013"). Depending on the axis range, you may 
also have the choice of an antilog format. 

Choose a decimal format for the numbering, or choose “auto”, 
and enter a prefix to place in front of each number and a suffix 
to place after each number. 

Title Uncheck the option to omit a title. Choose a font and specify 
how far the title is from the axis. 
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Axis numbering 

To: Do this: 
Change the font, size, 
and color of the 
numbering on all axes. 

Drop the Edit menu and choose Select… All. Then drop the 
Change menu and choose Selected Text…. 

Change the font, size, 
and color of the 
numbering for one axis. 

Double-click on the axis to bring up the Format Axes 
dialog. Click the Font button in the Numbering or labeling 
section. 

Increase or decrease the 
size of the numbering. 

Click on an axis to select it. To also select the other axis, 
hold shift and click on it. Now press the +or – buttons in 
the tool bar to increase or decrease the point size. 

 

Change the default font 
used for new graphs.  

See "Graph preferences" on page 65. 

Move the numbers 
above/below the X-axis 
or to the right/left of the 
Y-axis. 

Select the position in the “location” section on the  Format 
Axes dialog. Or click on the numbering to select. Then drag 
with the mouse or nudge by clicking the arrow keys. 

Put a prefix in front of all 
axis numbers, or a suffix 
after. 

Enter the prefix (i.e. “$”) or suffix (i.e. “%”) in the Format 
Axes dialog. 

Make the axis numbers 
be vertical or angled. 

Choose the angle you want in the Format Axes dialog. 
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Axis titles  
Prism puts generic labels (“Title”) on top of the graph and on the X- and Y-axes.  

To:  Do this:  
Edit a title. Click in the title. If you are editing a Y-axis title, it will be 

temporarily displayed horizontally. Edit (or replace) the 
text. To enter more than one line, press Enter between 
lines. When you are done, click in the background of the 
graph. If you were editing a Y-axis title, Prism will erase 
the temporary horizontal title and redraw it vertically. 

 

Delete a title. Drag over the title to select it. If you are editing a Y-axis 
vertical title, it will be temporarily displayed horizontally. 
Then press the DEL key. 

 

Change the size, 
font, or color of a 
title. 

Select the title, or a portion of it. Drop the Change menu 
and choose Selected Text. Set the font, size and color in 
the Format Text dialog. You can also change the font by 
clicking the Font button in the Axis Title section of  the 
Format Axes dialog 

 

Make the title a 
bit smaller or 
bigger. 

Select the title, Then press the + or – buttons on the tool 
bar to change the point size.  

 

Justify the title. Usually the title is centered over the graph or axis. To 
right or left justify the title (with the edge of the axis), 
select the title, drop the Change menu, and choose 
Selected Text…. In the Justification section of the Format 
Text dialog, choose Left or Right justification. 

 

Move a title. You can move the title closer to or further from the axis. 
Move the mouse near the title until it turns into a two-
headed arrow. Then hold down the primary mouse button 
and drag.  

 

Change the 
default font and 
size used for new 
graphs. 

Pull down the Edit menu (Prism menu in Mac OS X),  and 
choose Preferences, the go to the Graph tab.  
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Graphs with two Y-axes 
When you plot several kinds of data on one graph, it is often useful to plot some data 
using a Y axis on the left side of the graph and other data using a Y axis on the right side of 
the graph. 
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To create the second Y axis, press the Change button, and choose Size & Frame. Go to the 
tab for the right Y-axis, and drop down the list choices for Gaps and direction (which by 
default shows “no right axis”) and choose Standard.  

 

Shortcut: Just assign data sets to the right Y axis, as explained below. 
Prism will automatically create the axis. 

All data sets are initially graphed using the left Y axis. Depending on the scale of the axis, 
the data points may or may not all be visible. To plot data using the right Y axis, double-
click on a data point (or click Change and choose Symbols and Lines) to bring up the 
Symbols and Lines dialog. At the bottom of the Symbols and Lines dialog, select “Right Y 
axis”. Repeat for each data set to be plotted on the right Y axis. 
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15. Custom ticks on axes 

What are custom ticks? 
The regular numbering along the axis may not be adequate to make the graph you want. 
Prism custom ticks feature lets you replace a number with specified text, add a tick with 
label, and add horizontal or vertical lines at specified coordinates. 

Custom ticks are very versatile. They allow you to customize your graphs in many ways. 

Hint: Take the time to explore the power and versatility of custom ticks. 
They are useful in many situations. 

How to create custom ticks 
Click the Custom ticks button on one of the axis tabs of the Format Axes dialog to bring up 
the Customize Ticks and Gridlines dialog. 

 

 

Enter the X- or Y-coordinate of the first custom tick, the label that goes under (or next to) 
that tick, and choose the tick style (tick, solid line, dotted line, tick with solid line, tick 
with dotted line, or none). Click the Add button, and repeat steps to add more custom 
ticks to the list. 
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If you place the custom tick (or line) at the location of a regular tick and leave the label 
blank, the number under (or next to) the regular tick will still appear. To erase the regular 
numbering, enter a space as the label for the custom tick. 

Examples of custom ticks 
The graph below shows how custom ticks can create a time axis. Create a custom tick at 
position X=6 with the text "6:00" with a tick, another at X=9 with the text "9:00", etc.  
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Tip: To color or shade the graph, press Change and choose Plotting area color. 
To show the light and dark times, draw rectangles with the drawing tools.  

The example below shows custom ticks used to draw grid lines. The dashed line for the Kd 
was created by adding a custom tick at X=2.585 with the text "Kd" and a dashed line. 
There is no way to link the position on the X-axis to the results of the curve fit. If you 
change the data, Prism will automatically change the curve and the embedded table 
showing the best-fit values of Bmax and Kd. You will have to manually change the position 
of the Kd dashed line. 
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To change a custom tick, double-click on the axis to bring up the Format Axes dialog, and 
then click Custom Ticks. Highlight the tick you want to change. Press the Delete button to 
remove that custom tick, or enter new coordinates and label and press Change. 
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16. Discontinuous and hidden axes 

How to put a gap in an axis 
When plotting scientific data, you’ll often want to create a discontinuous axis. Later in this 
chapter you’ll see three such examples. 

Creating a discontinuous axis with Prism requires three steps. 

1. Create a discontinuous axis. Prism lets you place one or two gaps in each axis. To 
do this, double-click on the axis and choose two (or three) segments from the list 
labeled Gaps and Direction.  

 

2. Set the length and range of each segment. For each segment, set the range and 
length (as a percent of the total length of the axis).  

 

You can also drag the segments to the size you want. Click on the axis segment to 
select it. You'll see selection knobs at each end. Drag the knob just to the left of 
(or below) the gap to change the position of the gap along the axis (make one 
segment larger, and another smaller). Drag the knob to the right of (or above) the 
gap to widen or narrow the gap itself.  

3. Format major and minor ticks for each segment. You can choose the spacing and 
properties for minor and major ticks separately for each axis segment. 
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You will commonly want to make one axis segment short and label it with a single tick. 
You may want to place text at this point (for example, “control”) rather than a number. 
Check the option “Plot only one tick on this segment” and then enter the text and 
coordinate. 

 

Here is the result: 
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Discontinuous axes: Example 1 
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The X values range from 1 to 50. The data were analyzed by linear regression, which 
created a single regression line. The Format Axes dialog has the following settings: 

Setting Value 
Frame and axes Offset X and Y axes 

Gap and direction Two segments 

Left segment range  0 to 15 

Left segment length  67% of total axis 

Right segment range  15 to 50 

Right segment length  33% of total axis 

Because of the change in scale, the linear regression line appears to have two slopes. In 
fact the mathematical slope is identical everywhere, and the line was created by a single 
analysis of all the data. The slope just appears steeper in the right half of the graph 
because the time scale is more compressed. 

Discontinuous axes: Example 2 
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The Format Axes dialog has the following settings:  

 

Setting Value 

Frame and axes Plain Frame 

Gap and direction Two segments 

Left segment range   -9.5 to -8.5 

Left segment length  12% of total axis 

Right segment range  -8.5 to -2.5 

Right segment length  88% of total axis 
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The first number on the X-axis is "0". This was created by substituting a custom tick label 
at X=-9 (one log unit less than the lowest concentration used). To replace "-9" with zero, 
check the option to plot only one tick on the left-hand segment and provide the label (0) 
and X value where the substitution should be made. Since there is only one tick on the 
segment, there is no need to use the Custom Ticks dialog. 

 

Discontinuous axes: Example 3 
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The Format Axes dialog has the following settings:  

Setting Value 
Size and shape Custom shape. Height: 2 inches. Width: 4 

inches. 

Frame and axes Offset X and Y axes 

Gap and direction Two segments 

Left segment range  0 to 24 

Left segment length  50% of total axis 

Right segment range  48 to 72 

Right segment length  50% of total axis 

The line was drawn by linear regression, which automatically skips over the axis gap. 

Hiding axes and showing scale bars 
Prism lets you hide either the X or the Y axis and show scale bars instead. To do this, 
bring up the Format Axes dialog (double-click on an axis) and choose to hide one or both 
axes in the Frame & axes section. You can also choose to Show Scale Bars. The length of 
the bar equals one axis interval, set in the Range and Tick options sections of the Format 
Axes dialog.  
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To: Do this: 
Show or hide the scale bar. If you choose to hide either axis, a new option will 

appear in the Frames and axes section of the Format 
Axes dialog: Show Scale Bar. Check this option to see 
scale bars; uncheck to hide scale bars. 

Delete one scale bar. If you choose to show scale bars in the dialog, Prism 
will create scale bars for both axes. To delete one of 
them, click to select it, and then press DEL to delete 
it. 

Change the color or thickness 
of the scale bar. 

Double-click the scale bar to bring up the Format 
Object dialog. Choose color and thickness in this 
dialog. 

Remove the caps on the end of 
the scale bar. 

By default the scale bars are capped. These are 
actually "arrowhead" styles. To change, double-click 
the scale bar to bring up the Format Object dialog. 
Then change the arrowhead settings. 

Move the scale bar. Drag with the mouse. Or click to select, and then 
nudge by clicking the arrow keys. 

Label the scale bar. The scale bar doesn't include any numbering. To label 
the scale bar, click the text tool ("T" button), click 
near the scale bar, and type.  

Change the length of the scale 
bar. 

You can’t change the length of a scale bar by 
stretching it. Instead, bring up the Format Axes 
dialog, and change the interval in the Range and Tick 
Options frame.  
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17. Logarithmic axes 

The advantage of plotting data on a log scale 
If your data span a wide range of values, it can be easier to visualize the results when you 
make one of the axes logarithmic. To do this, set the scale of the axis to Log10 on the top 
right of the Format Axes dialog. 
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The figure above shows the advantage of displaying data on a log axis. The graph on the 
left has a linear X axis. Going from left to right, every major tick adds 100 nM to the 
concentration. The low concentrations on the left are hard to discern. The same data are 
plotted on the right using a logarithmic X axis. Going from left to right, every major tick 
increases the dose tenfold. Since the doses were prepared by serial dilution, they are 
equally spaced on a logarithmic axis, and you can easily see all the data. 

Axis numbering and ticks on a log axis 
The example graph above (right side) shows log spaced minor ticks. The minor ticks between 
the major ticks at 10 and 100 show the position of 20, 30, 40, 50, 60, 70, 80 and 90. Since the 
minor ticks are not equally spaced on the graph, we call these log spaced minor ticks. Note 
that there are eight ticks, so nine intervals (many people think there ought to be ten).  
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Prism offers three numbering format choices for log axes. The examples below assume 
that data range from 10 to 1000. 

Numbering format: Example: 
Antilog 10, 100, 1000 

Scientific 1x101, 1x102, 1x103 

Power of 10 101, 102, 103 

Log  1, 2, 3 

Making an axis logarithmic does not change the data 
Choosing a log scale changes the way the graph looks, but does not change the data values. 
Linear or nonlinear regression fit an equation to your data. Your choice of axis scaling 
does not affect any calculations. 

The example below shows three graphs of the same data. In each case, the data were fit by 
linear regression.  

• The graph on the left has linear X and Y axes, so the linear regression line appears 
straight. 

• The graph in the middle has a logarithmic X axis. The curve you see is the results 
of linear regression. It is the best fit to the equation Y=intercept + slope*X. The X 
values used by the linear regression are the X values you entered. Graphing this 
linear regression line on a log axis results in a curve.  

• The graph on the right has a logarithmic Y axis. Again, the best-fit linear 
regression line appears curved when plotted on a logarithmic axis. 
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How to transform data to logs and graph the results 
If you need log data for your analysis, you can either enter logs directly or transform your data. 
For example, you should fit a sigmoidal dose-response equation to data expressed with X as 
logarithm of dose. If you enter concentrations, you'll need to convert them to logarithms 
before using nonlinear regression. To do this, click the Analyze button, choose built-in 
analyses, and then select Transforms from the list of data manipulations. Choose X = log(X).  

 

Also check the box at the bottom of the dialog to create a new graph of the results.  
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Prism will create a results table of the transformed data, and a new graph. To perform 
nonlinear regression on the transformed data, click Analyze from either the results table 
or the new graph.  

Note: Distinguish between transforming your data to logarithms (which 
creates a new results table) from choosing a logarithmic axis (which only 
stretches the axis, without altering your data). 

Creating log axes with data entered as logarithms 
If you enter data as logarithms, or graph the results of a log transform, you should graph 
the data with a linear axis. Don't choose a log scale! Your data are already logarithms.  

If your data represent logarithms, you should format the axis numbering to make this 
clear. 

In the example below, the X values represent the logarithm of concentration. The logs 
were entered directly into the X column of the data table. The graph of these data has a 
linear (not log) X axis. The axis was formatted with a numbering format of powers of 10, 
and with nine minor tick intervals with log spacing (see dialog settings below the graph). 
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An alternative way to indicate that the data are logarithms is to choose the antilog 
numbering format (this choice is only available when the interval is 1, the minimum is –9 
or greater, and the maximum is 9 or less).  
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The figure below compares the appearance of decimal (the default), powers of ten, and 
antilog formatting. 

-2 -1 0 1 2

0.01 0.1 1 10 100

10-2 10-1 100 101 102

Decimal

Powers of ten

Antilog
 

Bar graphs with a log Y axis 
Prism can make bar graphs with a logarithmic Y axis, but think twice before deciding to 
make this kind of graph. 

The point of a bar graph is to let people compare heights or areas of the bars. For example, 
the treated bar in the graph below is four times as tall (and has  four times the area) as the 
control bar. This tells you that the treatment increased the response fourfold. This is very 
straightforward since the Y axis is linear.  
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But beware of bar graphs with a logarithmic axis. Since zero can’t be shown on a log axis, 
you need to decide where to begin the axis. A log scale has no logical starting place, so the 
choice is arbitrary. The graphs below show the same data as the graph above, but with the 
Y axis beginning at 0.001, 10 or 100.  
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The relative height of the bars appears to be almost the same in the graph on the left and 
very different on the graph on the right. The relative heights (or areas) of the bars on a log 
scale is not informative. Bar graphs with a logarithmic axis can be misleading.  

Tip: Avoid using a log axis when creating a bar graph.  

If you do decide to make a bar graph with a logarithmic Y axis, Prism makes it easy. 
Double-click on the axis to bring up the Format Axes dialog, and choose a log scale. If you 
need to change the baseline from which the bars are plotted, double-click on any bar to 
bring up the Format Bars dialog. Go to the order and direction tab, and choose a new 
baseline. 

A review of logarithms 
The best way to understand logarithms is through an example. If you take 10 to the third 
power (10 x 10 x 10) the result is 1000. The logarithm is the inverse of that power 
function. The logarithm (base 10) of 1000 is the power of 10 that gives the answer 1000. 
So the logarithm of 1000 is 3. 

You can take 10 to a negative power. For example, taking 10 to the -3 power is the same as 
taking the reciprocal of 103. So 10-3 equals 1/103, or 0.001. The logarithm of 0.001 is the 
power of 10 that equals 0.001, which is -3.  

You can take 10 to a fractional power. Ten to the one-half power equals the square root of 
10, which equals 3.163. So the logarithm of 3.163 is 0.5.  

Ten to the zero power equals 1, so the logarithm of 1.0 is 0.0.  

You can take the logarithm of any positive number. The logarithm of values between zero 
and one are negative; the logarithms of values greater than one are positive. The 
logarithms of zero and all negative numbers are undefined; there is no power of 10 that 
gives a negative number or zero. 

The examples above use base 10 logarithms, because the computations take 10 to some 
power. You can compute logarithms for any power. Mathematicians use natural 
logarithms, using e (2.7183), but natural logarithms are rarely useful when graphing data.  

Biologists sometimes use base 2 logarithms, often without realizing it. The base 2 logarithm 
is the number of doublings it takes to reach a value. So the log2 of 16 is 4 because if you start 
with 1 and double it four times (2, 4, 8, and 16) the result is 16. Immunologists often serially 
dilute antibodies by factors of 2, so often graph data on a log2 scale.  
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18. Changing bars and symbols 

Changing one data set vs. changing all data sets 
The dialogs to format symbols and lines and bars let you make a change to one data set or 
all data sets.   

To change the settings for one data set, select a data set from the list, and choose the 
symbols, lines, and error bars for that data set. Then select another data set and choose 
settings for that data set. Click OK to redraw the graph with all the changes. 

To change all data sets on the graph (for example to make all symbols larger), drop the list 
of data set names and choose --Change ALL data sets--. Or click the “All” button just to 
the right. Changes you make after that will then apply to all data sets.  

 

Shortcut: Instead of choosing Change ALL data sets from the list of data 
sets, hold the Ctrl key. As long as you hold the Ctrl key, any changes you 
make will apply to every data set on the graph. 

Format symbols and lines  
Change the appearance of symbols, connecting lines and error bars on XY graphs using 
the Format Symbols and Lines dialog. To bring up this dialog, double-click on any data 
point or click the Change button and select Symbols & Lines. 
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Settings on the Symbols and Lines dialog 

Setting: Meaning: 

Symbols 

 

Choose symbol type, size, and color. If you pick an open symbol, also 
select a thickness. Check the clear option if you want point-to-point 
lines and overlapping points to show through the open symbol. 

 Error bars Select SD, SEM, 95% CI, or range, and how it will appear (thickness, 
with or without caps). 

Connecting 
line/curve 

Choose the line's color, style (straight vs. staircase), thickness, and 
pattern (solid, dotted, dashed, etc.).  

Don't confuse the connecting line – which always goes from point to 
point – with a best-fit curve or line created by regression. If you have 
fit a curve through the data, Prism sees the curve as a separate data 
set. Select the data set for the values, and choose symbols but no con-
necting line. Then choose the data set for the curve, and choose a 
connecting line (curve) with no symbols. 

Area fill Fill below (or above) the point-to-point line that connects your points 
with a fill. Specify fill color and pattern, and background color. You 
may need to adjust the order of the data sets to get the effect you 
want. 

Plot on which Y-
axis? 

Specify which axis to use for each data set. If you choose to plot on the 
right Y-axis, Prism will create that axis if it doesn’t already exist. 

Legend 

 

Select Show legend to create a legend for this data set. Select “Use 
column titles” to link the legend to the column title entered on the 
data table. Uncheck this box if you don’t want the legend to change 
when you edit the column title.  

Symbols for survival curves, mass spectra, and histograms 
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On the shape drop down, the fifth from the last choice is the blip symbol, often used on 
survival graphs. The blip extends in an upward direction only. 

The last four choices are histogram bars. The bar will start at the X-axis and go up (or 
down) to the Y position of the point. The thickness of the bar is set by the symbol size. 
This is useful when you want to create a bar graph where each bar’s position is determined 
by its X value. It is also useful when you want to combine points and bars on one graph as 
shown below (details on how to create this graph are in our step-by-step example book). 
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Tip: If you pick the smallest size for the histogram bars, the bars will 
actually be spikes suitable for graphing mass spectra.  

Plotting order 
Use the Order tab of the Format Symbols and lines dialog to specify the front-to-back 
order of the data sets. When data points overlap (or are superimposed) this order 
determines which will show on top. The two graphs in this example are identical except 
that the plotting order was reversed. 
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Nudging data sets 
Use the bottom of the Order tab of the Format Symbols and Lines dialog to nudge a data 
set. You ask Prism to add a specified value to each X and Y coordinate before graphing. 
Use this feature cautiously, as it means that the position of the symbol on the graph will 
not match the actual X and Y values of the data point.  

Note:  The values you enter are the actual increments of X and Y. Each 
data set is incremented as much as you specify. The nudging is not 
cumulative.   

Nudging can be helpful to differentiate datasets that otherwise overlap a lot. For example, 
the data in the following graph overlap so much it is impossible to tell which tracing is 
which. 
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The graph below is an alternative way to plot the same data. The second data set is nudged 
by 25 units in the Y direction (and not at all in the X direction). The third data set is 
nudged 50 units in the Y direction (with zero in the X direction). Now you can see the 
individual tracings. All three tracings still have about the same baseline Y coordinates. But 
nudging the data in the Y direction separated them. Because the Y values were nudged, it 
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would be misleading to plot the data on a full Y axis as in the graph above. So instead, the 
Y axis is hidden (General tab of the Format Axes dialog) and replaced with a scale bar. 
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Nudging can also help you create a waterfall graph. All the data sets in the following graph 
cover the same range of wavelengths, and all have a baseline of zero optical density. Each 
data set was nudged in both X and Y directions, each data set nudged a bit more than the 
previous data set. This creates a pseudo 3D look that is sometimes called a “waterfall”. 
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Format survival graphs 
Formatting survival graphs is very similar to formatting XY graphs. The only difference is 
that you choose what you want to plot (survival vs. death, fraction vs. percentage) on top 
of the dialog. 

Format bars 
To bring up the Format Bars dialog, double-click on any bar or press the Change button 
and select “Format Bars”. 
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Bar appearance 
Choose the appearance of one data set at a time. Select a data set from the list, and choose 
the fill pattern and color, and border thickness and color, for that data set. Then select 
another data set and choose again. Click OK to redraw the graph with all the changes. 

 

Setting: Meaning: 
Appearance 

 

Choose fill color, a pattern (optional) and color, and the border 
thickness and color. If you want a solid bar, set the pattern to 
“none”. 

Error bars 

 

To plot an error bar with each data point, choose the kind of error 
bar you want from the list (mean & SD, mean & SEM, mean & 95% 
CI, mean & range, median & range). Also choose the style, color, 
and thickness. 

Which Y-axis? If you choose to plot a data set on the right Y axis, Prism will create 
that axis if it doesn’t already exist. 

Legend 

 

Select Show legend to create a legend for this data set. The legend 
will be the bar used for this data set followed by text that you can 
edit. Select Use column titles to link the legend to the column title 
entered on the data table. If you edit the legend on the graph, 
Prism will automatically uncheck the option box. 
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Order and direction 
Setting: Meaning: 

Direction Choose if you want the bars to be vertical or horizontal. 

Baseline Choose the Y coordinate where bars begin, usually the bottom of the 
graph. 

Space between 
bars 

Choose the gap between adjacent bars and the additional gap between 
groups of bars. Enter the gap as percent of bar width. Prism 
determines the width of each bar automatically, based on the number 
of bars on the page and the size of the graph. 

Order Choose the order (left to right) of the data sets 

Relation with 
preceding data set 

 

When you choose the type of graph (through the New button or 
Welcome dialog), you choose whether you want the data sets to be 
interleaved, stacked, or separate. If you want to change this for the 
entire graph, cancel from the Format Bars dialog, click Change then 
choose Graph Type and select the appropriate kind of graph.  

You can make hybrid graphs types from within the order tab of the 
Format Bars dialog. For each data set, choose whether it should be 
interleaved with, stacked on top of, or placed apart from the preceding 
data set (starting a new group of bars, hence the name “grouped”). 

Labels below the X axis 
Prism labels the bars with the row titles from the data table. You may not edit the bar 
titles directly, but if you edit the row titles, the graph will update. Use the Format Axes 
dialog, not the Format Bars dialog, to turn off the labels or to change to vertical or angled 
labels.  

If your data table has only one row, Prism will place the column titles, rather than row 
titles, under each bar. 

Format columns 
Graphs with one grouping variable (box-and-whiskers, column scatter, column bar, 
before-after, and column mean) are also called Column graphs. To change the appearance 
of any column graph (or to change the order of the data sets), bring up the Columns dialog 
by double-clicking on the data area of any column (bar), or press the Change button and 
select Column Appearance. 

Choose a data set from the drop down, and make changes for that data set. Then pick 
another data set, and make changes for it. Or choose “Change ALL data sets”, and changes 
you make will apply to the entire graph. You must first choose to change all data sets, and 
then make the changes.  
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Setting: Meaning: 
Appearance 

 

For each column, choose column scatter, before-after, box & 
whiskers, bar or symbol. Each data set (column) can have a 
different appearance. If you want to change the appearance of all 
the data sets, cancel from the Format Columns dialog, click Change 
and choose Graph Type. Then choose a new kind of graph. 

Bars and boxes Choices vary depending on which column appearance you chose. 
For dot plots, choose whether to plot a line at mean or median. For 
bar and symbol plots, choose which kind of error bar. 

Symbols or bars Choose appearance of symbols or bars. Color, size, etc. 

Lines Choose thickness and color of lines (border of box and whisker 
plots, connecting lines in before-after plots, lines at mean or median 
of dot plots). 

Error bars 

 

For column bar graphs, check the option box to create error bars, 
and then select how they are to be calculated (SD, SEM, 95% CI, or 
range). The error bars are calculated from all the values in each 
column. You cannot add error bars to column scatter or box & 
whiskers graphs. 

Which Y-axis? 

 

If your graph contains both left and right Y-axes, specify which axis 
to use for each data set. Initially Prism plots all data on the left Y-
axis. See "Graphs with two Y-axes" on page 88. 

Legend 

 

Select Show legend to create a legend for this data set. The legend 
will be the symbol used for this data set followed by text that you 
can edit. 

Legends are rarely helpful with column graphs, as the column titles 
appear underneath each column.  
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Order and direction 

 

Setting: Meaning: 

Direction Choose if you want the graph to be vertical or horizontal. 

Baseline Choose the Y coordinate where bars begin, usually the bottom of the 
graph. Only applies to column bar graphs. 

Dimensions Choose the gap between adjacent columns. 

Order Choose the order (left to right) of the data sets 

Spacing 

 

Change the spacing between the selected data set and the preceding one. 

Labels below the X axis 
Prism labels the bars with the row titles from the data table. You may not edit the bar 
titles directly, but if you edit the row titles the graph will update. Use the Format Axes 
dialog, not the Format Columns dialog, to turn off the labels or to change to vertical or 
angled labels.  

Placing two sets of before-after data on one graph 
If you only enter two columns of data, before-after graphs are straightforward. If you 
enter three or more columns of data, Prism will by default connect all the data sets. In 
some cases, this is what you want. Perhaps you are ploting before, during and after for 
each subject, and want the points to be connected.  
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In other cases, you want to connect some, but not all, of the data sets. Here is an example. 
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This graph was created as a before-after graph, and initially all four data sets were 
connected. This doesn’t make sense in this case, as the first two columns are one group 
(maile) and the next two columns another (female). To make this graph, double-click on 
the second data set (male, after) to bring up Format Columns. Change that one data set 
from Before-after to Aligned dot plot (with no line or error bar).  

 

For the fourth data set (female, after) it doesn’t matter whether you choose before-after or 
aligned dot plot. If there were a fifth data set on the graph, choosing before-after would 
connect the fourth to the fifth, and choosing aligned dot plot would not connect them. But 
since there is no fifth data set, the two choice appear identical.  

Legends 
Prism creates an automatic legend on all XY and bar graphs. When creating the legend, 
Prism matches the symbol shape, bar type, and color used in the graph. You can’t change 
the shape, size, or color of the symbol on the legend. If you change its appearance on the 
graph from the Symbols dialog, the legend will update automatically. 

Prism does not create legends for column graphs automatically (because the columns are 
labeled along the X axis). You can turn on legends for each data set within the Format 
Columns dialog. 

The text in the legend comes from the data set (column) title in the data table. If you 
haven't entered a column title, Prism simply inserts “Legend”.  
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To: Do this: 
Select a legend. Click on it. You'll see four knobs surrounding the legend. 

Select several 
legends. 

Hold Shift and click on each legend.  

Group several 
legends. 

Select several legends. Then pull down the Arrange menu and 
choose Group. Now the group of legends will act as one object. 

Move a legend or 
group of legends. 

Select one or more legends, then drag. 

Edit the text. Double-click on the text and edit it. The legend text will no 
longer be linked to the data set (column) title. 

Change the font or 
size of text. 

Select the entire legend, or a group of legends. Select Text from 
the Change menu. 

Change the size of 
the symbol in the 
legend. 

You can't change the size of symbols in legends. Prism uses the 
same symbol size you selected in the Format Symbols and 
Lines dialog.  

Align legends. Select the legends. Pull down the Arrange menu and select 
Align objects. 

Draw a border 
around a group of 
legends. 

Use the drawing tools to draw a box (or a rounded box). 

Delete legends. Select one or more legends. Then press DEL.  

Bring back a 
deleted legend. 

Double-click on a symbol (or bar) to bring up the Format 
Symbols (or Bars or Columns) dialog. Check the option box 
“Show legend”. 

Use data set title 
as legend. 

Double-click on a symbol (or bar) to bring up the Symbols 
dialog (or Bars or Columns dialog). Check the option box “Use 
column title”. 

Create a master 
legend on a page 
layout. 

See "Master legends" on page 115. 
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19. Page layouts 

An overview of page layouts 
Use the Layout section to arrange two or more graphs on a page, along with data or results 
tables, drawings, text, and imported images. 

Prism provides preformatted layouts for common graph arrangements that you can 
customize. You are not limited to these arrangements. You can add, delete, and resize 
graphs however you want. There is no limit to the number of graphs (or objects) you can 
place on a page layout. 

The page layout section is for arranging graphs, not for editing graphs. To change axes, 
symbols, etc., go back to the Graphs section. 

Changing the number or arrangement of graphs 

Format layout dialog 
To choose the orientation of the page and the initial number and arrangement of graphs, 
press the Change button and choose Arrangement of graphs. 

 

First choose the page orientation of this layout sheet. Prism ignores the page orientation 
setting in the Printer Setup dialog when printing layouts (and graphs). Choose the 
orientation of each individual layout in the Format Layout dialog. Also choose the 
background color of the page. 

To create an initial arrangement of placeholders, click one of the eight buttons or choose 
the number of rows and columns of graphs you need. Prism arranges graph placeholders 
according to the pattern you selected. 

Adding and removing graphs manually 
You aren't limited to the regular arrangement of page layouts that you chose on the 
Format Layout dialog. You can add and remove graphs, and you can rearrange them. You 
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can place one placeholder inside of another to create graph insets. There is no limit to the 
number of graphs (or objects) you can place on a page layout. 

To: Do this:  
Add a placeholder to the page.  Click on the graph tool (just to the right of 

the arc tool). Then point to the location 
where you want a corner of the graph to ap-
pear and drag to the opposite corner.  

 

Create several placeholders that 
are the same size. 

Select one or more placeholders, and then 
use the Duplicate object command on the 
Arrange menu.  

 

Delete a graph or placeholder. Click to select it. Then press DEL.  

Move a placeholder. Click to select it. Then drag.   

Resize a placeholder. Click on a corner and stretch.  

Background color 
When you first assign a graph to a layout, the layout will be assigned the background color 
of the graph. To change the background color, drop the Change menu and choose 
Background Color. You can also choose the background color on the Format Layout dialog. 

When you copy and paste a layout into another program, this color is ignored, so you’ll 
need to choose the background color again in the other program. 

Assigning graphs to placeholders 

Assigning a graph from this project 
Double-click on a placeholder to replace it with a graph. You'll see this dialog: 

  

Choose a graph to assign to the placeholder. Check the preview to be sure you’ve chosen 
the correct graph (you may not see a preview if the file was saved in compact format and 
you haven't viewed or edited the graph since opening the file). Press OK to place the graph 
on the layout. Press Go To if you need to edit the graph. 

In most cases, you’ll reposition the graph and change its size directly on the layout page. If 
the exact position of the graph is critical, you can enter its exact position and size. This 
could be useful if you want match the position of a graph on another layout or if you plan 
to print on a nonblank page. Click Show Size & Position to expand the dialog. Then enter 
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the desired distance from the left and top edges of the page (in inches or cm depending on 
your control panel). Choose to keep the graph exactly the same size it is on the graph page 
or to scale it to fill the placeholder (more common). If you scale the graph, enter the 
height and width of the placeholder. 

 

Two shortcuts to place a graph on a layout 
Instead of double-clicking on the placeholder, you can use these shortcuts which work just 
as well: 

• Drag the graph title from the Navigator and drop onto a placeholder.  

• Copy a graph to the clipboard, then paste onto a layout. 

Combining graphs from two or more projects 
Prism 4 lets you combine graphs from several projects onto a single layout. This gives you the 
flexibility to organize your projects however you like. It also makes it easy to make posters.  

When you assign a graph to a placeholder, you can choose a graph from any project. If you 
choose a graph from a project that is not open, Prism will open it. You can also copy a 
graph in one project and paste in another. 

Prism then gives you three choices: 

 

Most often, you’ll probably choose to link to the original Prism file. In this case, if you edit 
the original file, the changes will be reflected in your layout. Prism can maintain the link 
only if the relative location of the two files doesn’t change.  

You can also choose to merge the graph, along with its data tables and analyses, into the 
project you are working on now. The advantage of this approach is that everything will be 
in one project. The disadvantage (which some consider to be an advantage) is that the 
data now exist in two files.  
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A final choice is to paste a picture with no link to the original data. You won’t be able edit 
these graphs without going back to the original project. You might prefer this option if you 
are sure the graph is 100% done, and you don’t want to allow any possibility of it being 
changed. 

Master legends 
If you place several graphs on a layout, you can create a master legend that applies to all 
the graphs as shown below. 
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It took four graphs to make this figure. The first three graphs show data, and the fourth 
(not shown) was used only to create the master legend. Follow these steps: 

1. Create the graphs, omitting legends. The easiest way to create several similar 
graphs is to duplicate the first graph with its data and analyses (click New and 
then Duplicate Sheet with Family).  

2. Duplicate one of the graphs to create another graph that won't be shown in the 
layout, but will be used to create a legend. To create a legend on this graph, 
double-click on a symbol to bring up the Format Symbols and Lines dialog. 
Choose to change all data sets, and then check Show in the Legend frame.  

3. Create a layout and assign the graphs (three in this example).  

4. Select and copy the legends from the extra graph and paste onto the layout. That 
is a simple copy and paste operation and does not use a placeholder. 

The master legend is linked to the graph from which it was copied. If you change the 
symbols in that graph, Prism will update the master legend. 

Master legends on the layout have exactly the same size as the legend on the graph from 
which you copied the legends. When you place graphs on layouts, you can shrink or 
expand it to fill a placeholder. You can't do this with master legends. The only way to 
change the size of the symbol and lettering in the master legend is to change the font size 
and symbol size on the graph used to create the master legend. This is done in the graphs 
section, not the page layout section. 

Arranging graphs 

Equalize graph size  
When copying a graph to the layout, Prism reduces (or increases) the graph object so it 
fits inside the placeholder. The scale factor depends on the relative sizes and shapes of the 
placeholder and graph object. Because the graph object includes more than just the graph 
(also titles, legends, drawing, tables, and pictures), graphs that are the same size in the 
Graphs section can have different sizes on the layout.  



 

116 GraphPad Prism User’s Guide 

To equalize graph sizes, follow these steps: Hold Shift and click on each graph you want to 
balance (skip this step if you want to balance all graphs on the layout). Drop the Arrange 
menu and select Equalize Graph Size. Choose to reduce the size of graphs that are too 
small, or to increase the size of graphs that are too large. 

 

Note: The term “scaling” refers to the change in size when the graph is put 
on a page layout. It has nothing to do with the scale (range) of the axes. 

After balancing, two graphs that are the same size in the Graphs section will be the same 
size in the layout.  

Aligning axes 
To align the axes of two or more graphs, first hold Shift, and click on each graph you wish 
to select. From the Arrange menu, choose to align the X or Y axis.  

Note the distinction between aligning axes and aligning objects. The Align objects command 
will align the boundaries of the graph objects, but you will more often want to align axes. 

Center objects on page 
Before you print, center all objects on the page. Pull down the Arrange menu and select 
Center on Page. Prism will move all the objects on the page to equalize the margins. 

Layouts can contain more than graphs 
In addition to graphs, layouts can contain: 

• Text. See “Adding text to a graph or layout” on page 122. 

• Drawings. See "Drawing lines, arrows, and shapes" on page 125. 

• Graphics from other programs such as equations, chemical structures, and clipart. 
See “Including pictures and objects” on page 126. 

• Data and results tables from Prism. See "Embedding results " on page 49. 
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20. Colors 

Choosing colors 
As you work on different parts of your graph, you can change the various colors. For 
example, you can change symbol colors in the Format Symbols and Lines dialog and 
change axis colors in the Format Axes dialog. Whenever you choose a color in Prism, you 
can choose from a palette of 84 colors.   

When choosing a color of some objects, Prism offers the choice of “clear”. This makes the 
object transparent, so the color of any other object behind it, including the page 
background color, shows through. 

 

If you prefer a color that is not on the GraphPad palette, click More Colors to bring up the 
Choose Color dialog which lets you choose, and define, custom colors.  
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Choosing custom colors (Windows) 

 

 

You can choose a custom color in three ways: 

• Choose from the color chart. You must do two things. First pick the color by 
clicking on the big rectangle that shows lots of colors. Then choose intensity from 
the tall narrow box on the right of the dialog. That second step is essential. If the 
intensity is set to its lowest value (often the default), all colors will appear white no 
matter what color you think you are picking. 

• Choose one of the custom colors shown in the bottom left of the dialog. See below 
for defining custom colors. 

• Enter three numbers that define the color. Enter the Red, Green, and Blue 
components of the color, which you may know from another program. Or enter 
the hue, saturation, and intensity. Every color can be defined using either scheme 
– enter whatever values you learned from another program. 

If you want to be able to use the color you selected in other parts of the graph, add it to the 
list of sixteen custom colors shown at the bottom left of the dialog. This requires three 
steps. First select the color, then click on one of the sixteen custom color slots, and then 
click Add to Custom Colors. 

The set of 16 custom colors are saved with your Prism project. Click “Use these custom 
colors in new projects” to make your custom set of colors available in future projects. 

Choosing custom colors (Macintosh) 
Prism Mac offers several ways to choose custom colors and the choices are self-
explanatory. With OS X (release 10.2 or later) you can save any color in a custom palette. 
To do this, just drag a color from the color preview area in the Colors dialog down to the 
custom palette at the bottom. This set of custom colors is stored in a system preferences 
file, so you can easily choose those colors again from Prism (or almost any program) on 
your computer. Since the palette of custom colors is not saved with the Prism file, you 
won’t be able to access the palette if you move the Prism project to a different computer. 
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Background colors  
You can choose a background color for each graph and layout. To do so, click the Change 
button and choose Background Color. 

• When you print graphs, Prism will print the background color.  

• When you copy and paste the graph to another program, Prism does not copy the 
background color. You'll need to set the background color in the other program. 
This lets you pick gradient backgrounds in the other program. 

• When you send a graph or layout to PowerPoint using the PowerPoint button (or 
command on the File menu), Prism copies and pastes the graph or layout without 
the background color but also creates that same background color within 
PowerPoint. You can change the background color within PowerPoint by dropping 
the Format menu and choosing Background. (Windows only.) 

• When you export a graph or layout, you choose on the File Export dialog (or in the 
script command) whether to include the page background. 

• When you export a graph or layout using a script, the background is included 
unless you add the word Clear at the end of the command. 

Prism only offers solid background colors. Copy and paste to PowerPoint, or a similar 
presentation graphics program, if you want a gradient background. 

If you choose open symbols, you can check an option on the Format Symbols and Lines 
dialog to make the symbols clear. The background color will show through clear symbols. 
Likewise, if you choose a clear fill for bar graphs, the background color will show through. 

When you first assign a graph to a layout, that layout will get the background color of the 
graph. This is just a starting point. You can change the background color of a layout by 
clicking Change then choosing Background Color. 

If your graph has a different background color than the layout, you’ll see that background 
under that graph on the layout. If you don’t want a graph background color to show, set 
the graph background color to clear. 

Choosing a color scheme 
Color Schemes are a great way to apply colors to all graphs in your lab consistently. To 
pick a color scheme, drop the Change menu (or press the Change button) and choose 
Color Scheme, and then choose one of the named schemes provided on the menu. 
Schemes you defined are listed first (none in the figure below) followed by preset color 
schemes provided by GraphPad (preceded by asterisks). 
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Creating your own color schemes 
You can easily create your own color schemes to get just the look you want. 

 

Follow these steps to define a color scheme. 

1. Drop the Change menu and choose Define Color Scheme. 

2. As a starting point, choose a color scheme from the drop-down list. Or start 
from the current colors. 

3. Change individual colors using the choices on the right of the dialog. 

4. Click OK to see the changes on your graph. 
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5. Click Change and then Define Color Scheme again. Make further changes as 
needed. Note that a color scheme contains colors for up to 52 data sets.  

6. Once you have created a color scheme you like, save it to use on future graphs. 
Enter a name of the scheme in the lower right of the Color Scheme dialog, and 
then click the Save button on that dialog. 

Note: To change a color scheme, just make your changes and then save 
again with the same name. 

Making a color and black-and-white version of the same graph 
You may wish to have one copy of a graph be black and white (for publications) and 
another copy color (for presentation). To do this, duplicate the graph by pulling down the 
Insert menu and choosing Duplicate Current Sheet. Then change the colors of one copy 
and leave the other copy black and white.  

Both graphs will remain linked to data and results and will be updated if you edit the data. 
The other properties of the graphs (axes, symbols, titles, etc.) are independent. Changing 
one graph will not affect the other. 

Printing color graphs on black-and-white printers 
Color graph often print fine on a black-and-white printer. Various colors are shown as 
various shades of gray. If the printout is not clear, you can tell Prism to print in pure black 
and white. Pull down the Edit menu (Prism menu in Mac OS X),  and choose 
Preferences…. Select the File & Print tab. Check the option Print no grays and no color. 
Now the printed page will be pure black and white, with no shades of gray. 
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21. Adding text, drawings, and pictures  

Adding text to a graph or layout 

Entering text 
To enter new text anywhere on a graph or layout, click one of the text tool buttons (the 
one on the right makes a text box with a border). 

 

and then click on the graph or layout at the spot where you want to enter text and type. If 
you want to enter several lines, press Enter between lines. When you are done entering 
text, click on the pointer button 

 

or click elsewhere on the sheet. 

You can also enter a paragraph with automatic word wrapping. To do this, enter the first 
line or two using the instructions in the previous paragraph. Then click on the pointer 
button to select the entire text object. You'll see knobs on the corners. Drag the knobs to 
make the text object the correct width. Don't worry about the height, as it will grow 
automatically as you enter text. Now, double-click inside the text object to bring back the 
insertion point and type your text. Don't push Enter at the end of each line, as Prism will 
automatically wrap the text as you type. 

Prism provides an easy way to enter Greek letters, international characters, math symbols 
or Wingdings. First be sure you have a text insertion point. Then press the Greek button 

 

and choose a character from the menus provided. 

Selecting text 
While entering text, you can select characters by dragging the mouse. The selected 
region is shown inverted. You can also select an entire text object. If you are entering 
text, click outside the text on the background of the graph or layout. Then click once on 
the border of the text to select the entire text object. You can tell that the text object is 
selected because it is surrounded by six knobs.  
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Changing font and size 
To make text bold, italicized, underlined, subscripted, or superscripted, select a portion of 
text (or an entire text object), and click a button. 

 

Shortcut: Hold Ctrl and press + or - for superscript or subscript. Use the 
+ and – keys in the keypad, not on top of the keyboard. Hold Ctrl and 
press U, I, or B for underline, italics, or bold. 

To make selected text a little bit larger or smaller, click these buttons: 

  

To change the font of selected text (or an entire text object), pull down the Change menu 
and then choose Selected Text. The Format Text dialog lets you change color and font. 
You can also change the size of selected text by entering a point size. 

Shortcut: Double-click on the border of the text object to bring up the 
Format Text dialog. 

Rotating text 
You can rotate text objects to any angle you want. Double-click on the object boundary to 
bring up the Format Text dialog. Then set a standard rotation (horizontal, vertical up, 
vertical down) or choose angled and enter the angle in degrees. 

You can't change the rotation of an axis title using Change Selected Text. However, you 
can change the rotation of Y-axis titles in the Format Axes dialog.  

Borders and fills for text objects 
To add or change a border or background, click the Border and Fill button on the Format 
Text dialog. You’ll only see this button when you edit independent text objects, not when 
you edit the graph or axis titles. 
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Moving text 
If you select an entire text object, you can move the object by dragging. You can also 
stretch the object to change its shape. This will change how text wraps, but will not change 
the point size of the lettering. 

You can only move axis and graph titles closer to, or further from, the graph. They always 
remain centered.  To move a title closer to or further from the graph, point the mouse 
near the title until the cursor changes to a two-headed arrow. Then drag the title.  

You can also move axis numbering (or labeling for bar or category graphs) closer to, or 
further from, the axis. Click on the numbering to select. Then use the arrow keys to nudge 
its position. Or set the distance between numbers and axis within the Format Axis dialog. 

Different character sets for different languages 
Prism lets you enter text in any language that goes from left to right, so long as you have 
configured your system to handle other character sets. The details vary depending on 
which version of Windows or the Mac OS you use. The following hints should help you get 
started. Note that for most systems, you have to make two different settings, one for 
character sets you want to display and elsewhere for character sets you want to enter. You 
may also have to restart Windows for the changes to take effect.  



 

21.  Adding text, drawings, and pictures 125 

OS Instructions 
Windows XP You must be logged in as an administrator to install additional 

languages. Go to the Control panel and open Regional and Language 
Options. On the Advanced tab, under Code page conversion tables, 
select the code pages for the languages you wish Prism to display. 
Then go to the Languages tab of that same control panel, and click 
the Details button and add the languages you wish to be able to 
enter.  

Windows 2000 You must be logged in as an administrator to install additional 
languages. Go to the Control panel and open Regional Options. On 
the General tab, under Language Settings, select the languages you 
wish Prism to display. Then go to the Input Locales tab of that same 
control panel, and add the languages you wish to be able to enter. 

Windows NT Go to the Regional Settings control panel. Then go to the Input 
locale tab and choose the languages you wish to support. 

Windows 98 or 
ME 

Go to the Add/Remove Programs control panel and then to the 
Windows Setup tab. Click Multilanguage Support, and then click 
Details and choose the languages you wish to support. Then open 
the Keyboard Control Panel, go to the Language tab, and choose the 
languages you need. 

Mac OS 9 You’ll first need to install the necessary components. Launch the 
Mac OS Installer, located on your system software CD. On the Select 
Destination window, select the system drive, and click the Select 
button. Click the Add/Remove button, select Language Kits, and 
then choose "Customized Installation" in the dropdown. In the 
Language Kits component, select the languages you need, and click 
OK. Restart the computer, and then go to the Keyboard control 
panel and choose the language you wish to use. 

Mac OS X Open System Preferences and click International. Go to the 
Keyboard Menu tab (OS 10.1) or Input Menu tab (OS 10.2) and 
choose the languages you wish to use. If the language you want is 
not listed, install it from the Mac OSX installation CDs by double-
clicking "AdditionalFonts.pkg" (or "AdditionalAsianFonts.pkg"). 

 

After the needed languages are installed, in order to type in that languages you need to 
switch to appropriate language (keyboard layout) in the Keyboard menu on Mac (located 
on the main menu bar) and language selector on Windows (located in the right part of the 
Task bar). 

To change the language used, select some text, click Change and choose Selected Text. 
Then choose a font (and also, in Windows, a language or script) in the Format Text dialog.  

Drawing lines, arrows, and shapes 
To draw a line, arrow, rectangle, oval, or arc, click on 
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Then position the mouse pointer (now a pencil) at one end of the line or arrow (or one 
corner of the box or oval). Hold down the primary mouse button and drag to the other end 
(or to the diagonally opposite corner). Hold the control key if you want to draw a perfect 
circle or square. 

After drawing an object, the cursor reverts to the pointer button.    

Click on a drawing tool again to draw another object.  

Tip: If you want to draw several objects, hold Shift while selecting the 
drawing tool. Then you'll be able to use it repeatedly without selecting it 
again. Click the pointer button (to the left of the drawing tools) when done. 

Select any object (or several objects) and double-click to bring up the Format Object dialog.  

 

Choose the thickness, color, and style of lines or borders; the fill color and shading of 
shapes; and arrowhead direction, size, and style. Note that some arrowhead styles let you 
put caps on the end of lines, as shown below. 

 

Including pictures and objects  
Prism lets you annotate your graphs with images, equations, flowcharts, diagrams, 
chemical structures, or tables created by other programs. There are four ways to add 
objects or pictures created by another program onto a Prism graph or layout.  

Paste a picture or object from the clipboard 
Copy a picture in the other program, then paste onto a Prism graph or layout.  

Prism Windows is an OLE container (client). It can link or embed objects created by any 
program that is an OLE server. It can also paste pictures without using OLE. 

When you paste an object created by a program that is an OLE server, Prism will embed 
the object. This means that Prism contains a separate copy of the object. In some cases, 
you may prefer to paste link to the original file. To do that, copy the object and then 
choose Paste Special from the Edit menu. Then choose Paste Link. To learn more about 
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the pros and cons of linking and embedding, see "The difference between pasting a 
picture, pasting a link, and paste embedding" on page 134. 

Tip: Select Paste or Paste Special from the right-click shortcut menu to 
paste the picture at the location of the mouse. 

Toolbar buttons that embed objects (Windows only) 
Prism Windows places up to seven buttons that insert objects on the tool bar. These 
buttons launch SmartDraw and small programs that come with Microsoft Office. You’ll 
only see buttons for programs you have installed on your system. 

Click a button to insert an object created by one of these programs onto a graph or layout. 

Button: Program: Comments: 

 

Microsoft Paint  Create freehand images (paintings). 

 
SmartDraw  Create forms, time lines, flowcharts, and diagrams. Get 

a free demo from www.smartdraw.com. 

 Microsoft 
WordArt  

Enter angled, curved, or shadowed text.  

     

  
Microsoft Clip 
Gallery 

Choose a clipart drawing or bitmap image from the 
collection that comes with Microsoft Office. Also note 
the links on the dialog to obtain additional clipart 
online.  

 Microsoft 
Equation Editor  

In addition to creating equations, this program is 
helpful for writing special characters and simple 
chemical reactions. If you have installed the MathType 
equation editor, it will launch instead. 

A B    QK → ≈i
2   X     N  

 
Microsoft Excel  Insert a formatted table. Prism won't be able to analyze 

or graph any values on this table.  

 Microsoft Word Insert a figure legend, which may include bullets, 
formatted text, tables, etc. 

 

After you click the button, the application will run in a window on top of Prism. After 
creating the object, close that application to return to Prism. In some cases, the 
application appears as a dialog, which you close by clicking OK. In other cases, it appears 
as an application that you quit by dropping the File menu and choose "Exit and Return". 

Note: Be sure to use the File menu of the other program, not the File 
menu of Prism, which will also be visible. 
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Insert Object command (Windows only) 
To insert a new object, created by a program that is not on Prism's toolbar, drop the Insert 
menu and choose Object.  

 

Choose Create New and select the program you wish to use. The list shows all programs 
on your computer that can create objects. Create the object in the selected program, which 
will run in a small window on top of Prism. After creating the object, close that application 
to return to Prism. In some cases, the application appears as a dialog, which you close by 
clicking OK. In other cases, it appears as an application that you quit by dropping the File 
menu and choosing "Exit and Return". 

Tip: Include a pie chart (which Prism cannot create) by inserting a 
Microsoft Graph object (Microsoft Graph comes with Office). A 
Microsoft Graph object contains a graph along with its own data table. 
There is no link between Prism data tables and graphs made this way. 

Import a graphics file 
Use the File Import command to import a picture. Prism Windows can import bmp, jpg, 
pcx, png, tif or wmf files. Prism Mac can import  bmp, jpg, pict, png, or tif files. Transfer 
pictures as Windows Metafiles (wmf) or Mac pict files whenever possible. The other 
formats are bitmaps, and you should avoid changing their image size in Prism.  

Placing a border around an image or object 
Click once to select the image or object in Prism. Then drop the Change menu and choose 
Selected Object.  

Selecting and moving objects 
When you work in the Graphs section of your project, the graph itself as well as text, 
legends, drawings, and imported images are all referred to as “objects”. When you are 
working in the Layout section of your project, each graph with all of its objects is grouped 
into a single object. Images imported onto a page layout are also objects. Images imported 
onto a graph are objects in the graph section, but are part of the graph object in the page 
layout section.  
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To: Do this: 
Select one object. Point to the object and click the left mouse button. To select 

a rectangle or oval, click on its edge. Prism displays knobs 
on the selected object.  

Select several objects. Hold down the Shift key while selecting the objects one at a 
time.  Or… drag an imaginary rectangle around all the 
objects. You’ve selected all objects entirely contained within 
the rectangle. 

Move an object with the 
mouse. 

Point to an edge. Press the left mouse button and drag. 

Move an object vertically 
only. 

Hold the Shift key while dragging. (Remember this because 
the Shift key is marked with a vertical arrow.) 

Move an object 
horizontally only. 

Hold the Ctrl key while dragging. 

Nudge an object a tiny 
distance. 

Select one or more objects. Press the up, down, right or left 
arrow keys. Each press of an arrow key moves the object(s) 
one pixel. 

Position an object by 
entering distances. 

Select Position Object from the Arrange menu. Enter the 
distance of the upper left corner from the top and left edge 
of the page. 

Lock an object so you 
can’t accidentally move 
it. 

Select Lock Object from the Arrange menu. When you 
select a locked object, the knobs will be gray rather than 
black, and you will not be able to move the object or change 
its size. To unlock the object, select it, then select Lock 
Object from the Arrange menu again. 

Group two or more 
objects so they move 
together. 

Select Group from the Arrange menu. The set of objects 
now acts as a single object. If you want to work with the 
individual objects again, drop the Arrange menu and 
choose Ungroup. 

Force objects to snap to 
grid.  

Select Use Snaps to grid from the Arrange menu. This 
makes it easier to align objects, but harder to fine-tune the 
positions. 

Space objects equally. Select three or more objects. Choose Align Objects from the 
Arrange menu. Choose to space equally vertically, 
horizontally, or both.  

Bring an object on top of 
overlapping objects. 

Select it, drop the Arrange menu and choose Bring to Front. 
When objects overlap, the one in front will obscure your 
view of the one to the back. 

Send an object behind 
overlapping objects. 

Select the object. Drop the Arrange menu and choose Send 
to Back. For example, draw a colored box and send it 
behind a graph. 

Duplicate one or more 
objects. 

Select the object(s). Drop the Arrange menu and choose 
Duplicate Object. 
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Aligning objects 
Prism provides several tools to help you position objects. 

Tool: Explanation: 

Zoom 

             

To precisely align objects, zoom to a larger magnification. Select a 
zoom level in the View menu or click the zoom buttons. Zooming 
changes the magnification on the screen, but does not change the 
size of the graph or layout when printed. 

Shortcuts: To toggle between small and full size, hold down both the 
Ctrl and Shift keys and click the left mouse button. Hold Ctrl and press 
M to zoom larger or Y to zoom smaller. To remember these keys, note 
that M and Y are the first and last letters in “magnify”. 

Nudge You can fine-tune the position of an object by nudging it. Select one 
or more objects. Then press the arrow keys to move the object(s) in 
one-pixel increments. 

Rulers Choose Rulers from the View menu. The rulers appear on top and to 
the left of the graph and page layout screens. Show the rulers to 
align objects precisely. Hide the rulers to leave more space for the 
graph.  

Alignment guides 

     

Alignment guides are temporary lines you can drop from the ruler to 
check on the position and alignment of objects. Click the mouse in 
either ruler to drop a single guide (down from the top ruler, or over 
from the left ruler). Click the corner where the two rulers intersect to
drop both alignment guides at once. The guides will remain visible 
only as long as you hold down the mouse button. 

Show coordinates 

     

 

Choose Coordinates from the View menu. On both graphs and page 
layouts, the position of the mouse is shown in the corner where the 
two rulers meet. The position is shown as inches or centimeters (set 
in the Preferences dialog) from the left and top edge of the page. 
These coordinates are visible only when rulers are showing. In a 
graph, Prism also shows the X and Y coordinates (in data units) at 
the top of the tool bar. 

Show grid 

    

Choose Grids from the View menu. Prism will show a grid that 
extends from the minor ticks on the rulers, spaced every 0.1 inches, 
or 1 millimeter. This grid is provided to help you align objects. It will 
not print. Select Grids from the View menu again to turn it off. Note 
the distinction between showing this grid, and choosing a frame 
with a grid (from the Format Axes dialog) to include a grid on a 
graph. 

Use snaps Choose Use Snaps from the Arrange menu. With Snaps on, shapes 
or lines you drag will always align with the grid (see above), whether 
it is shown or not. Using snaps helps you align objects with each 
other, but prevents fine-tuning of object position.  
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Tool: Explanation: 
Position by  
entering distances 

If you want to position an object to an exact position, select the 
object(s), drop the Arrange menu and choose Position Object. Then 
enter the distance of the upper-left corner of the object from the top 
and left edges of the page, and the desired height and width of the 
object. 

 

To bring up the Align dialog, select two or more objects, then drop the Arrange menu and 
choose Align Objects. Use the left half of the dialog to choose how to move the objects 
back and forth. You can line up the left edges, right edges, or centers, or equalize the 
spacing of the gaps between objects. Use the right half of the dialog to choose how to move 
objects up and down. 

 

Tip: The Align dialog aligns object borders. It doesn't know anything 
about what is inside the object, so it cannot align axes. To align the axes 
of two or more graphs on a layout, use the Align X Axes or Align Y Axes 
commands on the Arrange menu. 



 

132 GraphPad Prism User’s Guide 

22. Printing 

Two toolbar buttons for printing 
Note that there are two buttons on the toolbar for printing. The first one, on the left, 
brings up the Print dialog where you can choose which printer to use and which pages to 
print. The second one, in the middle of the toolbar and with the digit “1” showing, is a 
shortcut to print the current sheet on the currently selected printer without bringing up a 
dialog. 

 

Print header with file name and date 
Prism can print a header with the file name, sheet name, date, and time. To show or hide 
this header, drop the Edit menu (Prism menu in Mac OS X),  choose Preferences, go to the 
File & Printer tab, and select or deselect “Print sheet name as header”. 

 

Landscape vs. portrait printing 
Choose between landscape and portrait printing of data tables, results, and info sheets in 
the printer dialog (File… Printer Setup for Windows, File… Page Setup for Mac). A single 
setting applies to all data tables, results sheets, and info pages in the entire project. 

Prism ignores the portrait/landscape setting on the printer setup dialog when printing 
graphs or layouts. This lets you set the orientation of each individual graph or layout: 

• From a graph, click Change then Graph Type. 

• From a layout, click Change and choose Page Orientation. 

Printing data and results 
Prism prints data and results using the same font used to display data and results. You 
can change this font in the View tab of the Preferences dialog. You can change the size of 
the font by clicking Change and then Use Smaller Font or Use Larger Font. 

Note that you can adjust column widths by positioning the cursor between column 
headings, and dragging. Use this method to squeeze more onto each printed page. 
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Printing posters 
Prism can print on very large pages (up to 1.5 by 2 meters) so can create a poster directly.  
(If you use Windows 98, you will be limited to smaller page sizes.) 

Choose the paper size by dropping the File menu and choosing Printer setup (Windows) 
or Page Setup (Mac). The details vary with each printer driver.   

Since you can only set the page size once for the entire project, we suggest that you create 
your graphs in one project (or several projects) using a standard page size. Then make 
your poster in a separate project created just for that purpose. Set a large page size and 
then go to the layout section and create a layout sheet. Arrange the placeholders, and 
assign graphs from your other projects.  

Print preferences 
You have four print options, shown on the File & Printer tab of the Preferences dialog. To 
open this dialog, press Options on the Print dialog, or pull down the Edit menu (Prism 
menu in Mac OS X), and choose Preferences. 

Print Option: Effect: 

Print grid lines 
on tables 

Check this box to include the horizontal and vertical lines on data and 
results tables. Omit it for a cleaner look. 

Print row and 
column labels 

When printing data tables, print the row numbers on the left of every 
page and the column letters on top of every page. 

Print sheet name 
as header 

Print the file name, sheet name, date and time at the top of every page. 

Print no grays 
and no colors 

Convert all colors to black. Don’t print colors as shades of gray.  

 

Tip: Pay attention to the option to print sheet name (and date, etc.) as a 
header. You'll probably want this header on pages placed in your 
notebook, but not on graphs submitted for publication. 
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23. Pasting from Prism into other programs 

Copying from Prism to the clipboard 
To copy a Prism graph or layout to the clipboard, pull down the Edit menu and choose 
Copy. Or use the toolbar copy button or command on the shortcut menu. You don't have 
to select the graph first. If the insertion point is editing a title or text, click in the 
background before copying to avoid copying only that text. 

When you paste a graph from Prism into another program, the background color is not 
pasted. This lets you choose a background color, including gradients and other effects not 
available in Prism, in the other program.  If you want a background color, you'll need to 
create it within the other program. From Word, select the graph, select Format picture (or 
Format Object), select the colors and lines tab, and then select a fill color. From 
PowerPoint, use the Format Background command. 

Copying from Prism Windows 

The difference between pasting a picture, pasting a link, and paste 
embedding into another program 
When you copy and paste a graph or layout from Prism Windows into another program, 
you can embed a Prism object, link to the Prism file, or paste just the picture. Embedding 
and linking work using a standard protocol called Object Linking and Embedding, 
abbreviated OLE. You can link or embed Prism graphs and layouts into any program that 
is an OLE container. 

When you embed a Prism graph, you paste a picture plus a copy of all the data, analyses 
and graphical settings needed to create that graph (or layout). Essentially, you are pasting 
a Prism project file. When you double-click on the Prism graph in Word (or some other 
program), you will launch Prism and open the embedded Prism project. The Prism project 
is not saved as its own file; it is an object stored within the Word file.  

When you paste link a Prism graph, you paste a picture of the graph along with the name 
of the Prism file it came from. When you double-click on the Prism graph in Word, you 
will launch Prism, open the Prism file and edit that graph. The original data exists only in 
the original file. You don't have to cope with the confusion of having multiple copies of the 
data (as you would with embedding), but you must keep the linked files together. If you 
move or rename the Prism file, the link is broken. If you move the Word file to another 
computer, you need to remember to also move the Prism file(s).  

A third choice is to simply paste a picture. This is your only choice with Prism Mac or 
when pasting from Prism Windows into a program that does not support OLE. Since it is 
just a picture, it is not connected at all to Prism. If you want to make changes, you need to 
delete the picture, open the Prism file, make the changes and then copy and paste again. 

Tip: When it doubt, choose to link.  
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How to link a Prism graph or layout into another program 
If you simply select the Paste command from Word, PowerPoint, or any other program, 
you will embed a Prism object. To paste link the graph or layout into another program, 
use the Paste Special command located on that program’s Edit menu. From the Paste 
Special dialog, choose Paste Link and GraphPad Prism Project Object.  

When you first create a new Prism project, it has no name until you save it. If you copy 
and paste a graph from an unnamed Prism project, the paste link option will not be 
available. You must save the file before you can paste link. 

Working with linked Prism objects 

To: Do this (from Word or another program): 

Edit a linked Prism 
project. 

Point to the graph or layout with your mouse and double-click 
to launch Prism and open the file. When you are done editing 
the data or graph, save the file. 

Show a different 
graph or layout.  

Double-click to go to the linked file. Go to the graph or layout 
you want to appear in Word, and copy it to the clipboard. 
Return to Word, and delete the object you don’t want (use the 
delete key on you keyboard, not the Cut command). Then pull 
down the Edit menu and select Paste Special to create a new 
object with the graph or layout you just copied. 

Update a link after 
editing the Prism file. 

When you edit a linked Prism file, Windows automatically 
updates Word (and other programs). If you need to trigger an 
update manually, select the Prism graph in Word, then press 
F9. Or drop Word's Edit menu and choose Links. You’ll see a 
list of all linked objects in the file, with the Prism object 
highlighted. Press Update Now. Using that same dialog, you 
can choose whether the link should be automatic or manual, 
and you can break the link.  

Update a link after 
moving the Prism file. 

If you move the Word file and Prism file together, Windows 
should update the link automatically. You just have to make 
sure that the relative location of the two files hasn’t changed. If 
they were in the same folder initially, then keep them in the 
same folder. If the Prism file was in a folder named “links” 
inside the folder containing the Word file, then place the Prism 
file in a folder named “links” inside the new folder containing 
the Word file.  

Update a link after 
renaming the Prism 
file. 

If you rename a Prism file, you’ll break the link from Word 
files. Windows will not automatically update the links when 
you rename files. To update the link manually, drop the Edit 
menu and choose Links. Choose Change source, and enter the 
new file name. 

How to embed Prism graphs into another program 
To paste embed the graph or layout, use the Paste command located on the Edit menu of 
the other program. You can also paste embed from the paste special command. In the 
Paste Special dialog, choose Paste and GraphPad Prism Project Object. 
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The advantage of embedding is that the Word (or PowerPoint…) file is self-contained, as it 
contains the Prism data and settings. You can later edit the graph with Prism, without 
having to find any other file. You can email the file to colleagues, and they will be able to 
open and edit the Prism graphs (if they have Prism).  

One problem with embedding is that you end up with two or more copies of your data. For 
example, assume you start with a completed Prism project. Now you embed a Prism graph 
into Word, creating an embedded copy of the data and results shown on that graph. Later, 
you also embed another graph that includes the same data, creating a third copy of the 
data. Then you embed that same graph into PowerPoint for a presentation, creating a 
fourth copy. If you then notice a mistake in data entry, you'll need to edit all four copies.  

There are two other less important disadvantages to embedding. First, your files can get 
large because the embedded object includes Prism data and results. The second problem 
is that OLE does not always work perfectly. On rare occasions, the object will be saved 
incorrectly, and you'll lose the ability to edit the data. If the embedded object is the only 
place you saved data, you'll lose data if OLE fails. 

Using the Insert Object command 
An alternative method to link or embed Prism objects is to use the Insert Object 
command. From Word (or another program) choose Object from the Insert menu, or 
Insert object from the Edit menu. Select Create from File and choose a Prism file. Or 
select Create New, and choose a GraphPad Prism Project Object. 

The advantage of using the Insert Object command, rather than copy and paste, is that 
you will embed an entire Prism project. You'll still only see one graph or layout in the 
Word document, but the entire project is available by double-clicking. This might be 
useful if you send a document to a colleague and want to include all supporting details. 
When you copy and paste, you’ll embed only that one graph (or layout) and linked data 
and results. 

Pasting a Prism graph or layout as a picture 
If you are using an older computer, you may wish to paste only the picture without linking 
or embedding. The only advantage of simply pasting a picture is that you avoid using 
Object Linking and Embedding (OLE), which can be slow or troublesome on older 
computers. The disadvantage of pasting only the picture is that you cannot easily edit. If 
you want to make changes, you need to delete the picture, go back to Prism, open the 
Prism file, make the changes, and then copy and paste again. 

If the other program doesn't support OLE, then choose the Paste command to paste the 
Prism picture. If the other program does support OLE, use the Paste Special command 
located on the Edit menu and choose Picture (rather than GraphPad Prism Project 
Object). If you simply Paste, you'll embed a Prism object.  
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Copying from Prism Mac 

No linking or embedding with Prism Mac 
When you paste a graph or layout copied from Prism Mac, you paste a picture only. The 
concepts of linking and embedding, discussed above for Windows, do not apply on the 
Mac. 

Vertical and angled text 
Copying vertical text can be a problem with Mac programs. Prism can copy vertical and 
angled text in two ways. Choose in the Preferences Dialog. The best choice is to copy 
vertical or angled text as text fonts. This is most compact and gives the highest resolution. 
But some programs cannot interpret the vertical or angled text, so flip it to horizontal. The 
alternative is to convert vertical and angled text into many pixels, and copy those to the 
clipboard. You can choose the resolution. If the pasted vertical or angled text seems too 
jagged, choose a higher resolution.  

Pasting into Microsoft Word  
The details of pasting a Prism graph depend on which program you are pasting into. This 
section gives a few hints on using Microsoft Word. 

Floating vs. inline pictures 
Microsoft Word can include graphs (pictures) into documents in two very different ways. 
Graphs can float over the text or be inline with the text. There are advantages and 
disadvantages to using either approach. 

The advantage of floating pictures is that you may move them anywhere on the page by 
dragging. Using settings on the Wrapping or Layout tab of the Format Object (or Format 
Picture) dialog to control how text flows around the graph. A major disadvantage of 
floating pictures is that you cannot see them when working in normal view. You must 
switch to page layout view (from Word's View menu). A second disadvantage is that you 
cannot place floating pictures into tables.  
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Tip: Don't panic if a Prism graph pasted into Word as a floating object 
seems to vanish. The graph isn't really gone. You just can't see it in 
normal view. Drop Word's View menu and choose Page Layout (Word 
2000) or Print Layout (Word 2002). The graph will reappear.  

The position of an inline picture is determined by the position of the insertion point 
(which may be in a table) when you pasted the picture. You cannot move an inline picture 
by dragging. The advantages of inline pictures are that they are visible in normal view, 
and can be placed into tables. 

Different versions of Word have different default settings for pasting. After pasting, select 
the graph, drop the Change menu and choose Picture (or Object). Then go to the 
Wrapping or Layout (label depends on Word version) tab. If "In line with text" is not 
selected, your graph will float.   

Background color 
When you paste a graph from Prism into Word (or any other program), the background 
color is not pasted. If you want a background color, you'll need to create it within Word. 
Select the graph, drop the Format menu and choose Picture (or Object), select the colors 
and lines tab, and then select a fill color. 

Linking to a different project or sheet (Windows only) 
If you link to the wrong project or graph, it is usually easiest to delete the wrong graph 
from Word (or whatever program you are using) and then copy and paste the right one. 

It is also possible to fix the mistake. Select the graph within Word (or some program), 
drop the Edit menu and choose Links. Click Change Source to pick a file and click Items… 
on that subdialog to choose a different graph or layout. 

Pasting into Microsoft PowerPoint (Windows) 
Insert a Prism graph or layout into PowerPoint instantly by choosing Send to PowerPoint 
from the File menu. Or click this button. 

 

Prism will then copy the current Graph or Layout, create a new slide in PowerPoint, and 
paste. The pasted graph will be an embedded Prism object. Even though you don’t use the 
Copy and Paste commands, Prism is using the Windows clipboard, so it will erase 
anything you had previously copied. 

The graph or layout pasted into PowerPoint always has a clear page background, even if 
you chose a colored background within Prism. Prism separately assigns a background 
color to the PowerPoint slide that matches the background in Prism. You can change this 
background color within PowerPoint. To change the background for one slide, select 
Background from PowerPoint’s Format menu. To change the background for all slides, 
select Master Slide from PowerPoint’s View menu, and then choose Background from the 
Formal menu.  

The visible graph (or layout) is stored in the PowerPoint file along with an embedded 
Prism project containing the data and results and settings to make that graph (Windows 
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only). Double-click on the graph within PowerPoint to open this embedded Prism object 
within Prism. Now you can edit the data, change the analysis settings, polish the graph, 
and more. When done, drop the File menu, and choose Close and return. You’ll then see 
the revised graph within PowerPoint. When you do this, you are editing the embedded 
graph that is stored in your PowerPoint project. When you first clicked the PowerPoint 
button in Prism, you made a copy of the graph and its family and placed this family into 
the PowerPoint file. There is no link between PowerPoint and the original file. If you 
prefer to have the PowerPoint slide linked to the original Prism file (rather than to an 
embedded copy) don’t use the PowerPoint button within Prism. Instead, copy the graph to 
the clipboard within Prism, go to PowerPoint, then use Edit.. Paste Special and choose to 
Paste Link. 

Pasting into Microsoft PowerPoint (Mac) 
There is no send button or command in Prism Mac to copy and paste a graph directly into 
PowerPoint. Instead, copy the graph or layout in Prism, then go to PowerPoint, create a 
slide and paste. 
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24. Exporting graphs for submission to journals 

Overview of exporting graphs or layouts 
Few journals will accept native Prism files. Instead, they ask you to export your figures to 
standard file types. Each journal has different expectations, so read their instructions 
carefully. 

To export a graph or page layout, select Export from the File menu. Then select a file 
format and name.  Each time you use the File Export command, you’ll export the current 
sheet only.  

Prism lets you choose whether you want the page background included in the exported 
file. You may wish to exclude the background when you plan to import the file into 
another program where you will apply a fancier (e.g., gradient) background.  

Exporting to a WMF or PICT file 
Windows Metafile (*.wmf) and Macintosh PICT files contain vector and font instructions 
for how to draw the graph (with the exception of vertical text in the Mac, discussed 
below). This means you can resize the image (in another program) with no loss of quality.  

Saving vertical and angled text into a pict file can be a problem with Mac programs. Prism 
can export vertical and angled text in two ways. Choose in the File Export dialog. The best 
choice is to save vertical or angled text as text fonts. This is most compact and gives the 
highest resolution. But some programs cannot interpret the vertical or angled text, so flip 
it to horizontal. The alternative is to convert vertical and angled text into many pixels, and 
save that bitmap. You can choose the resolution. If the exported vertical or angled text 
seems too jagged, choose a higher resolution.  

Exporting to a TIF file 
Many journals ask you to submit your figures as .TIF files. This is a bit-map format, which 
means that your graph or layout is turned into a collection of dots, with a color encoded 
for each.  

When exporting .TIF files, think carefully about the options that Prism offers, and try to 
match what your journal wants. The size of the file (and the time required to create it) is 
determined by the size of your graph (or layout), the resolution you choose, and the color 
depth you choose.  If you choose very high resolution of a very large graph or layout, 
Prism may not be able to export at all due to memory limitations. 

Note: Computer screens display images at about 100 dpi. Computer 
printers generally print at 300-600 dpi, and publications are generally 
printed at 1200 dpi. 

Journals typically ask for a file at 1200 dots per inch (dpi), the highest resolution that 
Prism offers. But they only need a file at this resolution at the publication size. Typically, 
graphs and layouts in Prism projects are much larger than publication size. If you ask for a 
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graph at 1200 dpi at the actual size in Prism, you’ll end up with a huge file (or perhaps an 
error message saying there is not enough memory). Avoid this problem by specifying the 
publication size (in Prism’s File Export dialog). This can make a huge difference in file 
size. Let’s say your graph is 6 inches wide, but you will publish it with a width of 2 inches. 
By checking the option to reduce the graph to a width of 2 inches, you’ll create a file one-
ninth as large (one-third the width times one-third the height). This also will require one-
ninth as much memory. 

Prism lets you choose between two ways to express colors: RGB or CMYK. If you are 
submitting to a journal, follow their instructions. If in doubt, choose CMYK. You can also 
choose Monochrome files, which are pure black and white with no grays. If you choose 
RGB, choose between 256 colors (smaller files) or millions of colors (more accurate color 
rendition). 

Exporting to a JPG file 
The .JPG format is designed for photographs with gradients of similar colors. It is not a 
particularly good format for exporting for line art and graphs. Prism offers this choice 
because some journals insist on it, but we recommend that you use the .TIF format when 
possible. The only advantage of .JPG is that the files are smaller. 

Most programs that export to the .JPG format give you a choice of compression. If you 
compress more, the files will be smaller but the resulting image won’t be as sharp. Prism 
gives you no choice.  It only exports to the .JPG format with the least possible 
compression, making larger files but sharper images. Any compression would reduce the 
clarity of your graphs noticeably.  

Exporting to other formats 
Prism can also export graphs or layouts as web-friendly .PNG files. There are no options 
of color depth or resolution. .PNG files use a bit map format at the resolution of a 
computer screen. They are great for posting on web sites, but have too little resolution for 
submission to printed journals. 

Prism Windows can also export to .BMP or .PCX files. These are older (especially pcx) bit-
map formats that don’t offer any advantage over .TIF. Choose .BMP or .PCX only if your 
publisher (or another program) needs one of these formats. 
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25. Posting graphs and layouts on a web site 

Overview of posting to the web 
Prism makes it very easy to post graphs and layouts on the web, handling all details 
automatically. You can post to your own web server, or (if you use Windows) you may use 
a free service offered by SmartDraw.com. 

You can also export Prism graphs and layouts as web-friendly .PNG files which a web 
designer can use in creating custom web pages. 

Before you post your first graph 
Before you can post onto a web site, you must configure Prism to do so. Drop the Edit 
menu (Prism menu if you use Mac OS X), choose Preferences, and then choose the Post to 
Web tab. If you use Prism Windows, choose whether you want to post to the 
SmartDrawNet server or FTP to your own server. Mac users must FTP to their own server. 

The SmartDrawNet system is free for anyone to use. You don’t need to already have an 
account with them. If you choose the SmartDrawNet server, you need to enter your email 
address and password. If you already have an account with SmartDraw, enter the name 
and password of that account. Otherwise, enter a new username and password, and 
SmartDraw will set up a free account instantly. You don’t need to register at the 
smartdraw.com web site and don’t need to own or purchase any SmartDraw software.  

If you choose to post to your own FTP server, enter its address and your account name 
and password (if required). You must also enter the URL to use to view these files (Prism 
will append the folder and file name). If your server is behind a firewall that prevents 
incoming FTP connections, check the option to use passive mode so Prism will initiate 
data connections rather than asking the server to connect back to your computer. You’ll 
probably want to ask your webmaster for help in configuring these FTP settings. 
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How to post a graph or layout 
To post a graph or layout, drop the File menu and choose Post to Web, and then choose 
whether you want to post the current graph or layout, or all graphs or all layouts. You can 
also post a single graph or layout by clicking the post to web button: 

 

What happens when you post to SmartDrawNet (Windows only) 
Posting to the SmartDrawNet system is entirely automatic, and Prism will open your 
browser to the appropriate page. SmartDrawNet is mostly used to post digital photos, so it 
organizes your account into “albums”. Each Prism project becomes a new album. 

Prism never deletes anything from your SmartDraw account. You need to do that 
manually from within the smartdraw.com system. If you post the same graph again, an 
additional copy will be appended to your album. 

The whole point of posting your graphs is to share them with your colleagues. These 
colleagues need only a web browser and do not need to install Prism. From 
SmartDrawNet, you can click a link to invite colleagues to come look at your graphs. 
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 Anyone who gets the URL of your site will be able to view it. The URL is not obvious, so 
your graphs are reasonably secure. But don’t post any data that you consider to be 
confidential.  

SmartDraw Software has created the SmartDraw program, which is very useful for 
drawing diagrams. It works very well with Prism, and we encourage you to try the free 
demo version. When you register to send Prism graphs to SmartDrawNet, SmartDraw will 
send an email telling you about SmartDraw. After that, you can decide whether you wish 
to remain on SmartDraw’s email list for periodic updates. You can still use the free 
posting service, even if you unsubscribe from SmartDraw’s email list. 

Note: Prism posts only pictures of your graphs or layouts for others to 
view. It does not upload the Prism file itself.  

What happens when you post to a FTP site (Windows or Mac) 
Prism will post the graphs (or layouts) on your FTP server and create an index page. 
Immediately after posting the graphs, Prism will launch your browser, and take you to 
that page. Copy the URL of the created page and email it to others so they can view your 
graphs.  

Security depends on how your site was setup. Understand the security of the site before 
deciding whether to post confidential data. 

Prism cannot delete files from your FTP site. Use an FTP program for that. 

Note: Prism posts only pictures of your graphs or layouts for others to 
view. It does not upload the Prism file itself.  

Exporting to a PNG file 
If you want to include a Prism graph or layout in a fancier web site than what Prism 
creates automatically, export to a .PNG file using Prism’s File Export command. All you 
have to do is choose a file name and location – there are no other options. Then email the 
.PNG file to your web designer. 

Why not use the .JPG format? Prism can export the .JPG format, but we don’t recommend 
it. That format is designed for photographs, not high contrast graphs, and has no 
advantages over .PNG for posting on a web site. 

Why can’t Prism export to the .GIF format? That is a proprietary format, and it would be 
illegal for Prism to export in that format unless GraphPad paid a substantial fee to the 
patent holder. If you really need to create .GIF files, create another format and then 
convert in another graphics program. The .PNG format is better than .GIF in all ways, 
except that it won’t be recognized by older web browsers. 
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26. Sending Prism projects to colleagues 

What’s needed to open a Prism file? 
Prism files contain an entire project — data, info, results, graphs, and layouts. Because the 
files contain far more than data, they are called “project files” rather than “data files”. 
These files can only be opened by GraphPad Prism. 

You can send a Prism file even to someone who doesn’t own Prism. The recipient can view 
the file using either the free Prism demo or the Prism viewer. The demo is fully functional 
for 30 days, but won’t work after that. The viewer lets your colleague view all parts of a 
Prism file (including analysis parameters) and print selected pages. Your colleague won’t 
be able to make any changes, and won’t be able to copy and paste. The Prism viewer has 
no time limits and is available free (for Windows and Mac) on www.graphpad.com . 

Prism 4 uses a new file format. Prism 4 files cannot be opened by previous versions of 
Prism, and Prism 4 cannot save in a Prism 3 file format. If you send a Prism 4 file to 
colleagues who use Prism 3, they will not be able to open your file unless they purchase an 
upgrade, or use the Prism 4 demo or viewer. 

Cross-platform considerations 
The Windows and Mac versions of Prism use the same file format. You don’t need to run 
any special conversion program – just open the file. 

With Mac OS 8-9, the use of file extensions is optional, and you can choose to turn off use 
of file extensions in the File & Printer tab of the Preferences dialog. If you use Windows, 
and a colleague sent you a file from Prism Mac without the Prism .pzf extension, you can 
rename the file yourself. Or set Prism’s File Open dialog to show All files (*.*) rather than 
only showing  files with Prism extensions. 

The Prism Mac installer configures the Mac OS to recognize files with the extension of .pzf 
to be Prism files. Therefore, you can double-click on a file transferred from Prism 
Windows and the Mac OS should know to launch Prism. If this doesn’t work, launch 
Prism yourself and use the File Open command.  

Some Mac email programs automatically encode or compress attached files without 
adding a  file extension. If you use Windows and receive a file from a colleague’s 
Macintosh that you can’t open, try “unstuffing” the file using the program StuffIt 
Expander (free from www.stuffit.com). That program does more than reverse “stuffing” 
(compression) – it also decodes files stored in MacBinary or BinHex formats.You don’t 
have to know how (or even whether) the file was encoded or compressed – StuffIt 
expander just figures it out.  

Emailing directly from Prism (Windows only) 
To send a Prism project to a colleague via email, drop the File menu and choose Send 
Mail. Choose to send the Sheet, Family, or Project. Your email program will open and 
create a new message with the Prism file attached. Prism creates a temporary copy of the 
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project, and attaches that. Changes you make after choosing the Send Mail command will 
not be included in the email, even if you delay sending it. 

If you choose to send one sheet, it will be a text file (data or results) or a .WMF file (graph 
or layout). 

The Send Mail command works if your email program is configured to use the MAPI 
commands. It won’t work if you use a web-based email system or if your email program 
isn’t configured for MAPI.   

If the command doesn't work, or if you use a Macintosh where the command isn’t 
available, you can still attach Prism files to email. Simply save the file, and then attach it 
to an email from your email program. If you only want to send a subset of your project, 
save the current sheet and all related sheets using the Save Family As command. To find 
it, drop the File menu and choose Save Special. 

Saving Prism files to a FTP server 
There are two reasons to post a file on a FTP server, rather than email it to a colleague: 

• Some email programs prohibit large attachments, with various definitions of 
“large”. So the file you attached to an email may not be received by your colleague. 

• You may want to make the file available to a number of people. 

To save Prism files to a web server, use File Transfer Protocol (FTP). One way to do this is 
to save the Prism file to your own hard drive, and then use a dedicated FTP program to 
transfer the file to your web server.  

With most Windows computers, it is also possible to save a file directly from Prism to a 
web server. These instructions are for Windows XP, but also work for Windows ME, NT4 
and 2000. It is not possible to save directly to a FTP site if you use Windows 98 or a 
Macintosh.  

Before you can open or save files from Prism (or most other programs) to an ftp server, 
you need to configure Windows to allow this. Click Start, then Settings, the Control Panel. 
Choose Internet Options, go to the Advanced tab, and then to the Browsing section. Check 
the option “Enable folder view for FTP sites”.  

Now click Start, choose “My network places”, and then choose “Add a network place”.  
After completing the wizard, you’ll have added your ftp site to “My network places”. From 
Prism’s File Save dialog (or any dialog on any program that asks you to select a file) you 
will be able to choose “My network places” and then choose your FTP server. This lets you 
save files to that server, or open files on that server, just as if it were part of your local 
network. 

Creating hyperlinks to Prism files 

Hyperlinking from a web page 
Once you’ve posted a file on a web server, you need to make it available to your colleagues. 
One way to do this is to give them the information required to access the ftp site. This can 
be complicated, requiring special FTP software or special configuration (see previous 
section), and may require a password. A better alternative is to post the link on a web site, 
so accessing the file requires only a web browser and a URL you provide. 
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Link a Prism file from a web page just like you’d link to another web page.  For example, 
this html code will link the words “click here” to a Prism file with the name 
TodaysData.pzf in the same folder on the web server. 

Please <a href=”TodaysData.pzf”>click here</a> to see the file. 

 

When the reader clicks on the link, the file will be downloaded, and then Prism will launch 
and open the file. The viewer’s computer must have Prism (or the free Prism viewer) 
installed. Mention the free Prism viewer on your web page and link to www.graphpad.com 

Hyperlinking from an Office document 
You an also create a link to a Prism file from within a Word, Excel, or PowerPoint 
document. Select the text you want to link (can be any text) and then choose Hyperlink 
from the Insert menu. This will bring up the Insert Hyperlink dialog. You can then either 
choose a Prism file on the same computer, another computer on your network, or enter a 
URL for the file on a web server.  

 

In the example above, notice that the words “Click here” will be linked (have the blue 
underline). You might prefer to spell out the hyperlink here, so it will appear when the 
document is printed. The middle part of the dialog is irrelevant in this example, since we 
are linking to a file saved on a web server rather than a file stored on this computer. We 
typed the complete URL of the file, starting with “http:” and ending with “.pzf” in the box 
marked “Address:”. This example is for Office XP, but it works very similarly with Office 
2000. 

Note: When you use the Insert Hyperlink command, you are 
hyperlinking a word or phrase within Word, Excel or PowerPoint to an 
entire Prism file. You won’t see any Prism graph within Word, Excel, or 
PowerPoint. 
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27. Sharing Prism templates and equations 

Individual configuration files 
Prism stores the list of user-defined equations, choices from the Preferences dialogs, the 
list of recently used files, and more in a configuration file.  

Prism Windows stores preferences in the file Prism4.cfg. Prism Mac stores preferences in 
a file named “Prism4 Preferences”. The location of these files depends on which version of 
Windows or the Mac OS you use, so search for them.  

If several people use the same computer, each may maintain their own preferences and 
equations. To do this, create a different shortcut icon for each user. In the target portion 
of the properties dialog for the shortcut, enter the full path name of the Prism program 
followed by “-O” (letter O, not zero) and then the full name of the configuration file you 
want to use. If the file doesn't exist, Prism will create it. For example: 

C:\Program Files\PRISM4\PRISM.EXE -OC:\JERRYS\JSPRISM.CNF 

 

If you are running a network license, you may place the Prism4.cfg file into the program 
folder on the shared (server) drive. When Prism is first used on a new computer, it will 
use the settings in this shared configuration file. Changes will be saved on the individual 
user’s hard drive. This means that all users can begin with the same settings, but then 
customize them.  

Templates and methods files 
You can create templates and methods within Prism (choose Save special from the File 
menu) and then use them from the program – all without knowing anything about where 
the files are stored. If you want to set up a computer with a library of templates or 
methods, read this section to learn how. 

Prism saves template files in a subfolder within the Templates folder, in the program 
folder. For example, save a template to "C:\Program 
Files\Prism4\Templates\Physiology\Blood Pressure.pzt". Methods are similarly stored 
within the Methods folder. 

If your users are running Prism from a network, you simply need to place the template 
and/or methods files in subfolders within the templates (or methods) folder within the 
Prism program folder. If your users run Prism from their own computer, you’ll want to 
place these files onto each user’s computer.  

When you save the template or method, enter a brief description. If you want to provide 
more extensive help to your users, also create a web (.htm) file that explains use of the 
template or method. Give it the same name as the template or method, but with the 
extension .htm, and place it in the same folder. For example, if your template is 
doseresponse.pzt, create a help file named doseresponse.htm. When someone uses the 
template or method, Prism will pop up the dialog with the brief instructions. This dialog 
also has a button “Help for this template”. When your uses click this button, Prism will 
launch a web browser to display the .htm file you created. 
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Equation library files  
When you choose an equation for nonlinear regression (or simulations), Prism lets you 
import from the equation libraries. GraphPad provides equation files with Prism. You can 
create additional library files, which are simply Prism files (or templates). Follow these 
steps: 

1. Create a new Prism project using the equation. Either enter sample data and 
analyze with nonlinear regression, or simulate a curve.  

2. Define rules for initial values (from the dialog where you enter/edit the 
equation). Also define constraints, if needed. 

3. Customize the graph so it will be clear as a preview (test this by looking at the 
graph gallery). 

4. Repeat with any number of related equations that you want to store in one file. 

5. Drop the Edit menu (Prism menu in Mac OS X),  and choose Preferences. Go to 
the File & Printer tab. Choose normal (not compact) file format. 

6. Save the file in the Equations folder, in the program folder. For example: 
C:\Program Files\Prism4\Equations\Electrophysiology.pzf 

7. If you are creating an equation file that will be used by others, consider creating 
a help file that explains the equations. Create an html file with the same name as 
the file containing the equations, but with the extension .htm.  

When you select an equation from a library file, Prism displays a list of all files (and 
templates) in the Equations folder. When you pick one of those files, it shows a list of all 
user-defined equations used in the file, along with a thumbnail preview of the first graph 
linked to each equation. If a help file exists for the selected file, click "Help for this 
equation file" to open it.  

 

Script files 
Prism scripts let you automate analysis of many files. Prism scripts are stored in files with 
the extension .pzc. If you create scripts for others, place these in the scripts folder within 
the Prism folder. 
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28. Automating Prism using scripts 

Introducing Prism scripts  
Because Prism links data to graphs and analyses, a great deal of automation is built in. 
Simply edit or replace data or info constants, and everything will be updated. Although 
this built-in automation suffices for day-to-day lab work, it can be tedious when repeated 
over and over.  

You can use a Prism script to automate the analysis of a large number of files or simulate 
many data sets for Monte Carlo analyses. Prism's scripting language lets you open and 
close Prism files, import data, and export or print results and graphs. You can run Prism 
scripts from within Prism, or launch Prism from another program. 

Note that Prism scripts do not tell Prism how to analyze or graph your data. That is built-
in to the Prism project (or template). Use a script to import data into an existing project 
and to specify which results and graphs you want to export or print.  

Scripts are small computer programs. Creating a script is slightly more difficult than using 
Prism. Experience with other scripting or macro languages is helpful, but not necessary. If 
you want to launch a Prism script from Excel, you will also need to learn Excel's macro 
language, Visual Basic for Applications. 

Examples of Prism scripts 
The easiest way to learn Prism's scripting language is to follow some examples.  

The examples below are for Prism Windows. The only difference on a Macintosh is that 
you use a colon instead of a backslash to specify disk names, folder names, and files. For 
example, the first line of the first example would read: 

SetPath “Hard Drive:Prism 4:Data:June21” 

Script example 1. Repeatedly import data 
This script analyzes a folder full of dose-response data stored as text files, perhaps from 
an instrument. It creates a single file that tabulates the logEC50 values along with the 
standard error and the R2 of the fit.  

Commands in file Comments 
SetPath “c:\prism 
4\data\june21\” 

This sets the disk and directory to be used for the 
rest of the file. 

OpenOutput results.txt Create a file called results.txt to contain the 
output. 

WDate Write the date into the output file. 

WText Write a blank line. 
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WText File ; This command and the next three write a header 
to define the four columns that the 0utput file 
will contain. 

WText logEC50 ;   

WText SE ;   

WText R-squared   

Open dr.pzf Open the Prism file dr.pzf 

ForEach dr*.txt Loop for all files that begin with dr, have the 
extension .txt, and are present in the disk and 
directory defined by the SetPath command. 

   Goto D Go to the data section. 

   ClearTable Erase all data from the table. 

   Import  Import the file defined by the ForEach statement 
into the first empty columns. 

   WText %F ; Write the file name into the output file. The 
semicolon at the end means that the next item 
written will be on the same line, separated by a 
tab. 

   GoTo R 1 V2 Go to the second view of the first results page. 
This is the table of nonlinear regression results. 
For each file, Prism will notice that the data have 
changed and will rerun the fit. 

   // write out the logEC50,  
   SE, R2 

Comment. 

   WCell 5,1; Write to the output file the value on the fifth row, 
first Y column (A), in this case, the EC50.  

   WCell 11,1; Write another value. It will be on the same line as 
the previous result, since that was followed by a 
semicolon. 

   WCell 21,1 Write the R2 value. Since there is no semicolon, 
Prism adds Enter and linefeed to the output file. 

Next Loop back to the ForEach statement and read the 
next file. Exit loop if no more files. 

Beep Signal completion. 
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Script example 2. Monte Carlo analysis 
This is an example of Monte Carlo analysis. We'll create 500 data sets with random variation 
and fit each. This script creates a single file containing the logEC50 from all 500 fits.  

Commands in file Comments 

ShortLog Write less in the log file to speed up the 
processing. 

SetPath “C:\prism 4\” Set the disk and directory to be used by the rest of 
the commands. 

Open generate.pzf Open the Prism file generate.pzf. 

OpenOutput fit.txt Create an output file names fit.txt. 

ForEach 500 Loop 500 times. 

   GoTo R 1 Go to the first results sheet, which is a simulation. 

   Regenerate Regenerate the simulation with new random 
numbers. 

   GoTo R 2 Go to the second results sheet. Since this sheet 
contains nonlinear regression results, Prism will 
automatically refit the data for each loop.  

   WCell 5,1 Write to the output file the logEC50 – the value in 
the fifth row in the first Y column.  

Next Loop back to the ForEach statement. 

Script example 3. Import several files onto one table 
This example uses the script to import several files onto one data table. 

Commands in file Comments 

SetPath “c:\prism 4\” Define the disk and directory to be used by the 
rest of the commands. 

Open rapid.pzt Open the Prism template rapid.pzt that was 
created to contain a formatted data table. 

GoTo D Go to the data section. 

ForEach Avge_*.dat Loop through all files that start with Avge_ and 
have the extension DAT. 

  Import  Import into the first empty column. 

Next Go to the next file, which will be imported into the 
next column of the same table. 
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Script example 4. Open a template and import data 
This example uses a script to launch Prism. 

Commands in file Comments 

SetPath “c:\prism 4\” Define the disk and directory to be used by the rest 
of the commands. 

Open rapid.pzt Open the Prism template file rapid.pzt 

GoTo D Go to the data table. 

Import today.txt  Imports the file today.txt. 

GoTo G Go to the graph section. 

While Example 4 would not be useful when run from Prism, it would be useful to program 
into an icon. For example, create a shortcut icon with a target of “C:\program files\prism 
4\prism.exe” @doit.pzc. Double-click that icon to launch Prism and run the script 
doit.pzc. That script instructs Prism to open a template (today.pzt) and import today's 
data (today.txt, presumably changing daily) into the file, and go to the graph. Once you’ve 
set this up (a few minutes) and also have a mechanism so the data file is updated daily 
(outside the scope of Prism), you simply double-click to see a new graph of today’s data. 

Script example 5. Import data and info constants from the script file 
Commands in file Comments 

ShortLog Don’t log every step. 

GoTo D , 1 Go to the first data table. 

InsertData 1,0 Insert data from the script file, starting at row 1, 
column 0 (the X column). 

<DATA> Start of data block within script file. 

0.000                        1115.999 Adjacent values are separated by tabs. 

1.000                        564.1452  

2.000                         389.7727  

3.000                         138.9337  

4.000                         115.3119  

</DATA> End of data block. 

GoTo I, 2 Go to second info sheet. 

SetInfo "Experiment", 2, 0 Set the name of the second info constant. 

SetInfo "345", 2, 1 Set the value of the second info constant. 

SetInfo "Experimenter", 3, 0 Set the name of the third info constant. 

SetInfo "Dan Brown",3, 1 Set the value of the third info constant. 

SetInfo "[Potassium]", 4, 0 Set the name of the fourth info constant. 

SetInfo "3.45 mM", 4, 1 Set the value of the fourth info constant. 
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Script example 6. Import data into several tables 
Commands in file Comments 

Shortlog Don’t log every step. 

GoTo D  Go to the data section. 

ForEach 9 Loop nine times. 

  GoTo %N Go to the Nth data table, where N is the loop 
number. 

  Import Data%N.txt Import the data file. Data2.txt goes into the 
second table, Data3.txt goes into the third 
table, and so on. 

Next Loop. 

GoTo L 1 Go to the first layout, which was setup to 
show all nine graphs. 

Print Print the layout. 

Creating a Prism script 
Create a Prism script using a plain editor such as the Windows Notepad or Macintosh OS 
8-9 SimpleText or Macintosh OS X TextEdit. If you use a word processor, be sure to save 
the files as plain text without word processing codes. You may also create a script right 
from Prism. Pull down the Files menu and choose Run Script. Then press the New 
(Windows) or  New Script (Mac) button. 

Although you may use any extension, we recommend that you give all Prism scripts the 
extension .pzc. When you double-click on a file with this extension from File Manager (or 
explorer) Windows will automatically launch the Windows notepad (or whatever editor is 
associated with the txt extension). 

We suggest storing script files in the scripts folder within the program folder. 

Launching a Prism script 
Scripts may be used in several ways. You can run scripts from within Prism, from a 
shortcut on your desktop, or from a macro within Excel or some other program. 

Running a Prism script within Prism 
While testing and developing a Prism script, run it from Prism. Once you perfect it, you 
may want to run it from the command line or from another program as explained later. 

To run a script from Prism, pull down the File menu, click Run Script, and then choose 
the script. Here is the top portion of the GraphPad Prism Script dialog. 
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Button: Explanation: 

Run Runs the script. As Prism runs each line of the file, it will show the 
line in the log area below the buttons. 

Step Run one step. Running one step at a time is often helpful when 
testing new scripts. You can see the changes in the Prism file as the 
script completes each step. 

Pause Stop the script. Press Run to start it again.  

Edit Launch text editor to edit the script file. After editing, save and 
close the file before running the script again. 

Minimize   Click the minimize button (upper left of dialog) to reduce Prism to 
a tiny Window that displays only the current step and loop 
number. Your script will run faster because Prism doesn't have to 
update the entire screen.  

 

  

Launching a Prism script from a desktop icon (Windows only) 
Once you've tested the script, you may launch it by pressing a button on your desktop. To 
create an icon that launches a Prism script, point your mouse to an empty spot on the 
desktop, click the right mouse button and select New Shortcut. Enter a command line 
something like this: 

“C:\PRISM 4\PRISM.EXE” @”C:\PROGRAM FILES\PRISM 4\SCRIPTS\DOIT.PZC” 

 

Click the new icon to launch Prism and run the specified script. While running the script, 
you’ll see only Prism’s script dialog. Expand the Window by clicking the expand button: 

 

After the script ends, Prism will remain open if you have left any Prism files open. If the 
script closes all Prism files, then Prism will exit. 

Launching Prism from another program using the Shell command 
(Windows only) 
It is often useful to launch Prism from another program such as Excel or Access. 

There are two ways to run Prism from another program. This section explains how to use 
the Shell command. To "shell" simply means to launch one program from another. The 
next section explains how to use OLE (or Active X) automation to launch Prism. These 
examples assume you are running Visual Basic for Applications (VBA) from within Excel. 
The syntax is identical for all versions of Visual Basic and should be very similar in other 
languages. 

The easiest way to run a Prism script is via the Shell command. For example: 
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Shell ("C:\prism 4\prism.exe @C:\prism 4\dr2.pzc") 

 

The shell command has to specify both the full location of prism.exe and the script that 
Prism will launch. Include the @ symbol in front of the script name. The Shell command 
is a Visual Basic statement that you will need to write in an Excel macro, perhaps one that 
runs when the user clicks a button.  

As soon as Visual Basic has launched Prism, it will continue to the next statement in the 
Visual Basic program or macro. It will NOT wait for Prism to complete before continuing. 
If you don't take the extra steps described below, your Visual Basic program will try to 
read a file containing Prism’s results before Prism has finished creating that file. To avoid 
this, make your Visual Basic program pause until Prism creates a file.  

When you write the Prism script, include lines at the end of the script to create a file that 
will tell Visual Basic you are done. The example below creates done.txt. 

OpenOutput  "done.txt" 
WText "done" 
CloseOutuput 

 

Your Visual Basic code should first delete the file done.txt (if it exists from a previous run) 
and then launch Prism. Immediately following, include these lines that make your 
program loop until done.txt is created.  

Do Until Dir$(“C:\prism 4\done.txt") > ""    
  Application.Wait Now + TimeValue("00:00:1") 
Loop 

 

The first line in the example above checks whether the file done.txt exists. Change the 
path and file name as needed. If the file exists (Prism is done), Visual Basic continues 
beyond the loop with any code that follows. If the file doesn't exist yet, Visual Basic waits 1 
second, and then loops back to test again whether the file exists. 

Running Prism from another program using OLE automation (Windows 
only) 
An alternative to the Shell command is to launch Prism using OLE (or Active X) 
automation. Here is an example. 

Set Prism = CreateObject("Prism.command") 
Prism.SetPath (”C:\data\july99”)  
Prism.visible  
Prism.runcommand (“c:\prism4\doseresp.pzc") 
Prism.quit  
Set Prism = Nothing 

 

The first line creates a Prism command object. You may give the object variable any name 
you like (on the left side of the = sign), but it is convenient to name it Prism. You don’t 
have to tell the program the location of prism.exe. Windows takes care of this 
automatically via the registry. 

The second line, which is optional, tells Prism which folder to use. This replaces the need 
for a SetPath statement within the Prism script. When running a script, Prism looks for 
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data files and templates in this directory (folder) first. Place the name of the folder in 
quotation marks or use a text variable.   

The third line tells Prism to show its progress dialog. Once you have tested your code, 
remove this line so Prism will run invisibly (show no dialogs).  

The fourth line launches the Prism script. You must include the full path of the script file; 
the directory used in the SetPath message (above) is not used automatically.  

The final two lines cause Prism to exit, and free the memory used by the Prism object. 

There are two advantages to using OLE automation, rather than the Shell statement. First, 
with OLE automation Visual Basic and Prism run sequentially, with no possibility of 
Visual Basic trying to obtain results that haven't been created yet. Second, with OLE 
automation, your Visual Basic program can direct Prism to import data from a particular 
folder (Prism.SetPath command) without changing the Prism script.   

Launching a script from an intranet web page 
You can launch Prism from an intranet web site. 

First, create a batch file on your web server that calls (using the Call command) the 
program and individual configuration files.  

For example, create a file called StartPrism.bat containing a single line something like this 

    Call N:\Program Files\PRISM4\PRISM.EXE -OC:\WINDOWS\local.cnf  

 

Or this: 

Call F:\Prism\Prism.exe @"F:\\PRISM\PRISMSCRIPTS\DOIT.PZC" 

 

Of course, you'll need to adjust this example depending on where you have installed 
Prism. The drive letters are aliases for the server drive. In the first example, the first part 
opens Prism and the second part tells Prism where to store configuration files. In the 
second example, the second part launches a Prism script.  

Next edit your web page to include a hyperlink to the batch file. For example, HTML link 
the text "Prism" to the file StartPrism.bat  

Launching Prism from using AppleScript (Mac only) 
Hereis a sample AppleScript that launches Prism and tells it to run the script named DR2 
located in the P4scripts folder on a disk named HD.  

tell application "HD:Applications:Prism4 Folder:Prism" 
    activate 
    open file “HD:P4scripts:DR2” 
end tell 

Launching Prism from another program using MacScript command 
(Mac only) 
It is often useful to launch Prism from another program such as Excel. One way to do this 
is with MacScript commands. These examples assume you are running Visual Basic for 



 

158 GraphPad Prism User’s Guide 

Applications (VBA) from within Excel. The syntax is identical for all versions of Visual 
Basic and should be very similar in other languages. 

Launch Prism with this MacScript command. 

MacScript “tell application “”HD:Prism4:Prism””” + Chr(13) + _ 
“activate” + Chr(13) + _ 
“open file “”Macintosh HD:Prism4:Scripts:dr2””” + Chr(13) + _ 
“quit” + Chr(13) + _ 
“end tell” 

 

The MacScript command has to specify both the full location of Prism and the script that 
Prism will launch. The MacScript command is a Visual Basic statement that you will need 
to write in an Excel macro, perhaps one that runs when the user clicks a button. 

As soon as Prism script is completed, click Cancel in the “GraphPad Prism Script” dialog 
to continue to the next statement in the Visual Basic program or macro. 

Using Prism scripts with Excel 

Exporting data from Excel to Prism 
Although Prism can open Excel files, this is slow. Instead, write a Visual Basic macro to 
export selected values as a text file. The macro below, run from Excel, exports the upper 
left corner of worksheet 1 (12 rows, 6 columns) to a comma-separated value (CSV) file, 
which Prism can import. 

Open  "C:\data\july97\dr2.csv" For Output As #1 
For I = 1 To 12 
  For J= 1 to 6 
    Print #1, Worksheets(1).Cells(I,J).Value; ","; 
  Next 
  Write #1,  
Next 
Close #1 

 

Follow this with code to launch Prism, run the Prism script, and perhaps import results 
from Prism back to Excel. 

Putting Prism graphs into Excel  
In addition to importing the results of Prism analyses, you may want to import a Prism 
graph into Excel. Exporting the graph is no problem, as a Prism script can export a graph 
or layout as a WMF picture. The problem is importing it into Excel, as there is no way to 
write Visual Basic commands to import a picture. You can do it indirectly. Create a picture 
object manually in Excel (display the control toolbar, click on the image button, then drag 
to create the object). Then write Basic code to change the contents of that picture object. 
For example, 
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Sheet2.DRGraph.Picture = LoadPicture(Path$ + "dr2.wmf") 

Creating a PZC file from Excel 
While creating a system to run Prism from Excel, you need to edit both the Excel VBA 
statements and the Prism PZC script. One way to simplify your work is to write Visual 
Basic code that exports the PZC file from Excel. Then you only have to edit one file. For 
example, you could use the following VBA code:  

Open  "C:\Prism4\auto.pzc" For Output As #1 
Print #1, “Shortlog” 
Print #1, “SetPath C:\gp\prism25\” 
Print #1, “Open generate.pzm” 
Print #1, “openOutput fit.txt” 
Print #1, “   ForEach 500” 
Print #1, “    GoTo R 1” 
Print #1, “    Regenerate” 
Print #1, “    GoTo R 2” 
Print #1, “    WCell 5,1” 
Print #1, “ Next” 
Close #1 
Shell ("C:\program files\prism4\prism.exe  @C:\prism4\auto.pzc") 

 

The first line starts a new file called auto.pzc and designates it as file number 1. The next 
11 lines, export Prism script commands you have written into that file. The next line closes 
the script file, which is launched by the final line shown above. Further lines would import 
the results exported by Prism. 

Putting all the commands into one file doesn't help conceptually. You still have to 
distinguish the VBA code within Excel from the script commands of Prism. The advantage 
is that you can do all the editing within one file, rather than two. The disadvantage is that 
writing the script is a bit harder, as you have to place each line in quotations and precede 
it with "Print #1,". 

Debugging Prism scripts 

Log files 
Whenever Prism runs a script, it creates a log file with the same name as the script but 
with the extension log. If a file with that name already exists, it is deleted. The log file 
shows you every command, every file looped through, and every error message reported 
by Prism. It can help you troubleshoot problems. 

Once your script runs well, you can speed things up a bit by starting your script with the 
ShortLog command.  

Stepping through your script 
When you launch a script from within Prism, you can step through the script one line at a 
time. Prism gives you feedback in the script dialog. You can also look at the results and 
graphs within the Prism project. 
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The syntax of a Prism script 
This section explains all the commands you can include in a Prism script. Arguments in 
square brackets [like this] are required. Those in angled brackets <like this> are optional. 
Note that you can use upper and lower case letters interchangeably, and can add extra 
spaces to improve readability. 

Navigation 
GoTo <section>, <sheet>, <V#>  

Use the GoTo command to navigate between the sheets of your project. <Section> can be 
D, I, R, G, or L for data, info, results, graphs, and layouts. [Sheet] is a number, and 
<View> selects a view (subpage) for results that have more than one. 

Example: Description: 

GoTo G Go to the graphs section, to the most recently 
viewed graph. 

GoTo 3 Go to the third sheet of the current section. 

GoTo G, 3 Go to the third graph.  

GoTo V2 Go to the second view (subpage) of the 
current results. 

GoTo R, 3, V2 Go to the second view of the third results 
sheet. 

GoTo + Go to the next sheet in the current section. 

GoTo - Go to the previous sheet in the current 
section. 

 

Tip: When exporting the results of nonlinear regression, note that the 
tabular results (the view you see by default) is view 2. The first view is 
the overview, which is text (not a table) so it cannot be exported by a 
Script. Go to view 2 before writing the results. 

ClearTable <row>,<col>,<subcol>  

Delete values from the current data table. If you specify row and column, start there and 
delete everything below and to the right. If you don't specify row and column, Prism 
deletes all values. 

Creating new sheets 
Script commands can create new data tables by duplicating the current table, perhaps 
with its family. 

DuplicateDataTable  <CLEAR> 

Duplicates the current data table, and optionally clears all data leaving column titles. 
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DuplicateFamily  [prepend_text] <CLEAR> 

Duplicates the current sheet, along with all related sheets, and optionally clears all data. 
All new sheets include the prepended text in front of the sheet name.  Enter %F as the 
prepend text, to use the name of the most recently imported file.  

SetYReplicates  [#] 

Changes the format of the current sheet (must be a data table) for entry of the number of 
Y replicates specified (1 to 52). From within a script, it is not possible to reformat a table 
for entry of mean and SD or SEM.  

SetTitle [new_name]  <K> 

Changes the sheet name of the current sheet to the specified name. If you enter the 
optional parameter K, then insert the new name between characters K and K+1 of the old 
name. 

Opening and saving Prism Files 
Open [filename] 

Open a Prism file. You may open several files at once. To go back to a file you already 
opened, simply reissue the open command again. If you don’t include a disk and directory, 
Prism will look in the directory (folder) specified by the SetPath command. 

Include the file extension (.PZF, PZT or .PZM). If the filename includes spaces, surround 
the name with quotation marks. 

Close 

Close the current Prism document. Closing a file does not save it. If the file has changed, 
those changes are lost.  

Save <filename> 

Save the Prism file with changes. Include a file name to create a new file. Omit the file 
name to save changes using the same name. 

If the filename includes spaces, surround the name with quotation marks. 

Importing 
Import <filename>, <row>, <col>, <subcol> 

If the import command is in a loop, you can issue the command Import with no other 
information. Prism will automatically import the current file into the current data table 
starting at the first blank column (starting with X). If you want to specify a particular row 
or column, use this syntax: 

Import %F.txt, 1, 3 

 

Here we use “%F” to refer to the name of the file, which changes with each iteration. Note 
that you need to specify the extension, “.txt” in this example. 

If the import command is not in a loop, specify a file name. For example: 
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Import “C:\PRISM2\May22.dat” 

 

If you don't precede the file with a path, Prism will use the path defined in SetPath. If 
there is no SetPath command, then Prism assumes that you want to use the directory that 
contains the script. 

Optionally specify the row and column to begin importing. The first row is 1 – the title row 
is row 0. For columns, 1 is the first Y column, and zero refers to the X column. 

Specify a subcolumn if needed. If the data table is formatted for triplicates, then 
subcolumn 2 is the subcolumn for the second set of replicates. If the table is formatted for 
mean, SD, and N, then the second subcolumn is for the SD. If you don't specify a 
subcolumn, Prism imports the value into the first available subcolumn. 

ImportLink <Filename>, <row>, <col>, <subcol> 

When you import data, you can choose to maintain a link between Prism and the data 
(text) file and can specify filters (to choose which data to import) and rearrangements 
(such as transpose). These properties are kept in a data object. See "Data objects in Prism" 
on page 39.  

Use the ImportLink command to import a different file using the same choices for 
filtering and rearranging. For example: 

ImportLink C:\PRISM2\May24.dat 1,1,1 

First specify the file name, which will replace the previous file. If you are in a loop, use 
“%F” as the file name, appending an extension if needed. 

Next, specify the row, column, and subcolumn of the upper-left corner of the data object. 
The first row of data is row 1 (the title row is row 0). The first Y column is column 1 (the X 
column is column 0). If you leave subcolumn blank, Prism uses the first (or only) 
subcolumn.  

If there is only one data object on the table, you don’t have to specify row, column, or 
subcolumn. If you leave these blank, and there is only one data object on the table, Prism 
uses it. If there is more than one block, Prism will display an error message. If the row, 
column, and subcolumn you specify is not the upper-left corner of a data object, Prism 
will display an error message. It doesn’t try to find the closest block, and doesn’t even look 
to see if the specified cell is within a block. You must specify the upper-left corner.  

Note that the ImportLink command updates a Prism data object linked to a text file. If you 
Paste Link data from Excel, you cannot update the link using this command. You'd need 
to write VBA code in Excel to change the data in Excel. 

Including data in the script file 
If you create the script file from within another program, you can include data and info 
constants within the same file as the script commands. 

InsertData <row>, <col>, <subcol> 

Imports data included within the script file, starting at the indicated position. The data 
block can be located in any place of a script file. The data is enclosed between the tags 
<Data> and </Data> with adjacent values separated by space, tab, or comma. See the 
example below. The rest of the script continues right after the </Data> tag. 
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InsertData 
<Data> 
1, 2, 4 
5, 7, 9 
</Data> 

 

InsertDataLink <row>, <col>, <subcol> 

Inserts data included within the script file, into a data object whose upper left position is 
at the indicated position. When you first import data, you can choose to maintain a link 
between Prism and the data (text) file and can specify filters (to choose which data to 
import) and rearrangements (such as transpose). These properties are kept in a data 
object. See "Data objects in Prism" on page 39 . Use the InsertDataLink command to 
insert new data using the same choices for filtering and rearranging. The data come from 
the script file in a block enclosed between the tags <Data> and </Data>. 

SetInfo <value> <rownumber> <position> 

This command stuffs information into an Info sheet. Set position to 0 to change the name 
of the constant, or to 1 to change its value (the default choice). 

Examples: 

SetInfo 5.3, 3    
Setinfo "Notebook 25, page 34", 5  
Setinfo "Experimenter", 3, 0   
Setinfo "Dennis", 3, 1  

 

The first example sets the third constant equal to 5.3. The second example sets the fifth 
constant to “Notebook 25, page 34”. The third example names (or renames) the third 
constant to “experimenter”.  The fourth example assigns the value “Dennis” to the 
constant "experimenter". 

Opening a text file for output 
OpenOutput [filename] ,<CLEAR>, <”delimiter”>  

Open a text file into which you will write results or other text.  

If you don't precede the file with disk and directory, Prism will use the path defined in 
SetPath (see below). If there is no SetPath command, then Prism assumes that you want 
to use the directory that contains the script. 

If the output file already exists, Prism appends that file unless you have included CLEAR. 

Results will be tab delimited unless you include an alternative delimiter in the 
OpenOutput statement. 

Examples:    

OpenOutput C:\gp25\output.txt, Clear 
OpenOutput C:\data\july97, “,” 

 

CloseOutput  

Closes (and saves) the current output file. 
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Writing to a text file: general issues 
You can write (export) data and results to text files using several commands listed below 
(WText, WDate, etc.). All these commands use the same conventions for using semicolons 
or ampersands at end of the line, and for numbering rows and columns; 

Semicolons and ampersands 

If you end any of the Write commands with a semicolon, the next Write command will 
add text to the same line, following a tab. If you end with an ampersand (&), the next 
Write command will add text to the same line, without a tab. If you omit the semicolon or 
ampersand, Prism inserts the codes for carriage return and line feed so the next Write 
command will write to the next line in the file. 

Numbering of rows and columns 

Row 0 refers to the row of column titles, and row 1 is the first row of data. Column 0 refers 
to the X column, and column 1 is the first Y column (column A). 

Writing to a text file: commands 
WText <"text"> <;&> 

You can omit the quotation marks if you are only writing only a single word. You need 
quotation marks if the text includes spaces or punctuation.  

WDate <;&> 

Write the current date. 

WCell [row], [col], <subcol> <;&>  

You must specify row and column. Prism will write all subcolumns (for example: mean, 
SD, N) unless you specify a single subcolumn (starting with 1) in the third argument. 

For many results tables, the "X" column is the list of variables, while the first Y column 
has the values. You can only export tabular results, not text. 

WRow [row], <col>, <subcol> <;&> 

 Write the entire row starting at the specified column and subcolumn. All the values ae 
placed into one row in the output file. 

WCol [row], <col>, <subcol><;&> 
Write the specified column, starting at the specified row. All the values are placed into one 
column in the output file. 

WSheet <row, col, subcol><;&>  

Write the current data or results sheet starting at the specified row and column. 

WTitle  

Write the sheet title.  

WTCol [row, col] <, subcolumn><;&> 
Write the specified column, transposed so that the output is a row. Start at the specified 
row and column. All the values are placed into one row in the output file. 
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WTRow [row] <,col, subcol> <;&> 

Write the entire row starting at the specified column and subcolumn transposed. All 
values are placed into one column in the output file. 

WTSheet <row, col, subcol><;&>  

Transpose and then write the current data or results sheet starting at the specified row 
and column. Each data set (column) in the sheet becomes one row in the output file.  

Looping 
ForEach [filespec]  

Loop through all matching files in a folder using a command like this example:  

ForEach *.dat 

 

ForEach [# of loops]  

Loop the specified number of times. For example: 

ForEach 500   

 

This is useful in simulations. Combine with the Regenerate command which generates 
new random numbers for simulated data. See Example 2 at the beginning of this chapter. 
This command also lets you loop through all sheets in a section, when combined with the 
“GoTo %N” command. See Example 6 at the beginning of this chapter. 

Next  

Loop again. Go back to the ForEach statement. You may not nest loops.  

Referring to file names and loop number 
While in the loop, you may use variables to construct file names and to format output. If 
you are looping through a batch of files, you can refer to the file name as %F and the 
extension (not including the preceding period) as %X. For example write the file name 
into a text file as follows. 

WText %F  

 

Create an output file with the same name (but different extension) as the data file as 
follows: 

OpenOutput %F.prn 

 

When performing simulations using the ForEach command to loop a certain number of 
times, %N equals the current loop number. You could write the iteration number into an 
output file as follows. 

WText %N 
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Or you can go to that sheet as follows. 

GoTo %N 

Note for Windows users. When using %F, remember that it only refers to 
the file name and not the extension. Most often, you’ll want to append an 
extension like “.txt” or “.wmf”.  

Exporting graphs and layouts 
For all export commands, Prism will use the SetPath setting if you don't specify disk and 
directory. 

Tip. If you use “%F” to export a file with the same name as the imported 
data table,  remember to append an extension. For example  
“ExportWFM %F.WMF “. 

ExportWMF [filename] <clear> (Windows only.) 

Export the current graph or layout as a Windows metafile. Add the option “clear” to omit 
the page background color from the exported file.  

ExportPICT [filename] <clear>. (Mac only.) 

Export the current graph or layout as a Macintosh Pict file. Add the option “clear” to omit 
the page background color from the exported file.  

ExportTIF [filename] <resolution> <mode> <compress> <clear> 

Export the current graph or layout as a TIF file.  

Set the resolution to 100, 300 (default if no resolution included), 600 or 1200. These 
values set the number of dots per inch. If you are submitting a figure to a publication, 
follow the guidelines for that publication. Note that it can take a huge amount of memory 
to create 1200 dpi tif files of large files, and few computers can do this. Reduce your graph 
to publication size before making a 1200 dpi tif file.  

Set the mode to “RGBlow” (256 colors), “RGBhi” (millions of colors), “CMYK” (default) or 
“MONO”. Note that “MONO” means black and white only, with no grays. CMYK and RGB 
are two ways of denoting colors. Publishers tend to prefer CMYK. 

If you include the "compress" parameter, the output file will be compressed. 

If your page has a colored background, it is included with the tif file by default.  Add the 
parameter "Clear" to export the graph or layout with no background color. 

Example:  

ExportTIF figure3.tif, 600, cmyk, compress, clear 

 

ExportBMP [filename] <resolution> <clear> 

This command allows to export graphs or layouts in .BMP format at 100, 300, 600, and 
1200 dpi. Low-resolution bitmaps work great if the goal is to display the graph on the 
screen (for example in a web page), but are not useful if the goal is to print a high-quality 
page. Choose a higher resolution bitmap if you plan to print the resulting graph.  
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If your page has a colored background, it is included unless you append the parameter 
"Clear".  

ExportPNG [filename] <clear> 

Choose a .PNG file if you plan to include the graph or layout on a web page. There are no 
choices of resolution.  

If your page has a colored background, it is included unless you append the parameter 
"Clear".  

ExportJPG [filename] <resolution> <clear> 

The .JPG format is more compact than .TIF, with only a slight loss of quality. 

If your page has a colored background, it is included unless you append the parameter 
"Clear".  

ExportPCX [filename] <clear> (Windows only) 

Old picture format used by PC Paintbrush. We suggest you use other formats when 
possible.  

If your page has a colored background, it is included unless you append the parameter 
"Clear".  

Copy and paste 
Copy 

From a graph or layout, the Copy command copies to the clipboard. Presumably you’ll 
then paste into another program. 

Copy [#rows] [#columns] [first row] [first col] <first subcol> 

From a data, info, or results table, copy selected values to the clipboard. Note that 
#columns includes subcolumns.  

Paste  [first row] [first col] <first subcol> 

Pastes from the clipboard starting at the specified cell of a data or info table. 

Miscellaneous commands 
Print  

Prints the current sheet. 

Regenerate  

Use this command to perform Monte Carlo analyses. This only works when the current 
sheet is a result sheet containing a simulated curve, or a transformation adding Gaussian 
scatter. Prism will generate new random numbers.  

// comment 

Add comments to your script. Comments may appear on a line by themselves or after any 
command. 
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SetPath [pathname] 

Define the disk and directory to be used for all file operations. Prism will use this path for 
all file commands that do not specify disk and directory. Example:  

SetPath c:\data\june\ 

 

You can also place the path into the command line as follows: 

Prism “c:\data\june12\”  @”c:\prism 4\screen.pzc” 

 

ShortLog 

Normally, Prism keeps a detailed log file of every step from the script that is completed. 
Once you are sure your script works well, use this command to make a shorter log file. 
This may speed up your analyses a bit. 

ShortLog 0 reverts to a regular log. 

Beep  

Use this at the end of a long script so you'll hear when the script has finished running. 

Summary of all script commands 
Arguments in square brackets [like this] are required. Those in angled brackets <like 
this> are optional. 

// [comment] 

Beep 

ClearTable <row>,<col>,<subcol> 

Close 

CloseOutput 

Copy 

Copy [#rows] [#columns] [first row] [first col] <first subcol> 

DuplicateDataTable  <clear> 

DuplicateFamily  <prepend_text> <clear> 

ExportBMP [filename] <resolution> <clear> 

ExportJPG [filename] <resolution> <clear> 

ExportPCX [filename] <clear> 

ExportPICT [filename] <clear> 

ExportPNG [filename] <clear> 

ExportTIF [filename] <resolution> <mode> <compress> <clear> 

ExportWMF [filename] <background> 

ForEach [# of loops] 

ForEach [filespec] 

GoTo <section>, <sheet>, <view> 
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Import <filename> ,<row>, <col> 

InsertData <row>, <col>, <subcol> 

InsertDataLink <row>, <col>, <subcol> 

Next 

Open [filename] 

OpenOutput [filename], <CLEAR>,<”delimiter”> 

Paste [first row] [first col] <first subcol> 

Print 

Regenerate 

Save <filename> 

SetInfo <value> <rownumber> <position> 

SetPath [pathname] 

SetTitle [new_name]  <K>  

SetYReplicates  [#] 

ShortLog 

WCell [row], [col], <subcol> 

WCol [row], [column] 

WDate 

WRow [row] , <col> , <subcol> , <;&> 

WSheet [row] , <col> , <subcol>, <;&> 

WText [text] , <;&> 

WTitle, <;&> 

WTCol [row, col] , <;&> 

WTRow [row] , <col> , <subcol>, <;&> 

WTSheet [row] , <col> , <subcol>, <;&> 

 

When looping, you may use variables denoting the file name or loop number to construct 
file names and text output. %F is the file name, not including path or extension; %X is the 
extension (not including the preceding period); %N is the loop number.  
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29. Technical support 

Do you have the current version? 
Like all software companies, GraphPad occasionally issues minor updates to Prism. If you 
are having trouble with Prism, check that you are running the current release.  

The full version number is not on the manual cover or the CD label. You have to run the 
program and find out which version it is. Drop the Help menu (Windows), Apple menu 
(Mac OS8-9) or Prism menu (Mac OS X) and choose About Prism. Windows versions have 
two digits after the decimal point (i.e. 4.00). Mac versions have a single digit after the 
decimal followed by a letter (i.e. 4.0a).  

Go to the Support page at www.graphpad.com to find out what version is most current. 
Download and install the updater if your version is not the most current. Updates 
(interim versions of GraphPad software containing bug fixes or minor improvements) are 
free to owners of the corresponding major releases. In contrast, upgrades (a new version 
with many new features) must be purchased.  

Is the answer to your question on www.graphpad.com? 
Note that this is one of four manuals that come with Prism. The others are a guide to 
curve fitting, a guide to statistics, and a book of step by step examples. All these books are 
available for downloading or viewing at www.graphpad.com. 

If you need help using Prism and can’t find the answers in the manuals, please visit our 
web site at www.graphpad.com. Your solution is very likely in the searchable Quick 
Answers Database in the Support section. 

You can browse the list of most frequently asked questions, browse questions by topic or 
search for particular words. We update the Quick Answers database almost every week, 
and the answer to your question is very likely to be there.  

If you have questions about data analysis, also browse the library of statistical articles and 
links on www.graphpad.com 

Personal technical support 
If you need personal help, contact us via email at support@graphpad.com or use the form 
on the support page. Be sure to mention the version of Prism you are running and if you 
are using Prism for Windows or for Mac. In most cases, a problem is best demonstrated 
by attaching a particular project (.pzf) file to your email.  

If you really think that your issue is better solved by a phone call, please email your phone 
number. We give much higher priority to emailed questions, and you may not get a return 
call the same day. You will get faster personal support by email than by phoning. 

While we reserve the right to charge for support in the future, we promise that you’ll 
receive free support for at least one year. 
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We can’t predict how computer hardware and system software will change in the future, 
so cannot promise that Prism 4, released in 2003, will work well with future versions of 
Windows or the Mac OS. 

Note that your Prism license does not include free statistical consulting. Since the 
boundary between technical support and statistical consulting is often unclear, we will 
usually try to answer simple questions about data analysis.   
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Index  

—A— 
Adding data sets to a graph 63 
Adding text to a graph 122 
Align objects dialog 131 
Aligning axes 116 
Aligning graphs 116 
Alignment guides 130 
Analyses, changing data sets to analyze 47 
Analysis chains 20 
Analysis preferences 48 
Analyze button 45 
Analyze dialog 45 
Analyzing repeated experiments 59 
Angled text 127 
Angled text, bar graph labels 107, 110 
Antilog numbering 99 
Appending one project to another 23 
Area fill 102 
Arrange menu 130 
Arrows, drawing 125 
Asymmetrical error bars 26 
Attaching Prism files to email 145 
Automatic backup files 23 
Automatic updating, freezing 21, 47 
Axes, aligning 116 
Axes, creating two Y-axes 88 
Axes, custom ticks and labels 89 
Axes, discontinuous 91 
Axes, hiding 94 
Axes, making so they don't touch 83 
Axes, range and ticks 85 
Axes, reverse 85 
Axes, with gaps 91 
Axis gaps 91 
Axis titles 87 
Axis titles, moving 87 

—B— 
Background color 113, 119 
Backing up a project 23 
Backup files, automatic 23 
Backwards axes 85 
Bar graphs, different kinds 17 
Bar graphs, X labels 25 
Bit map files, importing 128 
Boldface, in the Navigator 10 
Boxes, drawing 125 
Breaks in axes 91 
Bring to front 129 

—C— 
Censored subjects, in survival graphs 17 
Center on page command 116 
Chaining analyses 46 
Change ALL data sets 101 
Character sets 124 
Characters, inserting 122 
Circles, drawing 125 
Citing GraphPad Prism 2 
Clear color 117 
Clear data 28 
Clipart 127 
Clipboard, using with data 29 
CMYK 141 
Color schemes 119 
Color schemes, creating 120 
Color, background 113, 119 
Colors, custom 117 
Column scatter plots 107 
Column widths 27 
Confidence bands, graphing 80 
Confidence interval, definition of 76 
Connecting line 102 
Coordinates, showing 130 
Cross-platform considerations 145 
CSV files, importing 31 
Custom colors 117 
Custom ticks and labels 89 

—D— 
Data analyzed, choosing 47 
Data object 39 
Data object, defined 39 
Data objects, format dialog 33 
Data sets, selecting which ones to graph 63 
Data tables, entering data sets that don't share X 

values 26 
Data tables, number format 27 
Data tables, selecting a range 29 
Data tables, using the clipboard 29 
Data with Results, folder in navigator 20 
Data, choosing which data sets to analyze 47 
Data, excluding 28 
Data, exporting 29 
Decimal format of data tables 27 
Decimal places, how many are shown 50 
Decimate data 35 
Delete command 28 
Deleting a sheet 22 
Deleting results sheets 47 
Discontinuous axes 91 
Discontinuous axis 91 
Dot plot 72 
Drawing lines, arrows, ovals and boxes 125 
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Duplicating a graph 62 
Duplicating objects 129 

—E— 
Email, attaching Prism files to 145 
Embedded data 30 
Embedding Prism results 49 
Embedding. Advantages and disadvantages. 136 
Enlarge the view 130 
Equalize graph size 115 
Equation library, saving 149 
Equations, embedding 127 
Error bar direction 78 
Error bars in the X direction 68 
Error bars, choosing between SD & SEM 75 
Error bars, general 66 
Error bars, which one? 76 
Error envelopes 80 
Excel 30 
Excel, editing linked or embedded data 41 
Excel, embedding in Prism 30 
Excel, importing from 31 
Excel, linking to Prism 30 
Excel, pasting a formatted table 127 
Excluding data 28 
Explorer, showing and hiding 19 
Exporting data 29 
Exporting graphs or layouts 140 

—F— 
Family of sheets, duplicating 58 
Family of sheets, Duplicating a family of sheets

 58 
File Export command, data or results 29 
File Export command, graphs or layouts 140 
File Merge command 23 
File Save Methods command 61 
File Save Template command 59 
File Send Mail command 145 
Filter tab, of Format Data Object dialog 34 
Floating pictures, in Word 137 
Font of axis numbering 86 
Fonts 123 
Format bars dialog 105 
Format bBar appearance 105 
Format columns dialog 107 
Format data object dialog 33 
Format Data Table dialog 24 
Format page layout dialog 112 
Format Symbols and Lines dialog 101 
Format text dialog 123 
Four quadrant graph 84 
Frames and axes 83 
Freezing graphs and results 21 

Frozen results 21, 47 

—G— 
Gallery of previews 20 
Gaps in axis 91 
General tab of the Format Axes dialog 82 
GIF format 144 
Going to a linked sheet 20 
Graph preferences 65 
Graph size and shape 82 
Graph size, equalizing 115 
Graph title, moving 87 
Graph titles 87 
Graphs, deleting 22 
Graphs, duplicating 62 
Graphs, placing several on one page 112 
Graphs, selecting data for 63 
Greek letters 122 
Grid lines, adding to graph 83 
Grid, showing 130 
Grouping objects 129 

—H— 
Hardware requirements 2 
Header, printing 132 
Hiding axes 94 
Hyperlinking from a web page 146 

—I— 
Importing images 128 
Importing info constants 38 
Importing notes 38 
Indexed data, unstacking 35 
Info constants, importing 38 
Info constants, in analyses 43 
Info section 11 
Info sheets 42 
Inline pictures, in Word 137 
Inputs to analyses, changing 47 
Insert character 122 
Insert Object command 136 
Insets 112 

—J— 
JPG files, exporting 141 

—L— 
Labels, writing on graphs 122 
Landscape, making graphs 65 
Landscape, printing 132 
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Legend, master 115 
Legends 102, 110 
Library for equations, saving 149 
Line, drawing 126 
Linked data 30 
Linked sheets, going to 20 
Linking Prism graphs into another program 134 
Linking. Advantages and disadvantages. 134 
Locking objects 129 
Log axis on bar graph 99 
Log numbering 97 
Log transforms 97 
Logarithms, general 100 
Lorentzian distributon, random numbers from 55 

—M— 
Mac and Windows compatibility 145 
Macros (scripts) 154 
Magnify the view 130 
Masking data (excluding) 28 
Master legend 115 
Math symbols 122 
MathType 127 
Merging projects 23 
Metafiles, importing 128 
Method by example 58 
Method file, saving 61 
Microsoft Excel 30 
Microsoft Word. Using with Prism. 137 
Monte Carlo simulations 56, 150 
Moving objects 128 
Multi-graph layouts 112 

—N— 
Navigator 19 
Notes, importing 38 
Nudging data sets 104 
Nudging objects 130 
Number and arrangement of graphs 112 
Number format of data tables 27 
Number format, changing 50 

—O— 
Object linking and embedding See OLE 
Objects, aligning 131 
Objects, data 39 
Objects, duplicating 129 
Offsetting axes 83 
OLE, embedded data 30 
OLE, linked data 30 
OLE, Prism graphs into other programs 134 
OLE. Linking Prism graphs. 134 
One grouping variable 15 

Options, print 133 
Order of sheets 22 
Order tab,  of the Format Symbols dialog 103 
Origin, of graph 84 
Orphaned results 47 
Ovals, drawing 125 

—P— 
Page orientation of graphs 65 
Page orientation of layouts 112 
Parameters dialogs 46 
Parameters of analyses, changing 47 
Paste link 30 
Paste special 30 
Paste special dialog 33 
Pasting data from the clipboard 30 
Pictures, importing 128 
Pie chart 128 
Placement tab, of Format Data Object dialog 36 
PNG 141, 144 
Portrait, making graphs 65 
Position object dialog 131 
Position of titles 87 
Positioning objects 128 
Posters, printing 133 
Power of 10 numbering 97 
PowerPoint 138 
Predictiton bands, graphing 80 
Preferences, analysis 48 
Preferences, graph 65 
Preferences, printing 133 
Print options 133 
Printer setup dialog 64 
Printing, header 132 
Prism script, uses of 150 
Prism scripts, syntax 160 
Project explorer 19 
Project file, defined 9 
Projects, appending 23 
Projects, splitting 23 
pzc files 154 
PZF file format 7 
PZM files, opening 7 

—R— 
Random numbers, how Prism calculates 55 
Related sheet, going to 20 
Removing data sets from a graph 63 
Renaming a sheet 21 
Renaming sheets 21 
Reordering sheets 22 
Repeated experiments, analyzing 59 
Replicate values, entering 26 
Replicates, graphing each one 72 
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Results sheets, deleting 47 
Results, deleting 22 
Results, frozen 21, 47 
Results, orphaned 47 
Reverse axes 85 
RGB 141 
Right sided Y-axis 88 
Rotated text 127 
Rulers, showing 130 
Run script command 154 

—S— 
Save backup file 23 
Save Method command 61 
Saving templates 59 
Scale bars 94 
Scientific numbering 97 
Scripts 150 
Scripts, running 154 
Scripts, syntax 160 
SD of dataset (column) 74 
SD or SEM? 76 
SD values, how to enter 26 
SD, definition of 74 
SD, equation for 75 
Section tabs 19 
Selecting data to graph 63 
Selecting on a data table 29 
Selecting text 122 
SEM of dataset (column) 75 
SEM values, how to enter 26 
SEM, definition of 75 
SEM, equation for 75 
Send Mail command 145 
Send to back 129 
Series, x format 25 
Sheet name, renaming 21 
Sheets, deleting 22 
Sheets, freezing 21, 47 
Sheets, renaming 21 
Sheets, reodering 22 
Show coordinates 130 
Show grid command 130 
Show rulers 130 
Simulating data with random error 52 
Size and shape of a graph 82 
Skipping rows when importing or pasting 34 
SmartDrawNet 143 
Snaps, to align objects 130 
Sorting data 27 
Source tab of Format Data Object dialog 33 
Splitting a project 23 
Squares, drawing 125 
Standard deviation, definition of 74 
Standard deviation, equation for 75 
Standard error of the mean, definition of 75 

Standard error, equation for 75 
Subscripts 123 
Superimposing several data sets on one graph 63 
Superimposing several graphs on a page 112 
Superscripts 123 
Support, technical 170 
Survival curves, selecting symbol for 103 
Survival graphs 16 
Symbols 102 
System requirements 2 

—T— 
t distribution, simulating data from 55 
Tables, deleting 22 
Tall graphs 82 
Technical support 170 
Templates, saving 59 
Text object, selecting 122 
Text, writing on graphs 122 
Text, x format 25 
Ticks, custom 89 
TIF files 140 
Timed backup files 23 
Titles of graphs and axes 87 
Titles, moving 87 
Transparent color 117 
Transposing data while importing 36 
Two grouping variables 15 
Two-segment axis 91 
TXT files, importing 31 
Typeface 123 

—U— 
Ungrouping objects 129 
Unlinking a data object 39 
Unlinking results from data 21, 47 
Unlocking objects 129 
Unstacking data 35 
Updating a data object 39 
Upgrading 7 
Using snaps 130 

—V— 
Vertical text 123 
View tab, of Format Data Object Dialog 34 

—W— 
Waterfall graphs 105 
Welcome dialog 14 
What’s new? 7 
Wide graphs 82 
Width of bars on bar graph 107, 109 
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Windows and Mac compatibility 145 
Windows, versions supported 2 
Word. Using with Prism. 137 
Writing text on graphs 122 

—X— 
X column, format of 25 
X error bars 68 
XY coordinates, showing 130 
XY graph, choosing from Welcome dialog 14 

—Y— 
Y columns, format of 25 
Y-axes, creating two 88 
Yellow tabs 19 

—Z— 
Zoom 130 
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